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Introduction

Content Matrix Console - File Share Edition is a powerful workbench application designed to perform
end-to-end migrations of legacy content to enterprise SharePoint systems. Content Matrix Console -
File Share Edition is designed to efficiently migrate file share content to SharePoint Products and
Technologies. With its familiar copy-and-paste style user interface, you can quickly migrate your File
Share document content into SharePoint.

Whether deploying a small corporate file share with several hundred documents, or an enterprise-wide
file share of hundreds of thousands of documents, Quest solutions accelerate the migration process
and reduce the time and effort required to deploy.
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Supported Source Systems

The following source systems are supported in Content Matrix Console:

e Windows File Shares (Local or Networked drives)
e Mapped network drives

e SharePoint - Document off-loading only

Content Matrix File Share Edition
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Supported Target Systems

The following target systems are supported in Content Matrix Console:
e SharePoint 2016

e SharePoint 2019

e SharePoint Server Subscription Edition

e Microsoft 365 (including One Drive, Teams, and Groups)

Key Features

There are many advantages to using Content Matrix Console, including the following:

Ease of use
Similar to the Windows File Explorer, Content Matrix Console has a familiar, tree-based copy-and-
paste style user interface.

Valuable data retention
All version chains, metadata, user-edit information, and most views can be preserved.

Multiple site connections
Connect to multiple SharePoint sites, across any number of servers and tenants, for easy consolidation
or distribution of your SharePoint data.

Working remotely

Do all the heavy lifting for your SharePoint migration from the convenience of your own machine.
Content Matrix Console connects to any SharePoint site that you can access with your browser, even
those outside your organization's intranet.

Batch work
Multiple list migration operations can be batched up for convenience, and re-run at any time. Run your
migrations at night and view the results/logs in the morning.

Compliance
All migration activity is done through the supported SharePoint APIs. There are no unsupported, direct
writes to the SharePoint database.

PowerShell functionality

PowerShell functionality is incorporated into the Content Matrix User Interface (Ul), and any action in
the Ul can also be performed with PowerShell. Cmdlets are also included, so scripts can be manually
created and run.

Content Matrix
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Product Announcements Splash Screen

When you launch the Content Matrix Console, a splash screen displays the latest Content Matrix
product announcements. If you have internet access, you will receive announcements directly from
the Quest website. If you do not have internet access, the splash screen displays offline text included
with your Content Matrix installation.

You have the option of preventing this screen from displaying in the future by clicking the Do not show
this screen again box. (If you select this option, display of the splash screen will resume the next time
you perform a Content Matrix Console installation or upgrade.)

Automatic Updates

Content Matrix Console can automatically check online to see if a more recent version of the product
is available for download. This takes place when Content Matrix starts. To help ensure that you are
taking advantage of the latest features and fixes, it provides a direct line to download and installation
of new Content Matrix builds.

Automatic Upgrades requires access to the internet. While Content Matrix will check every time it is
opened, it is also possible to run a manual check. To do so, go to the main toolbar and choose Help >
Check for Updates.

If you are already running the latest build, the Check for Updates dialog will open, and you will be
informed that you already have the latest version installed. If there is a new build available for
download, the Download and Install Update dialog will open.

Running the Automatic Update

When Content Matrix checks for updates and finds a newer build available for download, users will be
prompted to update with the Download and Install Update dialog.

Download and Install Update @

g
@ New version is available for download.

To download the |atest version, pleaze click on Download buttan,

If wou access the Intemnet via a proxy server, enter the required information here.

Download progress:

Diowwnload | Cloze |

1. Click [Download] to directly download the latest build to your current machine.

The progress of the download is displayed in the Download progress bar.

NOTE: If you are accessing the internet through a proxy server, the here link can be clicked on to
open the proxy configuration dialog.

2. Once the download is complete, click [OK] to continue.

Content Matrix
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The Download and Install Update dialog will still be open, but the Download button will be replaced
with the [Install] button.

[

Dowenload and Install Update @

o,
@ New version is available for download.

To download the latest version, please click on Download button,

IF you access the Intemet via a prosy server, enter the required infarmation here.

Download progress: 30413 of 30413 £E downloaded [100%]
EERERREE|Avtomatic upgrade | SR NNNNANANNNRRNNRRARN

Inztall | Cloze |

You will have the option of installing the new build directly from here by clicking the [Install] button.
This will open the Installation guide. If you are continuing the installation process directly from this
dialog, then the Content Matrix Console will close itself down, so the install process can be run.

NOTE: When running the automatic upgrade process, only the latest build of the Content Matrix
Console will be updated. Any installations of the Metalogix Extensions Web Service will have to be
updated manually. See the Content Matrix Advanced Install Guide for details.

Content Matrix
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2

Activiating the License Key

You will be prompted to input an Activation License Key when launching the Content Matrix Console:
o for the first time after it has been installed if an existing license is not detected
OR

o after your license has expired.

NOTE: If users are not required to be a local administrators on the machine where Content Matrix is
installed, every user who launches a Console needs to enter a license key. If users are required to be
a local administrator, only the first user who launches a Console needs to enter a license key.

IMPORTANT: During installation, all Editions of the Console (SharePoint, File Share, and Public Folder)
are installed. However, the license will only be activated for Editions that are covered by it. If an
Edition is not covered by the license, the message Invalid license: License key is not valid for the given
product. will display in the Activate License Key dialog. A license key that starts with 823, 824 or 827
will not work with File Share Edition since its reintroduction in version 9.9.

If you are performing an online activation, you can also do it silently, using Powershell.

To enter a license key:

1. Inthe Activate License Key dialog, select | have a license key, and enter the license key provided
by Quest (the key can be copied and pasted into the provided space).

Content Matrix
12
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2 Enter license key and select the activation method

k-

Enter license key:
(®) I have a license key

() 1 am updating from an older version and have an old-style key

Choose activation mode:

(® Online activation {requires online internet connection)  Set proxy ...
() Offline activation

Mext = Close

NOTE: If you are updating from a Content Matrix installation older than version 6, select the | am
updating from an older version and have an old-style key option, and enter the key in the
provided space (or paste into the first field from your clipboard).

2. Select the appropriate activation method.

NOTE: Most systems can use the Online activation method as long as the system has internet
access. If you are unable to use the online activation method due to security settings or lack of
internet access, the Offline activation option can be used.

Online Activation

NOTE: In order to activate your license, the following URL must be unblocked by your firewall:
https://license.metalogix.com

1. After entering the license key, select Online activation.

N

If you need to configure proxy settings:
= (Click the Set proxy... link.

= Follow the procedure for Configuring Proxy Settings.

3. Click [Next].

Content Matrix will contact the licensing server and attempt to authenticate the license key, after
which, on successful activation, a 'Congratulations!' message will be returned, and the license key
will be active and in use.

4. Click [Finish] to complete the process.

Content Matrix
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http://license.metalogix.com

Offline Activation

o

8.
9.

NOTE: The offline activation option is generally used in cases where you cannot use the online
activation due to security settings or lack of internet access. This option will still require some
internet access but allows for the authentication to be done from another machine that is not as
restricted by security or has a connection to the internet.

Select Offline activation.

Click [Next].

A Generate Activation Request dialog displays with a different key. This key can be copied from
the window, or the Save to file option can be used to save the key into a text file (in case it needs
to be copied to another machine).

Copy the Activation URL (listed under the Activation Request) to a web browser that has internet
access.

Alternately if the system the Content Matrix Console is on does have internet access through a
Web browser, click Go to automatically open a web browser to this URL.

On a machine that has internet access, use the Activation URL to navigate to the Offline Activation
page.

Either:

= Enter the key into the Activation data text box.

OR

= |f the key was saved to a file, select Browse and navigate to the file.
Click [Activate].

Upon successful activation, a new key displays in the text box.

Do one of the following:

= To save the key as a DAT file, click [Download file].

OR

= To copy the key to the clipboard (if the license will be activated on the same machine), click
[Copy text].

Click [OK] to continue.

Return to the Activate License dialog.

10. If the Generate Activation Request window is still active, click [Next]. to the Enter your Activation

Response window.

11. Use one of the following options:

= |f you copied the key to the clipboard on the same machine, paste it into the window.

= |f you saved the key to a DAT file, navigate to, and select the DAT file.

12. Click [Next]. The license key will be active and in use.



13. Click [Finish] to complete the process.

Checking the Current Content Matrix Console
License

To check the status of the license key in use, open the About dialog. Here, information such as the
license type, expiration date (if any), size limitations for migrations, and how much data has already
been migrated can be seen.

NOTE: If an offline license is used, the offline activation process will need to be used to do this
update instead, unless the system that the Content Matrix Console is installed on has internet access.

To check the current license:

1. Inthe Content Matrix Console ribbon toolbar, choose Help > About.

2. Inthe dialog that opens, click [Refresh]. This will initiate a refresh of this data from the licensing
servers and update the information.

Content Matrix
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Selecting the SQL Database You
Want to Connect to

The first time you launch the Content Matrix Console you will be prompted to select the SQL database
that you want to connect to. Options are:

e Connect to Job Database (SQL Server).
e Connect to New Job List (SQL Server Compact 4.0* required)
e Connect to Existing Job List (SQL Server Compact 4.0* required)

* NOTE: The use of SQL CE in a production environment is discouraged because of the following
limitations:

= |t uses a single .Ist file that is less robust and reliable and may be corrupted after the database
reaches 4 GB.

= Data compression is not supported.
=  Support for large objects is limited.
=  Microsoft support for SQL CE has ended.

If you still want to use SQL CE for evaluation purposes, SQL Server Compact 4.0 must already be
installed on your machine. You can download it from Microsoft, install it, then restart the Console.

NOTE: If you have upgraded from version 9.3 or earlier and are using SQL CE (.Ist) files but SQL
Server Compact is not installed, a pop-up will display. You will be given the option of either installing
SQL Server Compact 4.0 or selecting a different Job database.

To create or connect to a full SQL database:

IMPORTANT: If you are connecting to an Azure SQL database, the database must already have been
created via Azure Portal. You cannot create or delete an Azure SQL database from within Content
Matrix.

1. From the Please connect to a job database dialog, select Connect to Job Database (SQL Server).
2. Complete the Connect to SQL Server dialog:

= |f you are connecting to an on premises SQL database, create (using the New Database option)
or select the database you want to use.
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https://www.microsoft.com/en-us/download/details.aspx?id=30709

SQL Server: QAX-5P13-DE14
S0L Database:

Encrypt Connection

Trust Server Certficate

Authentication

®) Use Cument Windows User: AX

Use SQL Server Login

Password

Data Migrated
“gilures: 1 Bytes Copied: 0B
Bytes Copied: 0B

= |f you are connecting to an Azure SQL database, select the database that has been created in
Azure Portal for use by Content Matrix. (Note that the New Database and Delete Database

options will be disabled.)

ILE 300 | endniL e sunaiun
- 6.7 MB)
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3¢ Database Browser E3
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| Search_Service_Application_AnalyticsReportingStoreDB_cc85d65967

1J Search_Service_Application_DB_11b35f6c495c4ad6bad0203147af3t
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3. If you want to use an encrypted connection to the database, check the Encrypt Connection box.

{J ContentDatabase
#{J ContentDB2013

NOTE: If the certificate used for encryption is not trusted, you will also need to check the Trust

Server Certificate box.

4. Select an Authentication method for connecting to SQL server:

e Use Current Windows User
OR

e Use SQL Server Login

NOTE: Currently, Use SQL Server login is the only valid option for an Azure SQL server.

5. Click [OK].
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Content Matrix Console End User
Interface

The Content Matrix Console User Interface (Ul) is simple and easy to use. There are three high level
components to the configurable interface:

o Explorer View 1 - At minimum, the interface will always display one Explorer Control, providing
multiple ways to view the content for any active connections to source and target environments.

o Explorer View 2 - A second explorer control can be displayed simultaneously. Having two explorers
visible allows the user to simultaneously view two different parts of the connected content set. For
example, in many cases it makes sense to show a migration source on the left in Explorer Control
1, and a SharePoint migration target on the right in Explorer Control 2.

e Job List - Beneath the Explorer Control windows is a Job list that shows the history of migration
jobs and other tasks that have been run or batched in Content Matrix.

More information on these Ul components is provided in the topics that follow.

Conttent Matrix Console - File Share Edition - X
Connection View Settings Help L
2 & C
Connectto  Connect to Refresh Import SCM
File System SharePoint  Connection Report
Add Connection General
Location: [ 2, 2.ch t.com/portals/ Location:
Explorer View Browser View Explorer View
Filter: F | % Ba 1% sortBy: [Default |v| || Fiter: F | ®ar Ba 1= sortBy: |Defadt |v
5 e ktop D ion Guides (4 files) =2 Bty 22-admin.sh: it.com (Microsoft 365 Tenant - Remote Connection - con &
& [T ¢:File Uploads (3 directories) 5, hitps:/fmetalogixsoftware622.sharepaint. com/
[ Eval Guide (30 files) & hi h it.com/ - Community {1.3 M)
[ Pr 2022 (38 fles) 2 hi harepoint.com/portals fhub
[ Pr 2023 (4 files) 5 http 53.5h: it.comfportalsfOffice-Videos
[ Fr 2024 (38 files) = hi h t.com 1
[ Graphics (4045 fies) 5 h narepoint. com|
7 ODES 5 h harepaint.comfsearch
[ oD (t directory) = hittp: 22,5 it.comfsitesfa_group_2
[ PII Process flow (2 files) B h t
[ scmprocess Flow (1 file) 2 h harepoint. ites/AATODElete
B dmin.she it.com (Microsoft 365 Tenant - Remote Connection - ¢ icrosoft.com) = h h it ites/AATSClassicEx
[ C:\users\testbenchinstal\Desktop\Documentation (3 files, 2 directories) 5, hitp: 225 t d
[ ci\users\testbenchinstal\Desktop\Documentation (@ fils, 2 directories) = h h t d_nensite
= hi 27.sharenaint. ci helul Gite Callection e
<! 2]
Job Seurce:  Data Source=CP-SP 1 ;Initial Catalog=CM. y ypt=} TrustServerC
B Fie~ E g
Job Hame Source Target Container Started Status Log Summary Data Migrated Finished Upload Duration  Total Duration  User Hame Machine
J Paste Folder As DocumentLi... C:\File Uploads https://metalogixsof ... 3/1/20246:01:14PM  Done Completions: 2, Skipped: 1 Data Migrated: 0B 3/1/20246:01:16 PM 00:00:02 AXCELERTEST\t... CP-SP ™
+f Paste Hierarchy Ct\File Uploads https://metalogixsof... 3/1/20247:35:18PM  Done Sites Created: 24, Libraries C... DataMigrated: 1L.2MB  3/1/2024 7:42:22PM 00:07:03 AXCELERTESTt... CP-SP
+/ Paste Site s Directory https://metalogi... C:\Users\testbenchi... 4/22/20242:25:53PM Done Completions: 215, Skipped: 28 Data Migrated: 56.2MB  4/22/2024 2:30:27 PM 00:04:28 AXCELERTEST\t... CP-SP
‘/ Paste Folder As DocumentLi... C:\File Uploads https://metalogixsof... 5/16/2024 12:51:53PM Done Completions: 1, Failures: 1 Data Migrated: 0B 5/16/2024 12:52:05 PM 00:00:05 AXCELERTESTt... CP-SP
v
< >

Main (Ribbon) Toolbar

At the top of the Content Matrix Console is a ribbon toolbar allowing access to the following five menu
group settings:
e Connection

o View

Content Matrix File Share Edition
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e Settings

e Help

The Content Matrix Console menu ribbon can be expanded or minimized to fit the user's needs. When
expanded, a set of options will be available depending on the selected menu heading.

w I": I:ki“:-

(@] hd -4 Connection View Settings Help @
0 — p—

=1 | 1= =

) O — @ Rt @

Show 2nd  Show Jobs | Show Checkboxes  Show Internal  Show Web
Explorer List List Mames URLs

Views View Options

When minimized, options will only be visible when a menu heading is selected. Otherwise, only menu
headings will show. The minimize and expand options can also be accessed by right clicking an option in
the ribbon itself. This opens a context (right-click) menu where the Minimize the Ribbon option can be
selected or deselected.

) [’ B,
(@] 5 =4 Connection View Settings Help @

Location: l] http:/ ga2013farm: 38876/ sites/Auditlog... Location: E) https://metalogixsoftwaretl? ...

Fenlorer View Rrrwear Wisw Funlnorer View Brrwear Wisw

Quick Access Toolbar

The Quick Access Toolbar can be accessed above the ribbon. The Quick Access Toolbar can also be
moved just below the ribbon by selecting the drop down menu (on the top left-hand side) and choosing
Show Quick Access Toolbar Below the Ribbon, or it can be placed back above the ribbon by choosing
Show Quick Access Toolbar Above the Ribbon. Any option that is available under one of the menu
group headings can have a shortcut for the option placed into the Quick Access Toolbar. This can be
done by right-clicking on the option in the ribbon, and choosing Add to Quick Access Toolbar.

“ll
d ole Content Matrix Console - SharePoint Edition - 9.9.0.1 - 0O X
. .

(@)% -4 Connection View Settings Hi ~

Q0 YLD M B

Help Topics About  Check for Update  Support Create Support Contact
Updates License  Fy == = :
Add to Quick Access Toolbar
Help Update
Show Cuick Access Toolbar Above the Ribbon

Minimize the Ribbon

Shortcuts can also be removed from the Quick Access Toolbar either by selecting the option within the
ribbon and opening the context (right-click) menu or by selecting the shortcut option itself, opening the
context (right-click) menu, and choosing Remove from Quick Access Toolbar.
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O ' il M @ ) Content Matrix Console - File Share Edition -

O

D ! Connection View Settings Help
e B C
= k=

Connect to  Connect to Refresh
File System SharePoint  Connection

Add Connection General Distributed Migration

Explorer Control View Tabs

The Content Matrix Console user interface uses an Explorer Control style window which allows you to

navigate, view, and select the desired content for migration. The Explorer Control window is broken up
into three separate tab options, each of which contains its own set of options for viewing content and

data. They are:

e Explorer View Tab

e |tems View Tab

e Browser View Tab

Explorer View Tab

The Explorer view tab allows you to navigate through your various connections in a tree view. You can
navigate to and select a desired SharePoint site collect, site, list/document library or sub-folder or a
under a specific connection or a specific file share source connection.

There are a set of filtering options that are available in this tab, as well as a set of ordering options.
This allows you to display, sort, and filter all your connections as desired.

Content Matrix File Share Edition
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Bxplaorer View Items View Browser View
Filter: Y R v Ba - 1° SortBy: |Default |

= d% Metalogix Demo ~
= ,5% Company Meeting (Basic Meeting Waorkspace)
E Agenda (3 items)
m Attendees (4 items)
=] iH Document Library (13 items)
—
i Demo Documents
COhjectives (3 items)
m Workspace Pages (1 item)
,5% Document Workspace (Document Workspace)
E Announcements (3 items)
@ Calendar
Contacts
m Custom List Created in SharePoint
m Custom List New W

<] > |

There are three primary Filtering options: Text Filter, Connections Filter, and Status Filter.

Text Filter: For example, if you only want to view connections that contain "2010" in the URL, you
can enter "2010" in the Filter text box and click the Filter button to the right of the text value. The
filter will then be applied to all connections in that Explorer View tab, and only connections that
contain a "2010" value will be displayed.

LoCarion:

Explarer View
Filker: | 2010 LR l° Sort By:

IJ http: ff2010Foundation: 80 (Web App - Local Connection - BELLURM) administrataor)

NOTE: To remove a text box filter, delete the filter value from the text box and re-run the filter
action.

Connections Filter - This option consists of a drop-down menu that allows you to filter by
connection type. By default, all of these options are selected, but one or more can be DE-selected.

[ . -

al. B
SharePoint Farm
charePoint Site

SharePolnt Tenant

LR S RS

SharePgint Tenant My Site Host

Status Filter - This option consists of a drop-down list with the various connection status options:

= NotChecked — Content Matrix has not tried to validate the connection yet.

= Checking - Content Matrix is currently trying to validate the connection.
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= Valid - Content Matrix has tried to validate the connection and has been successful. A
connection has been established.

= |nvalid - Content Matrix has tried to validate the connection and has been unsuccessful. A
connection has not been established.

= Warning - Content Matrix has tried to validate the connection and has been successful. A
connection has been established, however, a warning message has been given.

By default all of the status types are selected but, as with the Connections Filter, one or more can be
de-selected.

o & MokChecked

Zhecking %
W alid

v
o Irmeealid
v

Warning

You can also Sort by

o Default - All of the connections in the order they were added.

o Type -These are the same types that are listed in the Connections Filter drop down menu. When
selected, connection types will be sorted in the following order:

=  File Share Connections

= SharePoint farms (this includes all Web App and Farm connection to a server, as well as
Database connections)

= SharePoint Site connections, which include Site connection types, and Read-only connections to
SharePoint

You can combine various filter and sort options.

Items View Tab

The Items View tab displays any items/documents that exist directly under the selected node (that is,
the content of any subfolders under the selected node-will not be displayed), along with column
metadata.
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Bxplaorer View

el T A -
Searah In Name

Marne

Izl low_tide_oops.jpg

Izl logo.gif

| = read me.himl

W= wssbeta2_eula.rtf
Mz beta?_eula.rtf

Wiz CMS Airlift Motes. doc
4¥ | Picasa.ini

Wiz DEWRCaseStudy. doc

Items View

Wiz Important Addresses.doc

| MLSharePointdisco. aspx

Browser View

o~

Show Version History [ Show Properties

Content Type ID

Approver |

0x010100A75336E633A36044944C 730151399, ..
0x010100A75936E633A36044944C 750151399,
0x010100A73936EE33A36644944C 750151399,
0x010100A7393BEE33A36644944C 750151399, ..
0x010100AF5936EE33A36644944C 750151399,
0x010100A75336EE33A30044944C 750151399, .,
0x010100A75336E633A36044944C 730151399, ..
0x010100A75936E633A36044944C 750151399,
0x010100A73936EE33A36644944C 750151399,
0x010100A7393BEE33A36644944C 750151399, ..

There are four main options that are available through this tab. These options are:

e Search —To perform a full or partial text search, enter the string in the search box then either and
either press <Enter>, or click the magnifying glass icon to run the search.

NOTE: The search will be run on the name column (the FileLeafRef) by default, but you can select a

different column to search from the drop-down to the right of the search box.

ofF

|#] Refresh

Mame

Show VYersion His

Egl‘]li‘ermissions Managemnent, docx
E—E‘]Report Screenshots, docx
B4 ControlPoint Manage Groups of Use

|-

Modified

{_HasCopyDestinations)
{_CopySource)

@JCP Permissions Process Flows.docx | (_ModerationStatus)

{_ModerationCamments)
{CheckoutUser)
Madified By (Modified_x0020_Ewv)

-

1

-

e Refresh - This button will refresh all of the items in the Items View tab.

e Show/Hide Version History - This button option is only available when the selected document
library/list has versioning configured. When this button is selected the Items View tab will be
divided into two sections, a top section displaying all of the items/documents and a bottom section
displaying all of the versions for the selected item/document.

Explarer View Items View

Search In Mame

|2~

MName

= Volunteer Needs Assessment Survery - Cop...

B9 SALARY BUDGET 05-07 Uipdated - Copy.xls

£ FLSA dassification table 06302011-revised - ...

\=| CRYPTOLOCKER. - Copy. txt
| RE FOR APPROVAL - Copy.msg
Cover COmpliance - Copy.ppt

1= Copy-2013 PERFORMANCE APPRAISAL Rob...

"L IT-2104 NYS Tax Form-signed - Copy.pdf

Browser View

—
=]

= BN (R T, R o A

t::}" Refresh

Content Type ID

0x0101002F43ACED37B9B 7438 76 TOEDTE5T6T...
0x0101002F43ACED37B9B 748876 TOEOTE5TET. ..
0x0101002F43ACED37B9B 748876 TOEOTE5TET. ..
0x0101002F43ACED37B9B 748876 TOEOTE5TET. ..
0x0101002F43ACED37B9B 748876 TOEOTE5TET. ..
0x0101002F43ACED37B9B 748876 TOEOTE5TET. ..
0x0101002F43ACED37B9B 748876 TOEOTE5TET. ..
0x0101002F43ACED37B9E 7488 76 TOEOTE576T. ..

Hide Version History (i) Show Properties

Content Type Created

Document 10/10/2016 10:42:47 £
Document 10/10/2016 10:42:47 £
Document 10/10/2016 10:42:49 £
Document 10/10/2016 10:42:49 £
Document 10/10/2016 10:42:50 £
Document 10/10/2016 10:42:51 £
Document 10/10/2016 10:42:51 £
Document 10/10/2016 10:42:52 £
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When an item/document is selected in the top window, all of that item/document's version’s will
be listed in the bottom half of the window. You can then look at the metadata for each
item/document version that exists. This option can be combined with the Show/Hide Properties
button.

If the Show Version History button has already been selected, this will change to be a Hide Version
History button instead. You can use this option to stop looking at item/document version histories.

e Show/Hide Properties - The Show Properties button allows you to see a list-style view of the
available fields (columns) and their values, for a selected item/document. Any value listed in dark
text can be edited and within the window.

Explorer View Items View Browser View
2
jin ] Content Type ID
L W= Volunteer Needs Assessment Survery - Cop... 1 0x0101002F43ACED3TBIB 743876 70ED 755
Content Type Document E- SALARY BUDGET 05-07 Updated - Copy.xs 2 0x0101002F43ACEO37BIB 743876 76ED 765
Iz Signed B FLSA dassification table 06302011-revised - ... 3 0x0 10100 2F48ACEN3TBOE 748876 FEEDTES
v Misc =] CRYPTOLOCKER - Copy. bt 4 0x0101002F48ACEN37BOB 748876 76E0765
SResources:core, 2 .| RE FOR APPROVAL - Copy.msg 5 0x0101002F43ACED3TBIB 743876 70ED 755
Access Palicy Caover COmpliance - Copy.ppt [ Ox0101002F43ACED3TBOB 743876 70E0765
App Created By mdg' Copy-2013 PERFORMANCE APPRAISAL Rob... 7 Ox0101002F43ACED37BIB 743876 70ED 765
App Modified By " IT-2104 NY5 Tax Form-signed - Copy.pdf 8 0x0 10100 2F48ACEN3TBOE 748876 FEEDTES
Approval Status 0
Approver Commer
BLOB Sequence M
Check In Commen
Chedked Out To
Chedked Out To Y]

The fields in the Properties window can also be ordered by category, or alphabetically. By default, the
fields are ordered by category, and are listed alphabetically within each category. If listed
alphabetically, then all property fields (columns) will be listed in alphabetical order, with no breakdown
by category. There are two buttons at the top of the Properties window that can be used to determine
what ordering type is used. This option can be combined with the Show/Hide Version History button.

If the Show Properties button has already been selected, this will change to be a Hide Properties
button instead. Use this option to close the Properties window.

Browser View Tab

The Browser View displays a view of the content as it would be seen in a web browser for a selected
SharePoint node. It is also available if selecting a single item in the Items View. When selected, this tab
will display a fully functioning web browser view of the selected content. You can use this Browser
View to navigate or work with their content, the same way they would through a normal web browser
window.
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Explorer View Browser View

C) C

SharePoint
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Home Get started with your site  removeTHis

Motebook

Documents

Recent alls

Doc Library

Doc Library Test

Working on a
deadline?

Add lists, libraries, and
other apps.
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Site Contents

Recycle Bi
yele sn Newsfeed DocL

# EDIT LINKS Start a conversation @ n

Jobs List

Jobs in Content Matrix Console can be managed from the Job List. Jobs are listed for migration actions
that have already been run, as well as for actions that have been saved.

Using Multi-Select

Multi-select can be used to select several nodes on the source side Explorer View tree and migrate
those nodes to a target SharePoint instance. Multiple SharePoint connections can be selected at one
time, but only to Disconnect or Refresh those connections. If connected to a SharePoint farm or web
application, only a single site collection can be selected at a time, however, multi-select can be used on
any sub-sites under a single site collection.

This feature also works for migrating a single list or site into multiple target locations at the same time;
for example, if you have a document library that you want to migrate into two or more target
SharePoint sites. After the library is copied, any number of desired target sites can be selected, as long
as they are all under the same target connection node, and when pasted the list will be migrated to all
of the selected target site nodes. The basic cases for multi-select are copying: multiple to one, one to
multiple, and multiple to multiple.

For example, if connected to a File Share in the Explorer View, and the navigation tree is expanded, you
can select several (Folder A, Folder B, etc.) and these can all be migrated at the same time. After
pasting the content all the selected content (Folder A, Folder B, etc.) will be migrated under the target
SharePoint node.

Content Matrix File Share Edition
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In addition to using check boxes to multi-select, you can use <Shift> and the <Ctrl> keys in the
conventional way.

Limitations of Multi-Select

There are a few limitations when using multi-select. These limitations are:

e Only one node type can be selected at a time - This means that if a SharePoint site node is
selected, then only other site nodes can be selected, and included in the action. If a File Share
connection type is made, only nodes under each specific connection can be selected at one time

While the content under those nodes will be migrated (as per the selected options), only other site
nodes themselves can be selected. This is the same for SharePoint lists/libraries, and folders. When
connected to a SharePoint server only a single site collection can be selected at one time, but
multiple sites under the site collection level can be selected.

The first node selected in the multi-select will determine what type of node can be included, and if
an invalid selection is made, then the node that you tried to select will only blink. For example, if a
list is selected, then only other lists, within the site collection, can be selected. If you try to select a
SharePoint folder or site, then this is an invalid selection, and the folder or site will blink.

e Available Context (Right-Click) Menu Options - When using multi-select the options that are
available in the context (right-click) menu can change depending on where the multi selection is
taking place.
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Enabling Advanced Mode

Some options in Content Matrix are considered "advanced" and are disabled by default. Options that
require Advanced Mode are identified throughout this documentation.

To enable Advanced Mode:

In Content Matrix Console ribbon toolbar, choose Settings > Enable Advanced Mode.

NOTE: When the button is highlighted, Advanced Mode is enabled, and additional options become
available for nodes/items selected in Explorer and Item View tabs. Transformation Options become
available as well.

View Settings Help
Configuration  Manage Job Enahble Edit Resource
Jptions Configurations =~ Advanced Mode Utilization Settings G
on Options
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Enabling and Disabling Optimistic
Mode

Content Matrix Console - File Share Edition has an Optimistic Mode designed for faster migration of
content from a File Share to SharePoint by eliminating some of the additional checks that are normally
made as part of the migration process. Optimistic Mode is an option that can only be set on a root File
Share connection node (and not on a root SharePoint connection node).

NOTE: As of version 8.5.0.4, Optimistic Mode is disabled by default.

Known Limitation: Large File Migration

Currently, Optimistic Mode does not support large file migration. For a CSOM target connection, if a
file over 250 MB is encountered during migration, a message will be logged that prompts you to disable
Optimistic Mode before attempting to migrate it.

How Versioning is Handled Based on Mode and SharePoint
"Require Check Out" Setting

Optimistic Mode works best when the SharePoint setting Require Check Out is disabled. If both
Optimistic Mode and Require Checkout are enabled, migrated files will need to be manually checked in
after migration. The following table identifies how versioning is handled based on the various
combinations of the migration mode and the Require Check Out setting.

If Optimistic And the Then ...
Modeis .... SharePoint Require

Check Out setting

is ...

the files will be checked out on the target and they will

be given a version number by SharePoint after they are

manually checked in.
TIP: If you notice that all of the migrated documents
are in the checked-out status, it is likely that the
SharePoint Require Check Out setting is enabled. This
can be verified in the document library versioning
settings (Document Library Settings > Versioning
Settings). If this option is enabled there are two
solutions available to migrate the File Share content

enabled enabled
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If Optimistic And the

Mode s .... SharePoint Require
Check Out setting
is ...

disabled

enabled

disabled

disabled

Then ...

and have the documents checked-in after migration.
The first option is to disable Optimistic Mode. The
second is to disable the Require Check Out SharePoint
setting by switching it to No, then switching it back to
Yes after migration.

the files will be incremented by the smallest version
number type that is available (that is, by one minor
version or major version depending on what version
types are set).

all of the files will be migrated and automatically
checked in, and they will have the same version number
that existed in the source environment.

the documents will have a version number of 1.0
(because the documents will be viewed as "new" in the
SharePoint environment, and they will be published as
the first major version).

To enable or disable Optimistic Mode:

In Content Matrix Console main ribbon, choose Settings > Enable Optimistic Mode, which is:

e Highlighted when enabled

L

Enable
Optimistic Mode

e Not highlighted when disabled

L

Enable
Cptimistic Mode
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Connecting to a File System

In order to connect to a file share, you will need the system path (address) to the file share, and your
login account must have access to the file share.

To Connect to a file system directory:

1. Inthe main Console ribbon, select Connection > Connect to File System.

2. Inthe Connect to File System dialog, and enter or browse to the file share.

Connect to File System E3

Connect to path docs-common. metalogix.internal\DocsShare \Projects ]

| QK | | Cancel |

NOTE: If you are copying a Sensitive Content Manager (SCM) report that has been imported into
Content Matrix, make sure that the connection uses the same Source Path that is specified in the .csv
file.

3. Click [OK] to establish a File System connection.

Note that, by default, the Explorer view shows only the folder structure of the connected File System.

=] C:\Users\doconnor\Documents\HelpAndManual Projects (1 file, 1 directory)
[=] l—_— Examples {10 directories)
l—_—' Conditional Qutput (11 files)
= l—: ePub Covers (3 files, 2 directories)
l—_—' Cover Graphics (5 files)
E Graphics (23 files)
= l—_— Feature Images (2 files, 1 directory)
E images (16 files)
= l—_— Get Me Started Example (2 files, 1 directory)
E Pictures (39 files)
l—_—' HelpAndManual7 (14 files, & directories)
[ HTMLS Tricks (1 file)
l—_—' Interactive Media {17 files)
E Modular Help Systems (15 files)
l—_—' Multiple TOCs (1 file, 1 directory)
l—_—' Windows eBooks (2 files, 1 directory)

To show files in Explorer View:

1. Select the top-level connection node for the File Share connection.

2. Right-click and choose Show Files.

Content Matrix File Share Edition
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8

Connecting to SharePoint

The following basic connection adapters are supported for making connections to SharePoint from
Content Matrix Console:

e Alocal connection to a SharePoint site or server *

e Aremote connection to a SharePoint site or server

e Aclient side object model (CSOM) connection for SharePoint Online at the site level
e An Microsoft 365 Tenant connection (based on the CSOM connection type)

* As of version 9.3 the Content Matrix Console client application requires Microsoft .NET Framework
4.7.2 to run. Since this .NET requirement applies to the machine on which Content Matrix is installed,
Content Matrix cannot make a local Object Model (OM) connection on a SharePoint 2007 or 2010
environment, because SharePoint 2007 and 2010 require an earlier version of the .NET Framework
(v.3.5), which prohibits Content Matrix from completing the connection. Because of this, any
migration ‘jobs’ configured to connect to SharePoint 2007 and 2010 environments using a Local OM
connection type will cease to work, and these jobs will need to be recreated for use over MEWS.

The following table identifies the connection adapter types for each supported version of SharePoint:

SharePoint Local Object Model Remote Object Model = SharePoint ClientSide = Microsoft 365 Tenant
Server Type (OM) Connection (OM) Connection Object Model (CSOM) Connection
(Content Matrix (Metalogix Extensions  (includes support for (includes support for,
Console - installedon = Web Service installed  Microsoft Teams, One One Drives)
server) on remote server) Drives and Groups)
Microsoft 365 _ , ,
Microsoft

SharePoint 2016

Microsoft
SharePoint 2019

Microsoft
SharePoint
Subscription
Edition

A YRR SA "
) SR NA N
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* Currently, if Content Matrix is installed in a FIPS-enabled environment, you cannot connect to or
migrate to SharePoint 2019 with a local or remote server connection. For SharePoint Server
Subscription Edition in a FIPS-enabled environment, you can only connect using a remote object model
connection. See Errors Connecting to SharePoint 2019 or SharePoint Server Subscription Edition in a
FIPS-Enabled Environment for more information.

Connecting to a SharePoint Site or Server

The same connection methods and options can be used for a normal connection to SharePoint and a
read-only connection to SharePoint. The below steps can be used for both connection types. The read-
only connection can be used to help users keep their source and target connection separate (and it can
help ensure that users do not accidentally migrate any data to a source connection).

NOTES:

e When making a secure connection to a SharePoint URL that is configured with TLS, Content Matrix
can use any version of TLS that is compatible with .NET Framework 4.7.2. The default version of
TLS used by the operating system on the machine from which you are connecting will be used by
Content Matrix.

e Currently, connections to a SharePoint server cannot be made for SharePoint 2019 in a FIPS-
enabled environment. (See Errors Connecting to SharePoint 2019 or SharePoint Server Subscription
Edition in a FIPs-Enabled Environment for more information.)

To connect to a SharePoint site or server:

In the Content Matrix ribbon, choose Connection > Connect to SharePoint.

Content Matrix
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SharePoint Logon

(O Connection Options Address:
&3

Target Type:

% Proxy Options Connection Type:

Authentication Type:
| g?al Induded Certificates
Connect As

| v

® Site Web App Farm Office 365 Tenant @
Auto Detect v @
Auto Detect v e

@) AXCELERTEST \testbenchfarm

Different user:

Password:

®

Override SharePoint Online Tenant Domain Name

OK | ‘ Cancel

To complete the Connection Options tab:

1.

For Address, enter either the URL or IP address of the SharePoint site or server to which you want

to connect.

Note that the drop-down menu displays a list of previous connections.

For Target Type, select the connection type. Use the information in the following table for

guidance.

If you want to connect...

directly to a SharePoint site

to a specific Web application on a
SharePoint server

to a SharePoint instance at the
Farm/server level

Select ...

Site.

Web App.
NOTE: This option can only be used if using the
Local or Metalogix Extensions Web Service

connection type.

Farm.

Content Matrix File Share Edition
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If you want to connect... Select ...
NOTE: This option can only be used if using the
Local or Metalogix Extensions Web Service
connection type.

(which will allow you to see all site
collections for all Web Application on the
selected server)

3. Select a Connection Type from the drop-down. Use the information in the following table for
guidance.
Connection Type: Remote Connection (Metalogix SharePoint Extensions Web Ser... |V {
Auto Detect {
Local Connection (SharePoint Object Model)
Remote Connection (Metalogix Sharig::int Extensions Web Service)
Remote Connection (SharePoint ClierwsSide Object Model 0365)

If ... Select ... Notes
you want to have
Content Matrix choose
the connection

Auto Detect e If the SharePoint instance is local

(installed on the same machine as the
Content Matrix Console), the Local

adapter type that Connection (SharePoint Object
makes the most sense Model) will be used
for the target

SharePoint instance

Content Matrix .
Local Connection

(SharePoint Object
Model)

Console is installed
locally (that is, on the
same SharePoint
server or one of its
Web Front Ends (WFEs)

e |f the SharePoint instance is remote
(installed on another machine), and the
Metalogix Extensions Web Service is
installed, the Remote Connection
(Metalogix Extensions Web Service)
type will be used.

This connection type

e is generally recommended for the
target SharePoint instance if possible,
to help with performance and to help
provide the product with greater
leverage into SharePoint.

AND

e the account used for the connection.
must be the logged in user and have
the following permissions:

e Farm Administrator
e Sjte Collection Administrator

e DB_Owner on the Content
Database (to allow the connecting



If ... Select ...

¢ Content Matrix Remote Connection
Console is not (Metalogix Extensions
installed locally Web Service)

AND

e Metalogix
Extensions Web
Service (MEWS) is
installed on the
SharePoint
server/WFE to
which you are
connecting

Notes

user access to the local SharePoint
Object Model).

The connecting account requires Full
Control over the content being connected
to and migrated. Additional permissions are
provided through the use of the Metalogix
Extensions Web Service.

NOTE: Although it is strongly
recommended that the version of the
Metalogix Extensions Web Service
(MEWS) match the installed version of
Content Matrix, you can override it to use
an earlier MEWS version.

NOTE: As of version 9.5, Content Matrix no longer supports CSOM connections to SharePoint on
premises. The option will work for backward compatibility with existing jobs, but if you select it
for a new connection, a pop-up warning will display.

4. For Authentication Type, select the method to use when trying to connect to the specified

SharePoint instance.

Use the information in the following table for guidance.

Auto Detect

Auto Detect

Windows Authentication

| Forms Based Authentication
Microsaft 365 OAuth/Standard/ADFS Authentication
Microsoft 365 OAuth with MFA Authentication (Mot Auto Detected)
Web Browser Authentication (Mot Auto Detected)
Microsoft 365 Web Browser Authentication (Mot Auto Detected)

If ...

you want Content Matrix to
automatically check against
the SharePoint environment

Select ....

Auto Detect

Notes

Content Matrix will check for non-
Microsoft 365 authentication types
listed in the drop-down (in order), and
use the first method that is found.

Content Matrix
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If ...

you want to connect to the
SharePoint environment

using the currently logged in
Windows user’s credentials

e you selected Metalogix
Extensions Web Service
as the Connection Type

AND

e youwant to connect
using Forms Based
Authentication

Select ....

Windows
Authentication

Forms Based
Authentication

you want to connect through | Web Browser

a Web browser

Authentication (Not
Auto Detected)

Notes

e The logged in user credentials are
used by default; however, other
credentials that use this
authentication method can also be
entered.

e This is the authentication type that
most environments use.

e Most setups for Forms Based
Authentication are supported.

e This method is limited to the
Metalogix Extensions Web Service
connection type because it
authenticates through 1IS and not
Active Directory (AD).

NOTE: This authentication type is not
supported for running a job using a
PowerShell script. Refer to the Quest
Support Knowledge Base article
Connections that will work with

PowerShell and Connections that

doesn't work with PowerShell for

complete details.

This option is not searched for within
the “Auto Detect” option, and needs to
be manually set.

In order for the Content Matrix
Console to logon to the system, users
must have logged on to the system
being connected to through the web
browser on that system first (only
before the initial connection). Since
this is all done using the Web browser
for authentication, the credentials
section of the window will be grayed
out (since it is not needed), and it is
limited to the Metalogix Extensions
Web Services Connection Type
because it authenticates through IS
and not the Active Directory (AD).

NOTES:


https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell

Select .... Notes

e Because this authentication type
uses cookies from the browser, it
may require multiple logins when
running a single migration.
However, this is only likely if the
migration is running for a long
session; this is mainly determined
by the web browser settings for
authentication. In the event that a
login is required, a dialog box
appears that lets users log in. After
the user logs in, the migration will
continue from where it left off.

e This authentication type is not
supported for running a job using a
PowerShell script. Refer to the
Quest Support Knowledge Base
article Connections that will work
with PowerShell and Connections
that doesn't work with PowerShell
for complete details.

5. For Connect As, enter/select the login credentials you want to use to connect to the SharePoint
site/server. Use the information in the following table for guidance.

NOTE: This option is disabled if you selected Local Connection (SharePoint Object Model) or
Web Browser Authentication (Not Auto Detected).

If you want to ...

use the current Windows
user's authentication
credential

use different authentication
credentials

Then ...

Select the (default) <Domain>\<user> radio button.

e Select the Different User radio button, and

e Enter the applicable user name and Password.

In cases where alternate credentials are entered, it is
recommended that you select the Remember my password
check box so Content Matrix will automatically remember that
user account password. This is especially important if you chose
Web Browser Authentication, as credentials must be stored in
the Credential Manager vault before the connection is made.


https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell

6. If you need to configure proxy settings:
a) Select the Proxy Options tab.

b) Follow the procedure for Configuring Proxy Settings.

SharePoint Logon E3

&.ig Connection Options

#® Import Proxy From Internet Explorer Enter Manually
% Proxy Options Server name: Port:
Connect As
| I Induded Certificates
2 ® METALOGIX\doconnor
Different user:

Password:

7. If youwant to Add or Remove certificates to be included when connecting to SharePoint:

a) Select the Included Certificates tab.

Please see the Connecting with Certificates for more details on connecting to SharePoint
instances that require certificates.

b) After all of the desired connection options have been set, for all options tabs, click [OK] to
establish the connection.

If you selected a connection type other than Site, the Limit Site Collections dialog displays, giving
you the option to limit the site collections to include in your connection (when importing an xml file
with the list of URLs you want to include). This is useful if the environment you are connecting to
includes a very large number of site collections. In this case, limiting displayed site collections can
improve performance.

Limit Site Collections E3

® Would you like to limit the Site Collections shown in this Connection?

| Yes - Import from XML | | Mo - Continue with Connection |

Wiew Sample ¥ml

NOTE: If you want to View Sample xml, click the link on the dialog. The xml file you import must
follow the same format as this sample.

8. Either:

Content Matrix
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= (Click [Yes = Import from XML] to specify the URLs of the sites you want to include in the
connection, then browse/upload the file

OR

= Click [No — Continue with Connection] to add all sites within the selected scope to the

connection.

If Content Matrix successfully makes the connection, a new node will appear in the Explorer View, and
you can expand this node and navigate through the SharePoint objects.

Connecting to SharePoint Online

Content Matrix Console can make a tenant or site level connection to a SharePoint Online
environment.

To connect to SharePoint Online:

In the Content Matrix ribbon, choose Connection > Connect to SharePoint.

SharePoint Logon

(O Connection Options
&3

% Proxy Options
| g?al Induded Certificates

Address: |
Target Type: @ Site
Connection Type: Auto Detect

Authentication Type: | Auto Detect

Connect As
@) AXCELERTEST \testbenchfarm

Different user:

Password:

Override SharePoint Online Tenant Domain Name

Web App

v
Farm Office 365 Tenant @
v @
v @
S
(7]
OK | ‘ Cancel

To complete the Connection Options tab:

1.

For Address, enter either the URL or IP address of the SharePoint site or tenant to which you want

to connect.

Content Matrix File Share Edition

Connecting to SharePoint

40



Note that the drop-down menu displays a list of previous connections.

2. For Target Type, select the connection type. Use the information in the following table for

guidance.
If you want to connect... Select... Notes
directly to a SharePoint Site. This option must be used for a
site site-level connectionto a
Microsoft 365 tenant
NOTE: If you want to connect
to a Microsoft 365 tenant root
node, use the Microsoft 365
Tenant connection type.
to the root of a Microsoft 365 Tenant. This connection type has most of
Microsoft 365 Tenant the limitations of the CSOM
environment connection adapter, but can run

Site Collection migrations.
(comparable to a farm-

level connectioninanon
premises environment)

3. For Connection Type, select Remote Connection (SharePoint Client Side Object Model 0365).

NOTE: If you accept the default (Auto Detect), this option will be detected automatically.

Auto Detect Vl:}

F L ' p— T Y| .
DNIMETI0N | SNarSr oL LDJECT IMI00E] |

- - - \
onnection (Metalogin SharePoint Extensions Web Service)

. L el — o I B g B v P T P Tl
pnnechion (SharePoint Client Side Object Model O355)

4. For Authentication Type, select the method to use when trying to connect to the specified
SharePoint instance. When connecting to Microsoft 365, the two main Authentication Types will be
Microsoft 365 OAuth/Standard/ADFS Authentication and Microsoft 365 Web Browser
Authentication (Not Auto Detected). Use the information in the following table for guidance.

Auto Detect W

Auto Detect
Windows Authentication
| Forms Based Authentication
Microsoft 365 OAuth/Standard/ADFS Authentication
Microsoft 365 QAuth with MFA Authentication (Mot Auto Detected)
Web Browser Authentication (Mot Auto Detected)
Microsoft 365 Web Browser Authentication (Mot Auto Detected)

For a SharePoint Online connection that uses "modern" (not "legacy") authentication, you must select
one of the Microsoft 365 OAuth Authentication options or Microsoft 365 Web Browser. If the account

Content Matrix
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is also part of a SharePoint Online Multi-Factor Authentication Policy, Microsoft 365 Web Browser or
Microsoft 365 OAuth with MFA Authentication must be used.

NOTE: Microsoft 365 Web Browser Authentication is not supported for jobs run from a PowerShell
script.

For more information about legacy vs. modern authentication, refer to the Microsoft article Microsoft
365 feature descriptions.

If ... Select .... Notes

you want Content Matrix to | Auto Detect Content Matrix will check for
automatically check against authentication types listed in the drop-
the SharePoint environment down (in order), and use the first

method that is found.

NOTE: At the time you click [OK] to
complete the connection, a pop-up
box will display that asks if you want
to use Microsoft 365 OAuth. See
Using Microsoft 365 OAuth
Authentication to Connect to
SharePoint Online for details.

By default the logged in user
credentials will be unavailable, since

e you want to connect to
Microsoft 365 OAuth,

Microsoft 365

) OAuth/Standard/ADFS » S -
Microsoft 365 — Standard Authentication® this uses the Windows authentication
editions, or systems with method, and the Microsoft 365
ADFS credentials will need to be entered.

NOTE: At the time you click [OK] to
complete the connection, a pop-up
e MFA is not being used box will display that asks if you want
to use Microsoft 365 OAuth. See
Using Microsoft 365 OAuth
Authentication to Connect to

AND

SharePoint Online for details.

With this authentication type, you do
not have to enter account credentials
in Content Matrix, and the Connect As
options will be disabled.

your account requires the Microsoft 365 OAuth

use of Multi-Factor with MFA

Authentication (MFA) Authentication (Not
Auto Detected)*

This option is not searched for within
the “Auto Detect” option, and needs to
be manually set.

In order for the Content Matrix

you want to connect through | Web Browser
a Web browser Authentication (Not
Auto Detected)

Console to logon to the system, users
must have logged on to the system


https://social.technet.microsoft.com/wiki/contents/articles/36857.sharepoint-online-o365-set-up-multi-factor-authentication.aspx
https://learn.microsoft.com/en-us/microsoft-365/admin/m365-feature-descriptions?view=o365-worldwide&tabs=User-account-management
https://learn.microsoft.com/en-us/microsoft-365/admin/m365-feature-descriptions?view=o365-worldwide&tabs=User-account-management

If ... Select .... Notes

being connected to through the web
browser on that system first (only
before the initial connection). Since
this is all done using the Web browser
for authentication, the credentials
section of the window will be grayed
out (since it is not needed), and it is
limited to the Metalogix Extensions
Web Service Connection Type because
it authenticates through IIS and not the
Active Directory (AD).

NOTES:

e Because this connection method
uses cookies from the browser, it
may require multiple logins when
running a single migration.
However, this is only likely if the
migration is running for a long
session; this is mainly determined
by the web browser settings for
authentication. In the event that a
login is required, a dialog box
appears that lets users log in. After
the user logs in, the migration will
continue from where it left off.

e For migrations from SharePoint
Online to SharePoint Online, web
browser authentication is currently
not supported for a source
connection.

e This authentication type is not
supported for running a job using a
PowerShell script. Refer to the
Quest Support Knowledge Base
article Connections that will work

with PowerShell and Connections

that doesn't work with PowerShell

for complete details.

you want to connect through | Microsoft 365 Web This option works the same as Web
a Web browser using Browser Authentication | Browser Authentication (Not Auto
Detected) except:


https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell

If ... Select ....

authentication for Microsoft

365
you want to make a site- Microsoft 365 User
level connection to a GCC Provided

High site using Microsoft 365 | Authentication
User Provided
Authentication

(hidden by default)

Notes

e it looks for more specific Microsoft
365 cookies

e it requires that users first log into
Microsoft 365 through the browser

e instead of allowing multiple logins,
only one "request" for data can be
made at a time, which ensures that
no data is missed or lost due to the
system locking from too many
requests (but which may result in a
slower connection).

NOTE: This authentication type is not
supported for running a job using a
PowerShell script . Refer to the Quest
Support Knowledge Base article
Connections that will work with
PowerShell and Connections that

doesn't work with PowerShell for
complete details.

You must first run a utility provided by
Quest Support and enable the setting
EnableUserProvidedAuthentication.
Refer to the Quest Support Knowledge
Base article Enabling User Provided
Authentication in Content Matrix for

details.

* If you are connecting to SharePoint Online using OAuth authentication and you used a custom
domain as the Address, you will also need to check the Override SharePoint Online Tenant
Domain Name and enter the default tenant domain name (which can be found at
https://admin.microsoft.com/Adminportal#/Domains) to allow Content Matrix to route the

request to the proper region.

Metalogix Software

Domains

| Override SharePoint Online Tenant Domain MName

metalogixsoftware522, onmicrosoft.com (7]

\ + add domain = Buy domain () Refresh
i Status

Domain name

\O MetalogixSoftware622.onmicrosoft.com (Def., @ Healthy

ControlPoint.com

i Choose columns

]’-:\ MetalogixSoftware622 onmicrosoft.com (Default)
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https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/4274605/connections-that-will-work-with-powershell-and-connections-that-doesn-t-work-with-powershell
https://support.quest.com/metalogix-content-matrix/kb/330254/enabling-user-provided-authentication-in-content-matrix
https://support.quest.com/metalogix-content-matrix/kb/330254/enabling-user-provided-authentication-in-content-matrix
https://admin.microsoft.com/Adminportal#/Domains

5. For Connect As, enter/select the login credentials you want to use to connect to the SharePoint
site/server. Use the information in the following table for guidance.

NOTE: This option is disabled if you selected Microsoft 365 OAuth with MFA Authentication, or
Web Browser Authentication (Not Auto Detected).

If you want to ... Then ...

use the current Windows Select the (default) <Domain>\<user> radio button.
user's authentication

credential

use different authentication e Select the Different User radio button, and
credentials

e Enter the applicable user name and Password.

In cases where alternate credentials are entered, it is
recommended that you select the Remember my password
check box so Content Matrix will automatically remember that
user account password. This is especially important if you chose
Web Browser Authentication, as credentials must be stored in
the Credential Manager vault before the connection is made.

6. If youwant to Add or Remove certificates to be included when connecting to SharePoint:

a)

b)

Select the Included Certificates tab.

Please see the Connecting with Certificates for more details on connecting to SharePoint
instances that require certificates.

After all of the desired connection options have been set, for all options tabs, click [OK] to
establish the connection.

If you are making a tenant-level connection, the Limit Site Collections dialog displays, giving you
the option to limit the site collections to include in your connection (which by importing an xml
file with the list of URLs you want to include). This is useful if the environment you are
connecting to includes a very large number of site collections. In this case, limiting displayed
site collections can improve performance. Additionally, the Include Microsoft 365 tenant my
site host connection allows One Drives to display under their own top-level connection node
(alongside the main tenant node) with the following URL format: http://[Tenant URL]-
my.sharepoint.com. It is selected by default, but if you want to exclude them from the
connection, uncheck this box.

Limit Site Collections E3

Would you like to limit the Site Collections shown in this Connection?

Indude Microsoft 365 Tenant My Site Host connection

| Yes - Import from XML | | Mo - Continue with Connection

View Sample Xl

Content Matrix
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NOTE: If you want to View Sample xml, click the link on the dialog. The xml file you import must
follow the same format as this sample.

7. Either:

= Click [Yes = Import from XML] to specify the URLs of the sites you want to include in the
connection, then browse/upload the file

OR

= Click [No — Continue with Connection] to add all sites within the selected scope to the
connection.

If Content Matrix successfully makes the connection, a new node will appear in the Explorer View (two
if you opted to include One Drives), and you can expand the node(s) and navigate through the
SharePoint objects.

NOTE: Should the log file ever show a "could not find site on remote SharePoint server" exception
message when working with CSOM connections, simply restart the CSOM service on all machines
running the Content Matrix console and then rerun the action.

Using Office Microsoft 365 OAuth Authentication to Connect
to SharePoint Online

Microsoft 365 OAuth Authentication is a token-based authentication method that can be used as an
alternative to Standard/ADFS Authentication to reduce throttling.

If Multi-Factor Authentication is set up for the tenant and enabled for the account (as described in the
Microsoft TechNet article SharePoint Online - Microsoft 365: Set up Multi-Factor Authentication), you
can connect using M365 OAuth with MFA Authentication as an alternative to Microsoft 365 Web
Browser authentication.

Registering the Content Matrix SharePoint Client Application for
OAuth Authentication

The very first time OAuth Authentication is selected, the application Content Matrix SharePoint Client
must be registered for the tenant.

IMPORTANT: Prior to version 9.2, the Metalogix SharePoint Migration Client application was used
for OAuth Authentication. Jobs created before version 9.2 (including those that use PowerShell) will
continue to use this application (as long as it is still registered in Entra ID). Starting with version 9.2,
all jobs using OAuth Authentication will use the Content Matrix SharePoint Client application.

Required Permissions

At a minimum, the following permissions are required to register and provide consent for the Content
Matrix SharePoint Client application.

e For a site-level connection, the account must have a minimum of Site Administrator and
Application Administrator permission roles.

Content Matrix
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https://social.technet.microsoft.com/wiki/contents/articles/36857.sharepoint-online-o365-set-up-multi-factor-authentication.aspx

e For a tenant-level connection, the account must have a minimum of Application Administrator
permission role.

Providing Consent to Grant the Application Requested Permissions

The first time a Content Matrix user attempts to connect to SharePoint Online using Microsoft 365
OAuth Authentication, a dialog displays requesting that you grant the permissions that the application
needs to perform migrations.

A Global Administrator can check the Consent on behalf of your organization box, which will prevent
this dialog from displaying for other users. If the account is not a Global Administrator, the Consent on
behalf of your organization option will be hidden.

IMPORTANT: If a Global Administrator does not consent on behalf of the organization, each
Content Matrix user who attempts to connect using Microsoft 365 OAuth Authentication for the first
time must sign in with an account that has the Application Administrator and SharePoint
Administrator permission role.

After [Accept] is clicked, the connection is created (and the application will be registered if it does not
already exist in Entra ID). In addition, the token cache file ConnectionsTokenCache.dat is created in
the AppData/Roaming/Metalogix folder. (Note, if you have used OAuth Authentication in an earlier
version of Content Matrix, this file will already exist.)

Completing a Connection to SharePoint Online Using Office 365
OAuth Authentication

When you select one of the Microsoft 365 OAuth authentication types, before making a connection to
SharePoint Online, a pop-up specific to the authentication type will display, as described in the
following table.

NOTE: If you click the Do not show the message again. box, Content Matrix will continue to use the
selected option and no longer display the pop-up. You can resume having the pop-up display by
clicking Reset Configuration Options on the ribbon toolbar Settings tab.

If you selected... Then ...

Auto Detect or the pop-up will ask you to confirm that you want to use the Microsoft 365
Office365 OAuth option.

OAuth/Standard/ADFS

Authentication
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If you selected... Then ...

Office 365 OAuth with MFA Authentication

Lising this authertication type, you can create a connaction to a
SharePoirnt Online Ste or Tenant, which will use a token to authenticate
the connection to SPO

Do not show this message again.§ QK Cancel

Choose [Yes - Use OAuth].

Microsoft 365 OAuth the pop-up will inform you of some migration limitations associated with
with MFA this authentication type.

Authentication (Not ]

Auto Detected) 9 Microsoft 365 OAuth or Standard/ADFS Authentication

Microsoft reduces the chance of throttling when OAuth authentication is
used far migrations.

Quest recommends that migration users use OAuth authentication and
provide consent to using the Guest app.

Yes - Use Oauth Mo - Use Microsoft 365 Standard /ADFS

Do not show this message again.;

Signing into your Microsoft 365 Account to Use Microsoft 365
OAuth Authentication

When prompted to sign into your Microsoft 365 account, for Auto Detect or Microsoft 365
OAuth/Standard/ADFS Authentication, you must use the account you specified as the Connect As
account in Content Matrix. The connection will fail if you try to sign in with another account. (This is
not an issue with Microsoft 365 OAuth with MFA Authentication, which does not use a Connect As
account.)
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cpgauser 16 - onmicrosoft.com )

| Remember my password

Sign in to your account

B Microsoft

@qauseﬂ@- L P onmicrosoft.coD

Enter password

Forgot my password

Sign in with another account

IMPORTANT: If you are using OAuth Authentication for the first time, a dialog may display
requesting that you consent to granting permissions that the application needs to perform migrations.
To provide this consent, the account must be an Application Administrator. (This dialog will not
display if a Global Administrator has granted consent on behalf of the organization.)

Sign in to your account -

A
BS Microsoft

abduluser2@metalogixsoftware622.onmicrosoft.com

Need admin approval

200 IContent Matrix SharePoint Client
05¥ quest.com

Metalogix Content Matrix SharePoint Client needs
permission to access resources in your organization that
only an admin can grant. Please ask an admin to grant
permission to this app before you can use it.

Have an admin account? Sign in with that account

Return to the application without granting consent

Migrating to SharePoint Online Using the Import Pipeline

Content Matrix currently has limited support for migration using the Import Pipeline.

By default, when the Use Import Pipeline option is checked on the Folder Options or File Options tab,
the SPO Provided Azure Containers option is selected. However, if you want to use Azure Private
Containers, you will also need to populate the Azure Storage Connection String field.

Note that the Pipeline is not used to export from a SharePoint Online source.

For detailed information on additional system and configuration requirements for using the Import
Pipeline, please see:

e Configuring Settings for Migrations Using the Import Pipeline
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e the Content Matrix Performance Optimization Guide for information on configuring Azure Private
Containers for use with Content Matrix.

Objects and Actions Supported Using the Import Pipeline

Supported Objects

The following is a list of objects that can be migrated using the Import Pipeline:

e Metadata associated with files and folders
e Overwriting existing files and folders

e Document Sets

Supported Actions

The following is a list of actions that are currently supported for Import Pipeline migration:

e Paste Files

Paste Folder

Paste Folder > As Document Library

Paste Folder > As Site

The following hierarchy-related actions:
= Following a Copy File action, Paste Web Hierarchy

= Following a Copy Folder action, Paste Folder Hierarchy and Paste Hierarchy

How Content Matrix Determines Import Pipeline Migration Batch
Sizes

When migrating using the Import Pipeline, the EnvironmentSettings.xml file includes configurable
thresholds for batch sizes in both number of items (200 by default) and size (1000 MB by default).
Content Matrix determines the size of a batch to upload to SPO when the lower threshold is met.

For example:

o |f a library has 20 documents, each of which is 100 MB, Content Matrix will use the size threshold and
will create two batches of 1000 MB.

e |f a library has 1000 documents, each of which is 1KB, Content Matrix will use the item threshold and
will create five batches of 200 items.

Refer to the topic Configuration Settings for Migrations Using the Import Pipeline for information on
changing batch sizes and other Import Pipeline configuration settings.
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Connecting with Certificates

When connecting to SharePoint, there are two options that can be used to add certificates to the list of
included certificates: Add Installed Certificate and Add Certificate From File.

SharePoint connections do not actually save the certificate information directly, but instead they save
the data on how to locate the certificates that are in use. This means that if the certificates are deleted
or moved from the referenced location, they will no longer be used with the SharePoint connection
and will have to be manually re-added.

SharePoint Certificates are also supported when generating a PowerShell script. It is still recommended
that the initial SharePoint connection is first configured in the Content Matrix Console. The
recommended process when working with certificates and PowerShell is to first add the connection
(with certificates) in Content Matrix, then set up a migration action in the Ul and generate a PowerShell
script. This will allow you to get the connection format that is required to create a connection in
PowerShell, and it can then be written out manually (if desired).

It should also be noted that the Web Browser Authentication type does not automatically detect
certificates. In order for certificates to be included with this method, they must first be installed in the
appropriate locations in order for a web browser itself to access them.

NOTE: Insome cases, including certificates can potentially result in receiving "maximum request
length" messages when migrating smaller files because the certificate information is included when
the data is being migrated.

To Add Installed Certificates:

Only "Personal" certificates can be added in this manner because it is the only store that web browsers
use to find certificates when accessing a website.

1. Inthe SharePoint Logon dialog, select the Include Certificates tab.
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SharePoint Logon E3

&.ig Connection Options Friendly HName Issued To Issued By Add Installed
Certificate

% Proxy Options Add Certificate
From File

| @I Induded Certificates

< > 2]

OK | | Cancel |

2. Click [Add Installed Certificate].

The Add Installed Certificates dialog displays all of the certificates that are installed in the logged
in user account's "Personal" certificate store.

3. Select any certificates that should be included, and click [OK].

When you return to the SharePoint Logon dialog the selected certificates be displayed in the Included
Certificates list, and they will be included whenever Content Matrix is running an action to or from the
SharePoint connection.

To Add a Certificate from a file:

1. Inthe SharePoint Logon dialog, select the Include Certificates tab.
2. Click [Add Certificate From File].
3. Either:

= enter a filename and location into the Certificate File text box

OR

= select the Browse button to open a file explorer dialog and navigate to, and select, the desired
certificate.

4. If a password is required to use with the certificate, enter it in the Password (optional) text box.

NOTE: When a connection to SharePoint is made, Content Matrix will save the password field for
any certificates so it can re-establish a connection to that SharePoint instance at a later date. If
you are not comfortable with entering the password in the Password (optional) field, you can move
the certificate into the user account's "Personal" folder, and use the Add Installed Certificate

option instead, provided the user account/password is the same.
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When you return to the SharePoint Logon dialog, the selected certificate will display in the Included
Certificates list, and it will be included whenever Content Matrix is running an action to or from the
SharePoint connection.

Important Note About Self-Signed Certificates

For security purposes, Content Matrix always attempts to validate a certificate when connecting to a
TLS/SSL site. Content Matrix cannot validate a self-signed certificate for an on-premises connection
however, and if it attempts to do so you will be unable to complete the connection. To avoid this
issue, you must change the value of the key BypassCertificatevValidation inthe
EnvironmentSettings.xml file to True.

Removing Certificates

Any certificates that have previously been added through the two Add Certificates options can also be
removed from the list of Included Certificates.

To remove a certificate:

1. Inthe SharePoint Logon dialog, select the Include Certificates tab.
2. Select the certificate(s) that you want to remove.

3. Click [Removel].

Connecting to SharePoint Using PowerShell

You can create and edit connections to SharePoint using PowerShell. These connections will be
displayed in the Content Matrix Console.

To access the PowerShell cmdlets for connecting to SharePoint:

Open a PowerShell or PowerShell ISE session and add the PowerShell snap-ins for the application
framework.

The following cmdlets are now available:

e Get-MLSharePointConnections

e New-MLSharePointConnection

e Set-MLSharePointConnection

e Remove-MLSharePointConnection

To retrieve information about active connections in the Console:

Select (from the PowerShell ISE Command Window) or enter Get-MLSharePointConnections, then run
the cmdlet.
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Details display for each active connection.

To create a new connection to SharePoint:

1. Select (from the PowerShell ISE Command Window) or enter New-MLSharePointConnection.

2. Select or enter the applicable parameters. Use the information in the following table for guidance.

Parameter

Address

(Required)

AuthenticationType

(Required)

ConnectionType

(Required)

TargetType

(Required)

Notes

The Url of the SharePoint object (Site, Farm, WebApp or Tenant) you
want to connect to.

Valid values are:
e Windows

e FormsBased
o Adfs

NOTE: Currently this cmdlet does not support connecting to
SharePoint Online with OAuth authentication.

e UserProvided

NOTE: UserProvided authentication is used to make site-level
connections to special types of tenants, such as GCC High. To use
this type of authentication, you must first run a utility provided by
Quest Support and enable the setting
EnableUserProvidedAuthentication. Refer to the Quest Support
Knowledge Base article Enabling User Provided Authentication in
Content Matrix for details.

Valid values are:
e Om (local object model)

e MEWS (remote connection using Metalogix Extensions Web
Service)

e CSOM (for SharePoint Online targets only)

Valid values are:
e Site
e WebApp

e Farm


https://support.quest.com/metalogix-content-matrix/kb/330254/enabling-user-provided-authentication-in-content-matrix
https://support.quest.com/metalogix-content-matrix/kb/330254/enabling-user-provided-authentication-in-content-matrix

Parameter Notes
ConnectAsCurrentUser Use this parameter if you want to make a SharePoint on-premises
connection using the currently logged-in user.

NOTE: This parameter is not necessary when using an OM
connection, which automatically connects as the currently logged-in
user.

MewsVersion This parameter is only necessary if you want to use an older version
of the Metalogix Extension Web Service.

Password The password of the account making the connection.

RememberPassword This option is recommended to to ensure that the connection
remains active after the PowerShell session has ended. [f it is not
used, the password will have to be re-entered.

Readonly Use this parameter if you want to make a read-only connection to a
SharePoint source.

SkipConnectionCheck Use this parameter if you want to skip validation of the connection.
This is useful if you use a connections factory and speeds up the
creation of connections.

User The user account making the connection.

3. Runthe cmdlet.
Example Scripts:

New-MLSharePointConnection -Address http://win-pvf4cd21lmb55/ -
AuthenticationType Windows -ConnectionType MEWS -TargetType Site -Password
"Pass" -User Administrator -RememberPassword

New-MLSharePointConnection -Address https://metalogixsoftware-
admin.sharepoint.com -AuthenticationType Adfs -ConnectionType Csom -
TargetType Tenant -Password "Pass" —-RememberPassword -User
cpgauser@metalogixsoftware.onmicrosoft.com
To edit a connection to SharePoint:
1. Select (from the PowerShell ISE Command Window) or enter Set-MLSharePointConnection.
2. Enter the Connectionlid.

NOTE: You can obtain the Connectionld by running the Get-MLSharePointConnections cmdlet.

You can now update any of the following parameters, then run the cmdlet:

e ConnectAsCurrentUser (on premises connections only)



e Password
¢ RememberPassword
o SkipConnectionCheck

NOTE: Use this parameter if you want to skip validation of the connection. This is useful if you u
a connections factory and speeds up the creation of connections.

e User
Example Script:
Set-MLSharePointConnection -ConnectionId '91335f9¢c-9311-439e-9b8e-

78d6f7ef480a' -Password pass —-RememberPassword -User Administrator

To remove a SharePoint connection:

se

1. Select (from the PowerShell ISE Command Window) or enter Remove-MLSharePointConnection.

2. Enter the Connectionld.

NOTE: You can obtain the Connectionld by running the Get-MLSharePointConnections cmdlet.
You can remove multiple connections using the PowerShell pipeline variable.

3. Runthe cmdlet.
Example Scripts:

Remove-MLSharePointConnection -ConnectionID '2F91B056-C300-4263-9FA6-
17EEDF583594"

Remove multiple connections using the PowerShell pipeline variable:

Remove-MLSharePointConnection -ConnectionID '2F91B056-C300-4263-9FA6-
17EEDF583594 , '2F91B056-C300-4263-9FA6-17EEDF583594"', '2F91B056-C300-4263-
9FA6-17EEDF583594' | Remove-MLSharePointConnection
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Preparing for a Migration

Content Matrix offers a number of tools to help you locate and organize data and in preparation for
your migration. You can:

e Add a Filter to a File Share connection

Search for File System objects that meet criteria you specify

Import a Sensitive Content Manager (SCM) Report for Content Classification

Create SharePoint objects

Delete SharePoint objects

View StoragePoint details

Adding a Filter to a File Share Connection

You can add and edit filters on the root connection node to a file share, which will be applied to all sub-

folders and files under that connection. You may for example, only one to include files with a certain

file extensions or files that have been modified after a certain date. When a filter is added, it will be

applied to any new migration actions that are initiated from that connection. Previously

existing/configured migration actions will not have these filters applied to them.

G
=/ This option is only available when Advanced Mode is enabled.

Filters that are added and applied to a root file share connection will become default settings in the

Filter Options tab. Any changes to Filter Options will be applied to the current migration, but will not
change the filters on the root connection node.

To apply a File Share root node filter:

1. Select the root connection node for a File Share source.

2. Right-click and choose Add/Edit Filters to display the Filters Configuration dialog.
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Filters Configuration bt

If "Preserve Corfiguration Options” is disabled, filters defined below will be used as default option settings for filas
under cumert directory:

File Metadata Filters

w| Fie Namre Contains W l:l
| Fie Type e - e l:l e.g. ~docx; .msi” ("docy; nsi® for SharePaint files)
Mot Contains

Created Beforz Starts With
Mot Starts With
Created After Ends With
Modiiec Before Not Ends With
Equds L
Moditec After €/13/2024 12:12 PM
Last Accessed Before | £/13/2024 12:12PM
Last Accessed Afer €/13/2024 12212 PM
Fie Size Min
Fie Size Max

o | ]

|
3. Set desired filters as you would in the Filters Options tab.

4. Click [OK] to close the dialog and use the filters on the File Share source.

NOTE: Filters will be applied to migration actions as long as Preserve Configuration Options is
enabled, as described below.

To Enable/Disable the File Share root node filter:

1. Inthe Content Matrix main ribbon, choose Settings > Preserve Configuration Options, which is:

e Highlighted when enabled

o7

Preserve
Configuration Options

e Not highlighted when disabled

Lol

Preserve
Configuration Options

NOTE: When the root node filters are disabled, you can still access the filtering options, but the filters
will not be applied to the migration.

To remove file share root node filters:

In Explorer View, select the node containing the filters you want to remove, right click and choose
Remove Filters

You will be prompted to confirm the action before continuing.
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Using the Search Function

This search feature allows you to search within a File Share connection.

NOTE: In addition to the Search feature, the Find feature can be used on File Share sources from the
Items View tab.

To run a Search:

1. InExplorer View, select the connection in which you want to search.
2. Right-click and choose Search.

3. Enter a Search Term/Filter and/or click [Advanced Options] and select any additional criteria you

want to use.
.ocation: |7 CFile Uploads

Explorer View Items View Browser View
‘ilter: ? ‘Qa' &'

L‘ C:\Users\testbenchinstal\Desktop\Documentation\Installation Guides (4 files)

le Uploads (10 directories) )
E) https: ffmetalogixsoftware622-admin.sharep Search Directory = “
L‘ C:\Users\testbenchinstal\Desktop\Documend | gearch in: L~ C:\File Uploads 4 Show Explorer

L‘ Ci\sers\testbenchinstal\Desktop\Documen
&, http:/fcp-sp19-a-55: 1818 (Blank Site - AXCEL

[z e

B H

Search Term: || {-.‘\‘ Search | == Hide Advanced

Advanced Search Options

[] Match Search Term Exactly [] created Before | &/11/2024

[] Enable Case-sensitivity [ Created After | &/11/2024

Recursively Search Subdirectories

Search for...
Directories Documents [ Modified After | 6/11/2024

[ Modified Before | &/11/2024

i) Show Properties

Name CreateDate ModifyDate Path

4. Click [Search].
All the results of the search display in the bottom pane. Select a result from the list to:

e View the metadata field properties for a selected item (by clicking [Show Properties]).

e Perform an action on a selected item (by right-clicking it and choosing the action).
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Importing a Sensitive Content Manager (SCM)
Report for Content Classification

If your organization uses Quest® Sensitive Content Manager (SCM), you can import a .csv file that has
been exported from SCM for migrations to a SharePoint document library. Once imported, you can
choose to include or exclude files referenced in the report based on sensitivity search terms in the
"Matches" column.

‘ NOTE: Only one imported SCM report can exist in Content Matrix, but it can be replaced.
For example:
You may not want to migrate files that contain highly sensitive information (such as an ID number).

Source PalSize Created At Owner Modified A Matches

\\spiti-sp0' 497 2023-08-2 CMTEAM\E 2023-08-2 Email;Name

\\spiti-sp0' 221152 2023-08-2 CMTEAM\S 2023-08-2 Address;Contextual Information; Medicare ID;Name
\\spiti-sp0' 305 2023-08-2 CMTEAM\E 2023-08-2 Name

\\spiti-sp0' 567 2023-08-2 CMTEAM\E 2023-08-2 Address;Government|D;Name

You may want to migrate only files that include an Email.

A B C D E B
Source Path Size Created A Owner Modified At Matches
\spiti-spOitest 497 2023-08-2{ CMTEAM\ 2023-08-28 05:41:16 +00:00 Email;Name
\ispiti-sp0\testi 305 2023-08-2{ CMTEAM\ 2023-08-28 05:41:45 +00:00 Name

To import an SCM report:

1. Inthe Sensitive Content Manager application, download the report that you want to import into
Content Matrix. Refer to the Sensitive Content Manager Administration Guide for complete details.

IMPORTANT: For Format, make sure you select Metalogix Essentials.
2. From the ribbon Connections tab, select Import SCM Report.
3. Specify the Report path then click [Import].

When an SCM report has been imported and the file system connection uses the same Source Path that
is specified in the .csv file, the following Configuration check boxes will be enabled:

e on the File Options tab, Migrate matches column.

e On the Filter Options tab, Matches.

To remove an imported SCM report from Content Matrix:
1. From the ribbon Connections tab, select Import SCM Report.

2. Specify the Report Path then click [Clear mapping].
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Importing an SCM Report Using PowerShell

You can import an SCM report and remove imported reports using PowerShell.

To access the PowerShell cmdlets for SCM reports:

Open a PowerShell or PowerShell ISE session and add the PowerShell snap-ins for the application
framework.

The following cmdlets are now available:

Import-ScmReport

Clear-ScmReport

To import an SCM report:
1. Select (from the PowerShell ISE Command Window) or enter Import-ScmReport.

2. Select or enter the applicable parameters. Use the information in the following table for guidance.

Parameter Notes

-ScmReportPath The path to the SCM report (as specified in the .csv file).

-v Enable verbose status messaging.

(optional)

-F Forcefully import the report (This will delete the existing report and

. replace it with a new one.)
(optional)

3. Runthe cmdlet.
Example Script:

Import-ScmReport -ScmReportPath "\\sensitive content\scan results" -v

To remove an SCM report from Content Matrix:

1. Select (from the PowerShell ISE Command Window) or enter Clear-ScmReport. This will clear the
imported SCM report from Content Matrix.

NOTE: If you want to enable verbose status messaging, you can also enter the -v parameter.
2. Runthe cmdlet.
Example Script:

Clear-ScmReport -v
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Creating a SharePoint Object

You can create new SharePoint site collections, sites, folders, and lists via the Content Matrix Console.

Creating a SharePoint Site

You can create a new SharePoint site via Content Matrix under an existing site collection or site except
for Database connections and the new site can use any site template that is installed on the SharePoint
environment.

To create a new SharePoint site:

1. Inthe Explorer View, select the site collection or site under which you want to create the new site.

2. Right-click and choose Create Site.

The Create Site dialog displays, prompting you to enter the Site Title, Site URL Name, Description,
and Template for the new site.

NOTE: For Site URL Name, it is only necessary to enter the name of the site as you want it to
appear in the URL, not the entire URL path.

“I- Create Site E3

Site Title Operations Team Site
Site URL Mame Operations Team Site

Description The team sites for the Operations Group

Template iTeam site (no Office 365 group) (STS#3) W

‘ oK ‘ | Cancel

Note that if you are migrating to SharePoint Online or SharePoint 2019, the default template is
(modern) Team Site (no Microsoft 365 group). For SharePoint Online, Content Matrix does not
support connections to tenant-level groups.

3. When you have completed the fields on the Create Site dialog, click [OK].

The new site will now display in Explorer View.
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Create SharePoint Site Collection

You can create new site collections on a target SharePoint environment for any SharePoint connection

type, except for database and site connections.

To create a new SharePoint site collection:

1. Inthe Explorer View navigate to the SharePoint Farm/ Web Application (on premises) or Tenant
(SharePoint Online) where the new site collection should be created.

2. Right-click and choose Create Site Collection.

3. Complete the fields on the Create Site Collection dialog for the selected Mode as you would if you

were creating a site collection from within SharePoint.

NOTE: In addition, you have the option to create a host named site collection using the Host
Header option. Refer to the Microsoft TechNet article details about host-named site collections.

SharePoint On Premisas

st Create Site Collection

Web Application: SharePaint - 80 v

Site Tile: | Clients

Description: Site Collection for Clients

Content Database: Auto Detect

Hostreader. @
Site URL:
http://2010foundation | fsites/ | v | |SharePoint20 16/sites /dients

Primary Administrator: bellum‘administrater

Secondary Administrator:

Quota Settings

Language:

English(1033) v

Template:

Multipage Meeting Workspace (MP... v

SharePoint Online

% Create Site Collection

Web Application: | https: ffmetclogisoftwares22.... [w| | Language:

Site Title: | Sales Team Site Engiish(1033) i

Description: Template:

Team site (no Office 365 group) (S... | v

Site URL:

https:/fmetalogixsoftware622.sharepoint.com | fteamsf |+ | |Sales

Owner: cpuser 1@metalogixsoftwars 22, onmicrosoft. com|
Storage Quota: 10| 5 | mb

Server Resource Quota: 300 :

Note that if you are migrating to SharePoint Online or SharePoint 2019, the default template is
(modern) Team Site (no Microsoft 365 group) (STS#3). For SharePoint Online, Content Matrix
does not support connections to tenant-level groups.

4. After completing the dialog, click [OK].

The new site collection now displays in the Explorer View.
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Create a SharePoint List

You can create a new SharePoint list via Content Matrix under an existing site as long as:

the connection type is not read-only, and

the new list can use any site template that is installed on the SharePoint environment.

If site creation is not valid for the connection type, the option will be disabled.

To create a new list:

1.

2. Right-click and choose Create List.

3. Complete the Create List dialog as you would if you were creating a list from within SharePoint.

=] d% https: fjmetalogixsoftwares 2

Navigate to the SharePoint Site where the list/library should be created.

a2 NTPS: [ METAI0gIXSOTINEr &0 L2, SNErEPOINT, COM/SITEs (AD_bl
<=, htips: {{metalogixsoftwares22.sharepoint.com/sites BijusC

& ClientsSite2

& 5ubBLOGO1
i‘H AuditLogReport (2 items)
m Converted Forms
iH Doc Library (12 items)

ol

=
e

Copy Site Ctrl+C

Check Links...

Cormpare Site...

iH Doc Library Test {12 items) [

i'H Documents
-.'H Form Templates
ITT] sharing Links (1 iter)
il Site Assets (1 item)
[T site Pages (2 items)
iH Style Library (5 items)
m wipub
2, https: {fmetalogixsoftwares22
&2, htips: {fmetalogixsoftwares 22
a2 htitps: {fmetalogixsoftwares 23

[7Z)  Create List From XML...

:; Create List...

“= Create Site...

(%) Delete Site Collection Del
f_ﬁ Change 5ite Collection Settings

Farnt
ot

Refresh Mode F5

Search...

Analyze Churn...

Properties... Ctrl+P

€2 Create List Ex

List Title Safety Documents
List Mame SafetyDocuments
Description Documents pertaining to the company sponsored safety program|
Type Document Library W

| Display on Quick Launch Create Versions

v*| Require Content Approval Create Minor Versi

oK | | Cancel

4. After completing the dialog, click [OK].

The new site collection now displays in Explorer View.
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Create SharePoint Folder

You can create a new SharePoint list via Content Matrix under an existing list or library (or within an
existing folder) as long as the connection type is not read-only. If folder creation is not valid for the
connection type, the option will be disabled.

To create a new SharePoint folder:

1. Navigate to the SharePoint Document Library, List, or Document Folder under which the new folder
should be created.

2. Right-click and choose Create Folder.
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3. Complete the Create Folder dialog.

Note that the Folder Type drop down allows you to select the content type with which to create

the folder. if only one content type exists on that list/library/folder, the option will be grayed out.
There is also a check-box option to overwrite any existing folder that uses the same folder name at

the level the folder is being added.

[ Create Folder

Folder Mame: | Safety Training Materials

W] Dverwrite existing folder

Folder Type: Folder (0x01200019AA894906

| | Cancel

4. After completing the dialog, click [OK].
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The new folder now displays in Explorer View.

Deleting a SharePoint Object

You can delete one or more SharePoint objects via Content Matrix as long as the connection type is
not read-only. SharePoint objects that can be deleted via Content Matrix are:

e SharePoint Sites

e SharePoint Lists

e SharePoint Document Folders
e SharePoint Documents

e SharePoint List Items

If the action is not valid for the connection type, it will be disabled.

NOTE: Document versions and list item versions cannot be deleted via Content Matrix.

To delete one or more SharePoint Objects:

WARNING: When this action is used at the site level or below, the object will be deleted permanently
(i.e., it will not be sent to the Recycle Bin). However, a pop-up dialog will display that allows you to
cancel the action.

1. Select the SharePoint object(s) to be deleted.

NOTE: Depending on the type of object, this may be in the Explorer View or in the Items View.
2. Either:

=  Press the Delete key on the keyboard.

= Right-click on the object and choose Delete [Object].
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—o

.7 Export List Metadata

m Site Pages (; L] Create Folder...
-.3 Style Library: _ -

m whpub #)  Delete List Del
ain https:/fmetalogh (> Refresh Node P
4=, https: ffmetalogi Search..
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You will be prompted to confirm the action before continuing.
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Viewing StoragePoint Details

Content Matrix can display the Quest® StoragePoint details for any document items that have been
offloaded to StoragePoint.

To view StoragePoint details:

1. InExplorer View, navigate to a SharePoint Document Library that contains items that have been
offloaded to StoragePoint.

2. Switch to the Items View tab.
3. Select an item, right-click and choose StoragePoint Details.

NOTE: The StoragePoint Details option will only be available in the menu if the selected items have
been offloaded into StoragePoint. If the selected item has not been offloaded to StoragePoint the
StoragePoint Details options will not be available. Only one item can be selected at a time.

Address: kites. File Share. Baseline/File Share Test MEWS./a/ Documents./a/d x|
Endpoint Relative Folder:  |fileshare data 201403052158

Filename: 3905afd4-2610-4b 34-bcbe-7a794d437a4a

The Storage Point Details dialog provides the below information:

= Address - The web address for the specified item within SharePoint.

= Endpoint Relative Folder - The folder that has been configured as endpoint for the offloaded
item (i.e. the location of the item in the offloaded storage space).

= Filename - The StoragePoint file name reference that is left behind in SharePoint after the item
has been offloaded.

4. When finished, click [Close].
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Initiating a Migration

From the Content Matrix Explorer View, you can "copy" an object from the source connection then
"paste" it to the appropriate location on the target connection. You will then be prompted to
configure Copy Options.

You can:

e Migrate a File Share Folder as a SharePoint site

e Migrate a File Share Folder as a document library

e Migrate File Share files as SharePoint documents

e Copy a SharePoint site or list as a File Share directory

Migrating a File Share Folder as a SharePoint Site

Use the Copy as Site action to migrate a File Share folder as a SharePoint site. Depending on the
migration options, any sub-folders will be migrated as SharePoint document libraries, or as sub-sites.

To initiate a "File Share folder as a SharePoint site" migration:

1. InExplorer View, select the source File Share folder to migrate.
2. Right-click and choose Copy Folder.

3. Select the target SharePoint site node under which you want the new SharePoint site to be
created.

4. Right-click and choose Paste Folder > As Site option.

Continue with Configuring Copying Options.

Migrating a File Share Folder as a SharePoint
Document Library

Use the Migrate as Document Library action to migrate a File Share folders as a SharePoint document
library or as a folder within an existing document library.

NOTE: Only File Share folders can be migrated as SharePoint document libraries. File Share files and
documents can only be migrated as documents into a SharePoint document library, unless otherwise
specified in the Configure Copy Options - Target Hierarchy Optionstab.
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To initiate a "File Share folder as a SharePoint document library"
migration:

1. InExplorer View, select the source File Share folder to migrate.

2. Right-click and choose Copy Folder.

3. Select the target SharePoint site/document library node under which to create the document
library/folder within the document library.

4. Depending on the target node you chose, right-click and choose either:
= Paste Folder > As Document Library (to create a document library)
= Paste Folder (to create a folder within the document library)

Continue with Configuring Copying Options.

Migrating File Share Files as SharePoint
Documents

Use the Migrate Files action to migrate File Share files as SharePoint documents in a new or existing
document library.

To initiate a "File Share Files to a new or existing SharePoint
document library" migration:

1. InExplorer View, select the source File Share folder whose files you want to migrate.
2. Switch to Items View.

3. Select the files for migration (these files can be multi-selected).

4. Right-click and choose Copy Files.

5. Select the target SharePoint site or existing document library into which you want to migrate the
files.

6. Right-click and choose Paste Files.

Continue with Configuring Copying Options.

Copying a SharePoint Site or Documents into a
File Share

Use the Copy as File Share Directory action to copy SharePoint sites, document libraries and
documents into a File Share. This allows you to move content back and forth between SharePoint and
the File Share environment.

You can:
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e copy SharePoint sites and document libraries into a File Share connection as a directory (folder)
while maintaining the existing sub-structure

OR

e copy SharePoint documents as documents under a selected File Share node.

To copy a SharePoint site or document library as a File Share
Directory

1. InExplorer View, select the SharePoint site or document library that you want to migrate.
2. Right-click and choose Copy Site or Copy List .

3. Select the target File Share directory.

4. Right-click and choose Paste Site > As Directory or Paste List > As Directory.

4

Continue with Configuring Copying Options.

To copy SharePoint documents into a File Share Directory:

1. InExplorer View, select the SharePoint document library that contains documents to be migrated.
2. Switchto Items View.

3. Select the documents to be copied.

4. Right-click and choose Copy Selected Documents.

5. Select the target File Share directory.

6. Right-click and choose Paste Documents.

Continue with Configuring Copying Options.
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Configuring Copying Options

The Paste [Object] dialog provides a tabbed interface that enables you to configure a migration
according to your specifications. Available tabs will vary based on the type of migration that you
initiated.

Folder Options

If you chose to Migrate Folders as SharePoint Sites or Document Libraries,complete the Folder
options tab as described below.

Folder Options | Migrate sub-folders
| Replace invalid characters in folder names with: =
I:I File Options If a folder with the same name already exists:

d ®) Do not copy the folder
Permission Options Overwrite the existing folde
Use the existing folder

Target Hierarchy Options Copy the folder with a unique folder name
Content type options:
I:' Filter Options ®) Use default content type (No folder metadata)
Use custom content type: | Folder {0x0120) e
@D o
E Logging Options w/| Lise Import Pipeline 0

®) SPO Provided Azure Containers
Azure Private Containers

To configure Folder Options:

1. If you want to Migrate sub-folders, make sure this box is checked.
NOTE: If you uncheck this box, only the folder from which you initiated the migration will be
copied.

2. For Replace invalid characters in file names with: select the character that you want to use as a

substitute for any characters disallowed by SharePoint.

3. Select the action that you want Content Matrix to take If a folder with the same name already
exists on the target. Use the information in the following table for guidance.
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If you to ...

prevent Content Matrix from copying a folder
from the source if a folder with the same
name already exists on the target (in the same
hierarchy structure)

allow Content Matrix to overwrite any existing
folders on that target, if they have the same
name as a folder that is being migrated

allow Content Matrix to migrate files and
other folders directly into a folder that already
exists on the target, if a folder with the same
name is being migrated from the source.

allow Content Matrix to migrate a folder from
the source, even if a folder with the same
name already exists on the target.

Select...

Do not copy the folder.

Overwrite the existing folder.

Use the existing folder.

Copy the folder with a unique filename.

NOTE: If you select this option, the folder
from the source will be created on the target
using a unique name (typically the original file
name with"_1" appended). For example, if a
folder named "Marketing Programs" is
migrated from the source, and a folder with
the same name exists on the target, then a
new folder will be created on the target called
"Marketing Programs_1", and the contents of
the folder will be migrated into this new folder.

4. Select the Content type options to use when setting the content type for any folders that are

migrated to SharePoint. Use the information in the following table for guidance.

If you want to ...

use the default SharePoint content type for
any migrated folders

specify the content type that should be
associated with folders when migrating
content.

Then ...

select Use default content type (No folder
metadata).

Select Use custom content type

AND

Either:

= select an available content type from the
drop-down

OR



If you want to ... Then ...

= click [Edit Field Mappings] and specify your

own target content type using the
procedure for Mapping Field Types.

5. If you want to migrate to a SharePoint Online target using the Import Pipeline, check the Use
Import Pipeline box and either:

o keep the default option - SPO Provided Azure Containers

OR

o select Azure Private Containers (if configured), and enter the Azure Storage Connection String

in the following format:

DefaultEndpointsProtocol=https;AccountName={your account name};AccountKey={your
account key}

SPO Provided Azure Containers
®) Azure Private Containers

Azure Storage Connection Siring:

JefaultEndPointsProtocol=https; AccountMame =SampleA ﬂ

..............................................

..............................................

NOTE: When using Azure Private Containers, you also have the option to Encrypt Azure jobs.

(When using SPO Provided Azure Containers, jobs are always encrypted.)

File Options

If you have chosen to migrate folders or files, complete the File Options tab as described below.

NOTE: The Migrate matches column option will only be enabled if a Quest Sensitive Content

Manager (SCM) report has been imported and the file system connection uses the same Source Path

that is specified in the .csv file.
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Folder Options w] Indude files
Iw*| Replace invalid characters in file names with: —

|:| File Options )

If a file with the same name already exists:
Permission Options ®) Do not copy the file
Update metadata on the existing file

Target Hierarchy Options

[E" Fiter ootons Copy the fie with 2 urique fAlename
Content type options:
C‘.? Link Correction ®) Use default content type
Use custom content type: [7]
B tossing optons [[Eatmadmespn: |

o/ Transformations

To configure File Options:

1. If you want documents within a folder to be migrated, make sure the Include Files box is checked
NOTE: This option cannot be unchecked if the migration was initiated for individual files.

2. For Replace invalid characters in file names with: select the character that you want to use as a
substitute for any characters disallowed by SharePoint.

3. If you imported an SCM report and want to migrate the Matches column, which contains the
search terms that were used to identify sensitive content, check the Migrate matches column box.

4. Select the action that you want Content Matrix to take If a file with the same name already exists
on the target. Use the information in the following table for guidance.

If youto ... Select ...

prevent Content Matrix from copying a file Do not copy the file.
from the source if a file with the same name
already exists on the target.

allow Content Matrix to copy and update the | Update the metadata on the existing file.
metadata for any files that are migrated from
the source, if a file with the same name
already exists on the target

NOTE: Any files that do not meet this criteria
will be migrated normally.

allow Content Matrix to overwrite a file on the | Overwrite the existing file if newer.
target if the file from the source has a more

NOTE: This behavior will only be used if the
recent Modified date

source and target fine names are the same.
Any other files will be migrated as normal.
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If youto ... Select ...

allow Content Matrix to migrate a folder from | Copy the file with a unique file name.
the source, even if a folder with the same
name already exists on the target

NOTE: The folder from the source will be
created on the target using a unique name
(typically the original file name with "_1"
appended). For example, if a folder named
"Marketing Programs" is migrated from the
source, and a folder with the same name exists
on the target, when this option is selected a
new folder will be created on the target called
"Marketing Programs_1" and the contents of
the folder will be migrated into this new folder.

4. Select the Content type options to use when setting the content type for any files that are
migrated to SharePoint. Use the information in the following table for guidance.

If you want to ... Then ...

use the default SharePoint content type for | select Use default content type
any migrated files

specify the content type that should be * Select Use custom content type
associated with folders when migrating AND
content.
e Either:
= select an available content type from the
drop-down
OR

= click [Edit Field Mappings] and specify your
own target content type using the
procedure for Mapping Field Types.

5. If you are migrating at the file (not folder) level want to migrate to a SharePoint Online target using
the Import Pipeline, check the Use Import Pipeline box and either:

o keep the default option - SPO Provided Azure Containers
OR

o select Azure Private Containers (if configured), and enter the Azure Storage Connection String
in the following format:
DefaultEndpointsProtocol=https;AccountName={your account name};AccountKey={your
account key}



SPO Provided Azure Containers

®) Azure Private Containers

Azure Storage Connection String:

JefaultEndPointsProtocol =https; AccountMame =Sample A ﬂ

NOTES:

e When using Azure Private Containers, you also have the option to Encrypt Azure jobs. (When
using SPO Provided Azure Containers, jobs are always encrypted.)

e Azure/SPO containers do not support migration to document sets. This option will be disabled
if a Migration to Document Set option is selected on the Target Hierarchy tab.

o If you are copying files as part of a folder migration, this option will instead appear in the
Folder Options tab of the configuration dialog. This option only appears in the File Options

tab for the Paste Files action.

Mapping Field Types

You can create field type mappings for files and folders that are being migrated from a File Share to
SharePoint when you click the [Edit Field Mappings] button from the Folder Options or File Options
dialog. Mappings are applied to a specific content type on the SharePoint target, which is determined

within the migration's configuration options.

NOTE: Mappings are saved as separate .MLM files, and the mappings are specific to the particular
mapping dialog (Field Types, Users, or Permissions.) they were saved from.

To configure field type mappings:

NOTE: Content Matrix supports one-to-one field type mappings between source and target.
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Specity your fiekd mappings for the target content fipe below:
Fiter: = 4 |- a - |-
bem temType  Fuid A
] Computed Stn #A
Seum E Mg
mafah Compubsd | Stm
[ Compued (e A
Modfylate Dt Time Lo Ste O
. . & d
CreateCiate Laat Updates Ciata Tie Ste Terget
FleSine Metn =
ko ¥ Dglet
3
Fiker Wi :
Source Soume Type  Tomget Tames Trpe
defuuit |
Edtar g Hodfied By User Lo
Hathor Srg Cremed By Liner il
Nane Sirg Tt Teut Cleat
0K Carcel

Content Matrix File Share Edition
76
Configuring Copying Options



1. From the File drop-down at the top of the Source Fields to Content Type Fields dialog, choose the
appropriate option. Use the information in the following table for guidance.

If you want to ... Then...

load mappings from a previously-saved e choose File > Load.

Metalogix Mapping setting (.MLM) file AND

e Navigate to and open the mapping file to
populate the Mappings dialog

create new mappings go to the next step.

2. Use the information in the following table to determine the appropriate action to take.
NOTE: You can Filter items in each window to narrow displayed lists.

If you want to ... Then...

manually map each individual source fieldto | ¢  From the left (File System) window, select the
a target SharePoint column Item that you want to map.

e From the right (SharePoint Column) window,
select an available Item (for the specified
Content Type).

e Click the Map icon.

have Content Matrix automatically map e From the left (File System) window, select the
source fields to target SharePoint columns Item(s) that you want to map.

e C(Click the Auto icon.

create a new column on the target for any e From the left (File System) window, select the
fields that are selected on the source side Item that you want to map.

e Click the Target icon to display the New
Mapping Target dialog.

e Select whether you want the mapping to be a
List Column or Site Column, enter a name
for the column, and choose a column type
from the Group drop-down

NOTE: These mappings will display in blue in the
right (SharePoint Column) window.

The mappings you create will display in the bottom window. (Note that you can also Unmap
individually-selected mappings in the bottom window or Clear all mappings from the bottom
window.

3. To save the mappings in the dialog as a Metalogix Mapping setting (.MLM) file, choose File > Save.



4. Click [OK] once all desired mappings have been made and return to the Configuration Options
dialog.

Permissions Options

With respect to SharePoint migrations, it is important to keep in mind that there are three different
aspects of permissions to be considered:

e Roles - These are also known as permission levels, and are a collection or rights that can be
assigned. In SharePoint it is possible to create custom permission levels (or custom roles).

e Securable Objects - These are basically permissions or rights that can be assigned to an object in
SharePoint. Only users or groups that have the same level of permissions or higher can access the
content holding these permissions.

e Principals - These are permission roles that are assigned to a user or group. In order for a user or
group to have access to a securable object, they would need to have the same permission rights or
higher as the permissions on the object. Users can also have access to secured object if they are a
part of a group that has access through its assigned permission level.

Content Matrix can migrate the Principals, but is currently unable to migrate SharePoint Roles or
Securable Objects.

In the migration process Content Matrix does not actually create any permissions, but instead it maps
the roles between the File Share source and the SharePoint target using its Permissions Mapping dialog.
Any permissions that are not included in permissions mapping will not be migrated to the SharePoint
target environment.

NOTE: If you want to use a custom role on the target you must add it to the target before migrating
permissions. However, this does not guarantee that it will be used. If another role on the target has a
closer match with the permission from the source, it will be used instead.
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To configure Permissions Options:

[ Paste Folder Settings E3
Folder Options v Migrate users using explidt user mappings Edit Users
«*| Migrate permissions using explict permission mappings e Edit Permissions
I:l File Options ®) Use explicit permission mappings regardless of overlap

Optimize permissions mappings to most condse permissions set

Permission Options
Migrate permissions auto-mappings @

Target Hierarchy Options

E Filter Options
C:? Link Correction

E Logging Options

v StoragePoint Options
[ ]

/’ Transformations

| Open Existing Job Configuration | | Save Job Configuration | | Run | | Save | | Cancel |

1. To enable all user and permissions migration options, including the ability to edit users and any user
mappings that have been configured, check the Migrate users using explicit user mappings box.

2. If you want to explicitly map source users to users in the target SharePoint object, click [Edit Users]
and follow the instructions for Mapping Users.

3. If youwant to explicitly map source file system permissions to target SharePoint permissions:
a) Check the Migrate permissions using explicit permission mapping box, and:
b) Select the applicable option. Use the information in the following table for guidance.

If you want to ... Select ...

use all Permissions mappings that you define,

; ) . Migrate permissions using explicit
regardless of if there is any overlap with

L ) permission mappings.
permissions that already exist om the target

have an "optimization algorithm" run against

Optimize permissions mappings to most
user roles on the source and target and apply

concise permissions set.

Content Matrix

79
Configuring Copying Options



If you want to ... Select ...

the least number of permissions necessary to
map all users from the source

c) Click [Edit Permissions] and follow the instructions for Mapping Permissions.

4. If you want Content Matrix to compare permissions on the source with the available permission
levels on the target and automatically map permissions that are not explicitly mapped, check the
Migrate permissions auto-mappings box. Permissions will be mapped as follows:

NTFS (source) permission SharePoint (target) permission
level
Full Control Full Control
Modify Contribute
Read Read
Write Contribute
List Folder Content Read
Read and Execute Read

Mapping Users

You can set user and group mappings for migrating content when you click the [Edit Users] button from
the Permissions Options tab. This allows you to preserve authorship metadata as well as help integrate
the File Share users with the SharePoint permissions model. In some cases, it is possible for users to be
automatically imported into the SharePoint environment, however, this is only possible if the File Share
source and the target SharePoint environment are working from the same Active Directory (AD). If this
is not the case, then users would need to be mapped into SharePoint user accounts on the target, and
these accounts must already exist in order for them to be mapped from the source.

NOTE: If the Author or Editor of any file to be migrated is Builtin\Administrators or Builtin\Users, you
must explicitly map the account to a user account in SharePoint for permissions to be applied on the
target. (There is no SharePoint equivalent to a Builtln account, so if it is not explicitly mapped it will
not be recognized as a valid user and permissions will not be applied.)

All user mappings are globally set, so once a mapping is created it will always be used unless removed.

NOTE: Mappings are saved as separate .MLM files, and the mappings are specific to the particular
mapping dialog (Field Types, Users, or Permissions.) they were saved from.




To map users:

NOTE: Content Matrix supports many-to-one (n:1) user mappings between source and target.

He -

Search <Erte Principsl bl Heres

Fdlen - C R SHITE Lhen
B

HETALOGDN
HETALOGI W
HETALOG X thortmarn

METALCK I jatah

bar Trpa [tz

HET ALOG D yparkoar

Lbvmr
Ly
Ly
Uy
L
b

Al

Sougie Thee Teg Tipe

Tage
defush
METALGN Adwnarator sy WETALIKERDEMATE 5Pl
METALDGI gl Lnar METALOGIK gl EPlisar

Filsze = 4l [T~ Seune hbpymopdill.ef -
[ [ . ~
METALOGH gharsicaas S A
ME TALDMGN grosskin o Map
NETALOGL hakacran hﬂ
METALNEI softardng e
|:m
Unap
A
Clear

1.

From the File drop-down at the top of the Active Directory Principal to SharePoint Principal

Mappings dialog, choose the appropriate option. Use the information in the following table for

guidance.

If you wantto ...

Then...

load mappings from a previously-saved
Metalogix Mapping setting (.MLM) file

e choose File > Load.
AND

e Navigate to and open the mapping file to
populate the Mappings dialog.

save the mappings in the dialog as a
Metalogix Mapping setting (.MLM) file.

choose File > Save.

set the current permission mappings in the
dialog as the default permission mapping
(regardless of the source/target connections
being used)

choose File > Use as Current Default.

NOTE: the mappings that display in the dialog
are saved to the local machine, so they are
persistent whenever the application restarts.

2. Use the information in the following table to determine the appropriate action to take.

NOTE: You can Filter items in each window to narrow displayed lists.

If you want to ...

Then...

manually map individual users or groups on

e From the source list, select the Item(s) that
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If you want to ... Then...

the source to a target SharePoint user or you want to map.

group .
e From the target list, select a target Item.

e Click the Map icon.

have Content Matrix automatically map e From the source list, select the ltem(s) that
source users/groups to target SharePoint yOu want to map.
users/groups

e C(Click the Auto icon.

NOTE: Content Matrix will only map users
automatically if the source and target side
names match, or if the emails match, and the
source and target environments are using the
same AD.

The mappings you create will display in the bottom window. (Note that you can also Unmap
individually-selected mappings in the bottom window or or Clear all mappings from the bottom
window.

3. Click [OK] once all desired mappings have been made and return to the Configuration Options
dialog.

Mapping Permissions

You can map File Share roles into SharePoint permissions when you click the [Edit Permissions] button
from the Permissions Options tab. Any Allow Rights or Deny Rights permissions on the source can be
mapped to SharePoint permissions on the target, provided the user or group with the permissions has
been mapped and exists in the SharePoint environment. Content Matrix does not create any
SharePoint permission levels, and can only map roles into existing permissions.

Role mapping (permissions mapping) is only available if user mapping is enabled.

NOTE: Mappings are saved as separate .MLM files, and the mappings are specific to the particular
mapping dialog (Field Types, Users, or Permissions.) they were saved from.

To map permissions:

NOTE: Content Matrix supports many-to-one permissions mappings between source and target.
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From the File drop-down at the top of the File System Rights to SharePoint Role Mappings dialog,
choose the appropriate option. Use the information in the following table for guidance.

If you wantto ...

Then ...

load mappings from a previously-saved
Metalogix Mapping setting (.MLM) file

e choose File > Load.
AND

e Navigate to and open the mapping file to
populate the Mappings dialog.

save the mappings in the dialog as a
Metalogix Mapping setting (.MLM) file.

choose File > Save.

set the current permission mappings in the
dialog as the default permission mapping
(regardless of the source/target connections
being used)

choose File > Use as Current Default.

NOTE: the mappings that display in the dialog
are saved to the local machine, so they are
persistent whenever the application restarts.

2. Map source roles to SharePoint permissions as follows:

e From the left (File System) window, select the Item(s) that you want to map.

e From the right (SharePoint) window, select an available Item).

e Click the Map icon.

NOTE: You can Filter items in each window to narrow displayed lists.
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The mappings you create will display in the bottom window. (Note that you can also Unmap
individually-selected mappings in the bottom window or Clear all mappings from the bottom
window.

Click [OK] once all desired mappings have been made.

Target Hierarchy Options

The Target Hierarchy Options tab lets you specify the hierarchical structure of migrated content on the
target SharePoint environment.

To configure Target Hierarchy - Subsite options:

1.

2.

Folder Options Sub-Site Document Library
Migrate to Sub-Site
|:| File Options Do not migrate files to sub-site
®) Migrate files to sub-site based on source directory structure
Permission Options Copy permissions (based on configuration in Permissions tab)
Set new site templates:
Target Hierarchy Options ® allas: | Blank Site (5TS=1) w
Filter Options

E

6‘.? Link Correction

E Legging Options
f Transformations

NOTE: This option is only available when migrating File Share content as a SharePoint site.

If you want to migrate source content into SharePoint sub-sites based on the source File Share's
folder structure, select Migrate files to sub-site based on Source directory structure.

NOTE: If you also want Content Matrix to use the configured permissions migration settings that
have been set in the Permissions Options tab, check the Copy permissions (based on
configuration in Permissions tab) box.

For Set new site template, select from the list of available SharePoint site templates from the
drop-down.

NOTE: If the target hierarchy is being configured as a separate action (that is, via the Paste
Hierarchy option), you will also have the option to enable the Use Import Pipeline option. For a
full migration, these options are available as either Folder Options or File Options.
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To configure Target Hierarchy - Document Library options:

[ paste Folder Settings

Folder Options Document Library

D File Options

Permission Options

Sub-Site
Migrate to Sub-Folders

Do not use a folder structure

®) Migrate files to sub-folder based on source directory structure

Truncate long path @

Target Hierarchy Options Max length before overflow 200

E Filter Options
69 Link Correction

E Logging Options
_/’ Transformations

€3 [e>

Overflow folder name length 5

Document Library
Set document library name from:
®) Custom Library Mame:

FileShare Documents

Source leaf directory name

Migrate to Document Set (@)
Do not migrate files to document set
®) Migrate to Document Set based on name in text:
Test Document Set

Flatten folder hierarchy and convert to Document Set

Open Existing Job Configuration | | Save Job Configuration

Copy permissions (based on configuration in Permissions tab)

Run | ‘ Save ‘ | Cancel

/2024 7:35:18PM  Done Sites Created: 24, Libraries C... Data Migrated: 1.2 MB

1.

3/1/2024 7:42:22 PM

00:07:03 AXCELERTEST\t... CP-SP18-A-5S

For Migrate to Sub-Folders, select how you want File Share content to be migrated into sub-

folders in a SharePoint document library. Use the information in the following table for guidance.

If you want to ...

migrate all files into the document library on
the target without creating any sub-folder
structure

migrates any sub-folders into a SharePoint
document library based on the existing folder
structure in the source File Share

Then ...

select Do not use folder structure

NOTE: When this option is selected, all files
will be migrated to the root of the library, even
if there is an additional folder structure on the
source.

select Migrate files to sub-folder based on
source directory structure.

If you also want to migrate permissions to this
new hierarchy structure based on options set in
the Permissions Options tab, check the Copy
permissions (based on configuration in
Permissions tab) box.
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If you want Content Matrix to truncate long folder paths or names to avoid migration errors when
the SharePoint character limitation (255) is exceeded:

a) Make sure the Truncate long path is checked.

b) If different than the default (200), enter a Max Length Before Overflow value, which
determines the folder path length that when reached, will trigger the overflow logic processing.
You may adjust this value, but make sure it does not exceed 255.

c) |If different than the default (5) enter an Overflow Folder Name Length value, which
determines the number of characters (from the first position) that will be used from each
source folder name to construct the folder name in the Overflow. You may adjust this value,
but make sure it does not exceed 255.

For Document Library - Set document library name from:, select which SharePoint document
libraries the source contents (files and folders) will be migrated into on the target SharePoint
instance. Use the information in the following table for guidance.

NOTE: These options are only available when migrating content as a SharePoint site or document
library.

If you want to ... Then ...

create a SharePoint document library * select Custom Library Name

with a specified name AND

e if different from the default (Documents) enter a
text you want to use for the library name.

create a SharePoint document library * select Source root directory name.

and name it based on the name of the NOTE: This option is only available when migrating

source root directory/folder content as a document library, or if pasting hierarchy
and is disabled if the Use Import Pipeline option is

(For example, if a source folder for the checked.

migration is named "Root1" and this
folder contains two sub folders ("Child1"
and "Child2"), then when this option is
selected, the top level migrated site
("Root1") will have a document library
called "Root1," and each sub-site will
have a document library named after
their source folders. In other words, the
site "Child1" will have a document
library called "Child1" and the site
"Child2" will have a document library
called "Child2.")

create a SharePoint document library select Source leaf directory name.

that uses the same name as the source



If you want to ... Then ...

folder containing the documents

4. For Migrate to Document Set, select how you want to migrate File System content into
SharePoint Document Sets. Use the information in the following table for guidance.

NOTES:

e When connected to SharePoint Online, if you have chosen to Use Import Pipeline, these
options are disabled because it is not supported. See Objects and Actions Supported Using the
Import Pipeline.

e Please see Microsoft's Document Sets planning page for more basic details on document sets.

If you want to ... Then ...
migrate content into SharePoint Document | e select Migrate to Document Set based on
Sets based on a specified name name in text:

AND

e enter the name you want to use for the

Document Set.

flatten the hierarchical structure of source | select Flatten folder hierarchy and convert
content and convert it to a Document Set | to Document Set.

Filter Options

Filters can be set and applied to all items within the scope of a migration.

NOTE: The Matches option will only be enabled if a Quest Sensitive Content Manager (SCM) report

has been imported and the file system connection uses the same Source Path that is specified in the
.csv file.


https://learn.microsoft.com/en-us/sharepoint/governance/document-set-planning

[ Paste Folder Settings

Folder Options

|:| File Options
Permission Options
Target Hierarchy Options
Filter Options
Logging Options

v StoragePoint Options

Transformations

File Metadata Filters

| File Name

| File Type
Created Before
Created After
Modified Before
Modified After
Last Accessed Before
Last Accessed After

File Size Min

File Size Max

Sontzk . I:l e.g. ".doox; .msi” ("docx; msi” for SharePoint files)
Mot Contains

Starts With

Not Starts With

Ends With

Not Ends With
Equals L4
6/13/2024 12:12 PM

6/13/2024 12:12FM

6/13/2024 12:12PM

Clear Al

To configure Filter Options:

Check the applicable filter options and enter or select the criteria to apply.

For File Name, File Type, and Matches, you can enter multiple non-case-sensitive search strings,
separated by a semicolon (with or without a space between values). For example

o |f you want to exclude application and installer files, for File Type you can add the filter "Not
Contains exe;msi".

V| File Type Mot Contains v| |exe:msi .
Created Before Contains A
Mot Contains
Created After Starts With
. Mot Starts With
Modified Before Ends With
Modified After Mot Ends With
Equals W

¢ If you want to migrate only the files referenced in the SCM report that contain an address and/or
email in the Matches column, For Matches add the "Contains address;email".

v'| Matches

Contains v | |address;email 9
Contains ~

Mot Contains

Starts With

Mot Starts With

Ends With

Mot Ends With

Equals v
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Content Matrix evaluates each string individually. For an "inclusion" criterion (Contains, Starts With,
Ends With, or Equals), only files that meet the specified criterion will be migrated. For an "exclusion"
criterion (Not Contains, Not Starts With, Not Ends With, or Not Equal), any files that do not meet the
criterion will be skipped.

For Matches, there are two additional criteria, Null and Not Null, which allow you to specify which files
you want to migrate based on whether or not the files have been found to contain any sensitive
content matches.

Link Correction Option

If you want to use Link Correction to create a create a column in the target SharePoint document
library containing the source path of the document, make sure the Migrate Source Path (for link
correction) box is checked.

NOTE: Content Matrix does not correct any links within documents.

[ Paste Folder Settings E3

Folder Options Link Correction

I:I File Options

Permission Options

[w] Migrate Source Path (for link correction)

Target Hierarchy Options

E Filter Options
C:? Link Carrection

E Logging Options

v StoragePoint Options
[ ]

7 Transformations
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Logging Options

Logging Options let you specify the level of detail to include in the migration logs.

[ paste Folder Settings E3

Folder Options w*| Enable verbose logging {may be memory intesive on larger copies)
El File Options

Permission Options

Target Hierarchy Options

I:1 Filter Options
C.'? Link Correction

E Logging Options

v StoragePoint Options
[ ]

f Transformations

To configure Logging Options:

If you want more detailed logging for the migration action, make sure the Enable verbose logging
(may be memory intensive on larger copies) box is checked.

StoragePoint Options

Content Matrix - File Share Edition has the ability to migrate documents directly into Quest®
StoragePoint, while leaving the endpoint reference in the appropriate SharePoint location. These
options are available through the StoragePoint options tab.

G

=/ These options are only available when Advanced Mode is enabled.

When you navigate to the StoragePoint Options tab, a check will be automatically run on the target
SharePoint environment to see if StoragePoint is installed. If StoragePoint is installed, all of the options
within the options tab will be enabled. If StoragePoint is not installed on the target SharePoint
environment, all of the options will be disabled. The StoragePoint detection status will be displayed

next to the StoragePoint found on target: line at the top of the tab window, and the value will either be
Yes or No.

NOTE: The StoragePoint options will only affect documents and attachments that are being migrated
into SharePoint on premises deployments. Other content such as Pages (for publishing sites), will not
be affected.
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To configure StoragePoint options:

1. If an endpoint profile is configured and you want any documents and attachments to be migrated
to SharePoint, check the Add documents directly to StoragePoint if an endpoint is configured
box.

NOTE: When you check this box, documents and attachments will be added directly through the
StoragePoint APl and the end reference will be added in SharePoint. This helps improve migration
efficiency and can potentially help performance speeds when migrating a large number of
documents and/or attachments.

2. If youwant the source File Share location to be converted into a Storage Endpoint location on the
target instead of actually copying the files, check the Link Files to SharePoint by configuring the
source directory as a StoragePoint endpoint.

NOTE: When you check this box, the appropriate endpoint location link will be added to the
SharePoint environment. This option's standard use case is for target SharePoint environments
that have StoragePoint installed, but no endpoint has been configured.

If both StoragePoint options are selected at the same time, the Link Files to SharePoint by configuring
the source directory as a StoragePoint endpoint option will take priority, and overwrite the first
option. This means that the source File Share will be configured as an endpoint for StoragePoint, even
if another endpoint is already configured. If there is a conflict between configured endpoints, the
documents that experience the conflict will not be migrated.

Transformations Options

If Advanced Mode and Custom Transformers options have been enabled, you can view, create, and edit
Transformers which, as the name implies, "transform" content during migration.

There are several built-in, non-editable transformers that Content Matrix uses to process data during
the migration. Advanced users can also create custom transformers using PowerShell.
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[ Paste Folder Settings =]

Folder Options Available Definitions Applied Transformers For Documents
Documents

Folders
D File Options Lists

Sites

= Add Transformer = 2]

Permission Options
Target Hierarchy Options

|:‘ Filter Options
C‘.? Link Correction

E Logging Options

i [ StoragePoint Options
[ ]

/. Transformations

The Transformations tab consists of two main sections: Available Definitions and Applied
Transformers For <Object>. The Available Definitions section will list all of the transformation
definitions that are available for the current migration action, in alphabetical order. For example, the
Site definition is available when migrating at the site level or higher. However, if migrating as a
document library or migrating documents, this definition will not be listed.

When one of the Available Definitions items is selected, any transformations that exist/have been
configured within the migrating content will appear. Some of the actions that may be grayed out.
These grayed out items are mandatory transformations that are run during the course of a normal
migration, and these actions cannot be edited or removed. However, they can be reordered by using
the up and down arrows to the right-hand side of the window if you want a transformation action to
occur before a mandatory action. Actions that appear and are not grayed are user added
transformations, and can be moved, edited and deleted at the users discretion.

In some cases, you could add another instance of an existing transformer, and then have it run in two
different locations within the migration process. One could be run in the middle, and it could be run
again just before the end.

Using PowerShell to Create Custom Transformations

When you select the Add Transformer > Invoke PowerShell script option for an Available Definition,
you can use custom PowerShell scripts to create your own transformations beyond the built-in
capabilities of the Content Matrix.

Specify when you want the script to run by selecting one of the following options:
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Begin Transformation — The transformation script will run before the migration of the affected

objects, allowing you to read and make changes to objects on the source before objects themselves

migrate.

Transform — The transformation script will run while the migration of the affected object(s) is in
progress. For example, the user mapping between source and target would be run using the Transform

option.

End Transformation — The transformation script will run after the migration of affected object(s),

allowing you to read and make changes to objects on the target.

EXAMPLE: The following Transformer consists of two scripts for disabling and re-enabling the

Required setting for a column list.

e The first script entered into the Begin Transformation tab sets the setting of any columns that are

Required to false before copying begins.

& Configure PowerShel Transformer

E" Begin Transformations MNone
Use Script From File
E’* Transform

@ Use Configured Script

3\. End Transformations

Stargets.ParentSPList. Fields
ol

sfieldLizt = Mew-Object "System. Collections. Generic. List[object] ™ ~

Sval = 5_,Field¥ml, Attributes, GethamedItem"Required”)

if(Sval -ne snull)
s

L
genforce = [System.Convert]::ToBoolean(Sval. Value)

if(senforce)
I
L

#We add the outer xml to the list so it doesn't
#remain tied to the reference when we update it.

sfieldList. Add($_.FieldXml)

e The second script, entered into the End Transformations tab, sets the setting back to true after

item migration has completed.

oK | | Cancel |
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& Configure PowerShel Transformer “

i’ Begin Transformations

F: Transform

} End Transformations

) None

() Use Script From File
(@) Use Configured Script
sfieldList |

Yot

Sval = 5_, Attributes. GetMamedItem{™Required”)
Sval.Value = "TRUE™
Stargets.ParentSPList.Fields. AddField($_. OuterXmi)

Ok | | Cancel

Content Matrix File Share Edition

Configuring Copying Options

94



12

Saving or Running a Migration Job

When you finish configuring a migration action, you can run it immediately or save a copy of the
settings to a job file, which displays in the Job List section. You can then:

e run a migration directly from the Job List section

OR

e create a PowerShell script and schedule it to run as a Windows Scheduled Task

OR

e triggerjobs in the Content Matrix Console to run using PowerShell.

You can also save the job configuration as a template so that you can preserve and reuse settings for

future migration jobs.

When the migration starts, a status dialog box will appear. The job logs can be viewed (in progress or
after the migration is finished) by clicking [Details>>]. The Status section of the status box will list a live
count for the number of successes, warnings, failures, etc. for the migration. The Progress section of
this dialog will list any completions and the type of completion (Sites, lists, items, users, groups, etc.). A
Migration Completed message will appear when finished. Click Close to exit the status dialog.

Saving a Job Configuration as a Template

You can create job configuration templates for a set of selected settings which can be saved and
reused, including any options that are not normally preserved using the Preserve Configuration
Options option (in the ribbon Settings menu).

These templates can also be moved to another machine and used with a separate install of Content
Matrix Console (provided that it is the same Edition of Content Matrix, and the same version number or
greater).

To save a job configuration template:

1. Afterinitiating a migration, complete the Configure (Object) Copying Options with the settings that
you want to include in the template.
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Save Job Configuration [ x|

Enter a name for the configuration

2. Click [Save Job Configuration].

Here you can set the display name for the job template. This is not the actual file name, but it is
the name that Content Matrix will use to list the template.

NOTE: In most cases, when a job template is saved by Content Matrix it will be saved to the
following location:
C::\Users\<User>\AppData\Roaming\Metalogix\Content Matrix Console - <Product> Edition

However, it is highly recommended that you do not interact with this system location. If you are
trying to save a job template so it can be exported to another system the template can be exported
from the Manage Job Configurations dialog.

3. Enter the desired display name value and click [OK] to continue.

Once the save is complete, you will be returned to the Configure <Object> Copying Options dialog
where the migration can either be Run or Saved.

The saved job templates will now be visible in the Manage Job Configurations dialog.

NOTE: If you are looking to save a job template and move it to another system for use, this should be
done using the Export option in the Manage Job Configurations window. Additionally, if you are trying
to Import a job template from another system, this must also be done from either the Manage Job
Configurations dialog or it can be imported when applying a template.

Applying a Job Template

Any job templates that have been imported or saved, and are available in the Manage Job
Configurations dialog can be applied to another migration of the same type. For example, if migrating
at the site level, you would not be able to use a job template that is created for a migration at the list
level. It would only be able to use a template that migrates at the site level.

The source and target connection types do not apply directly to a job template, so it does not matter if
the connection types for the new migration are the same as the connection types for the job template.
If the connection types are different than any options that are not applicable for the connection types
that are being used will not be available, but all other options will be set.

1. Afterinitiating a migration, click [Open Existing Job Configuration] in the bottom left corner of the
Configure <Object> Copying Options dialog to display the Select Job Configuration to Apply
dialog.
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NOTE: Any options you have specified directly in the dialog will be overwritten once a job template
is applied.

Select Job Configuration To Apply E3

Config_Template_Test_01

Job Template

oK Cancel

The dialog lists all of the job templates that are currently available for the migration type (i.e. a
site, list, item, etc. migration), as well as only the templates for the specific Edition of Content
Matrix that is being used.

Select the desired job template and click [OK].

You will be prompted to confirm your action before continuing. Remember that if you choose to
apply the template, any other settings that you entered directly in the Configure <Object> Copying
Options will be lost.

The Configure <Object> Copying Options dialog will now reflect all of the template options. Any
additional configuration options can be set or modified, and the migration can continue as normal.

Managing Job Templates

Content Matrix Console job templates can be managed in the Manage Job Configurations dialog. This
dialog allows users to Import, Export, Delete, or Filter any job templates. Below is a breakdown of the
available options in the Manage Job Configurations dialog.

Import - This button allows users to Import a job template. The imported job template must be
from the same Edition of Content Matrix Console. For example, if users are importing a template
into SharePoint Edition then the template must have been exported from SharePoint Edition.

Export - This button allows users to Export a job template. The export will create an XML file in a
desired folder location so the file can be copied and placed into another location as needed.

Delete - This button will delete any selected job templates from Content Matrix Console. When
deleting a template, a confirmation dialog will open and must be confirmed before the templates
are deleted. Deleting will permanently delete the selected templates from Content Matrix
Console.
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e Filter - This is a text box that allow users to enter a value that Content Matrix will filter the job
templates against. The filter will only display items that contain the specified value. There is a Filter
icon to the right-hand side of the filter text box. Clicking this icon will apply the filter text value to
all of the job templates listed in the Manage Job Configurations dialog, so only the templates that
contain/include the matching filter value will be shown. Filtering can be cleared by removing the
text value from the filter text box and clicking the filter icon button.

Exporting a Job Template

To export a job template:

1. In Content Matrix's ribbon toolbar, switch to the Settings tab and click [Manage Job
Configurations] button to display the Manage Job Configurations dialog.

Manage Job Configurations E3
(=) mport [& Export | () Delete Filter: A

4 Paste Site as Subsite

Config_Template_Test_01
Job Template

Close

2. Select the template you want to export then click the Export button at the top of the Manage Job
Configurations dialog, .

3. Navigate to the desired folder location where you want to save the job template, enter a File
name, and click [Save].

4. The job template XML file will be saved to the selected folder location, and Content Matrix will
return to the Manage Job Configurations dialog. Any additional importing, exporting, or deleting of
job templates can be done. Click Close to return to the main Content Matrix window.

Now that the job templates have been exported and saved to a folder location they can be manually
moved to another location as required.
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Importing a Job Template

Only templates that have been created from the same Edition of Content Matrix Console can be
imported. For example, a job template from SharePoint Edition cannot be used in Public Folder Edition,
it can only be imported into SharePoint Edition.

To import a job template:

1. In Content Matrix's ribbon toolbar, switch to the Settings tab and click [Manage Job
Configurations] button to display the Manage Job Configurations dialog.

Manage Job Configurations E3
(=) mport [& Export | () Delete Filter: A

4 Paste Site as Subsite

Config_Template_Test_01
Job Template

Close

2. Click the Import button at the top of the Manage Job Configurations dialog, navigate to the folder
location for the template XML file, then click [Open].

The job template will be added to the list of templates in the Manage Job Configurations dialog.
The template will be listed using the same Display name that was used when the task was created
on the original system and will not have its file name displayed.

The job template is now imported and can be applied to any migration.

Importing and Exporting Migration Jobs

From the Job List, you can export a job to an xml file. This functionality allows you to:

e Copy a job from one instance of Content Matrix to another (as long they are for the same Edition).

e Manually modify a job, then re-import it.
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To export a job to an xml file:

1. Inthe Job List, select the job(s) you want to export.

NOTE: If you select multiple jobs, they will be saved to a single xml file.

2. Right-click, and choose Export selected job to xml.

The xml file will automatically open in whatever program is set as the default application for xml
files, and it can be saved to any desired location.

To import an xml file to the Job List:

1. Make sure the file you want to import uses a different Job ID than any existing jobs (this should
only be an issue if the xml file was previously exported from the same Content Matrix Console).

NOTE: If you import an xml file via the Console and the file being imported contains the same Job
ID as an existing Job, then the import will fail. However, you can create a duplicate job with a
different Job ID if you import the xml file using PowerShell.

2. From the Job List menu, choose File > Import Jobs From Xml.

3. Select the xml file to import.

If the import is successful, the job will be listed in the Job List section. If unsuccessful, an error
message will be displayed.

Refreshing the Jobs List

‘ NOTE: The refresh is applied to whichever job list Content Matrix is currently connected to.

To refresh the Job List:

1. From the Manage Queue dialog, select a job in the Job List. The row selector icon and the
highlighted row indicates the selected row.

2. From the Job List menu bar, choose File > Refresh.

If the status of the job has changed, the Status value will indicate the new status of the job.

Creating and Running a PowerShell Script from
the Jobs List

In order to create a PowerShell (PS) script for Content Matrix, a job list (or batch file) must first exist in
the Job List section of the Content Matrix Console. Once created, it can be run from the PowerShell
console or scheduled to run as a Windows Scheduled task.

NOTES:

e Itis recommended that the connections to the source and target environments have the
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Remember my password check-box selected. This is to ensure that the PowerShell scripts will be
able to establish a connection to both the source and target environments when they are being run.
If a password is required and this check-box is not set, the migration will fail. However, users can
manually enter this value into the PowerShell script itself if the option was not checked when the
script was first generated.

e \Web Browser Authentication, 0365 Web Browser Authentication, and Forms-based Authentication
are not supported for running a job using a PowerShell script.

Refer to the Quest Support Knowledge Base article Connections that will work with PowerShell and
Connections that doesn't work with PowerShell for complete details.

To create a PowerShell script:
1. InJob List, and select the job (or jobs) that you want to run in PowerShell.

2. Click the Generate PowerShell Script button in the Job List tool bar, or right-click on one of the
items and select Generate PowerShell Script from the context menu.

3. From the drop-down, choose the appropriate option. Use the information in the following table for
guidance.

1t Matrix Console - SharePoint Edtion)JobHistory. lst

wport Excel ] iew Log Change Configuration [« Generate PowerShall Script = (=) Mav
tarted Status Log 5i l For Current User and Mathine
1?”” e e For Current Machine

18/2021 2:54:13 AM  Dane Comple For Certificate

If you want to generate a PowerShell script Choose ...
for scheduling ...

that can be used only by the currently logged | For Current User and Machine.

in User Account on the machine it is .
NOTE: Any PowerShell scripts that are generated

for scheduling through this option can only be run
by the logged in user on the machine they were

generated on

generated on.

that can be used by any User account on the | For Local Machine.
machine it is generated on

that can be used by any User account on any | For Certificate.

machine that has the certificate that is When you save the PowerShell script using this

specified when the script is created method you will be prompted to select a security
certificate that exist on that machine. The
selected certificate will be required on any system
that attempts to run the script at a later date.
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Available Certificates
Please select the certificate you would like to use

seanm@metalogix.com

Issuer:

Valid From: 2014-03-10 to 2014-03-10

Click here to view certificate
properties

Once the PS script generation type is selected, Content Matrix Console will generate a PS script for
the select Job, which will be written to a Microsoft Notepad file. If multiple jobs are selected they
will all be written to the same file.

4. Choose File > Save As... and select any desired save location for the PowerShell script. Give the file
any name you want, but change the file type to .PS1.

Fila Efit  Formal  View

Halp
if [ (Get-PSSmaplin -Name Metalogix.Systes.Commands -Errordction SilemtlyContinue) -eq $null ) { add-pssnapin b
Metalogls, System, Commands | out-mull } 1

if [ (Get-PSSnapin -Mame Metalogix.SharePoint.Migration.Commands -ErcorAction Silemtlylontinue) -eq $null ) {
add-pesnapin Metalogix. SharePoint Migration, Conmands | out-rall }

# Load configuration settings
Load-MetalogixlonfigurationVariableSattings -FilePath “C:\Programlata\Metalogix\EnvironmentSettings . ml” -Scope
Ervirormentipecific

Load-MetalogistonfigurationVariableSettings -FilePath “(:\Users)seann’\fpoData’\RoaningiMetalogisx’ Content Matrix 2
Consple = SharePoint Editiom\ApplicatiomSettings.sml” -Scope ApplicationfndUserSpecific
Load-MetalogiefonfigurationVariableSettings -FilePath “C:\Usersiseanm'AppData'\Reaning \Metaloglin\UserSettings ., wml”
-Scope UserSpecific

# Load source

$Sourcefollection = New-MetalogixSerlalizablefbjectCollection "<INMLABleList

IxMLAbleTyper" "Metalogix. Explorer.Nodefollection; Metalogix.Explorer, Version=7.8.8.1, Culture=neutral,
PublicKeyTokansb2d@f ac ko Y@l “rchlodeCollectionsdlocation Path="" /http: XIFKIFeoss 1007 -asXiF /AndreuTast Dema™
Displaylel=""Mitp: [ /moss 2087 -e5 fAndrewTest /Tend” "rcConnection NodeType=""Hetalogix.SharePolnt, SPherver,
Metalogix.SharePoint; Version=7.8.8.1, Culture=neutral, PublicKeyToken=3b248faciedSfcBl™ " ShowdllSites=""Troe "
AdapterTypas" 5P " Urls" “kttp:f/moss2007-05" " Readdnly="“False" =
fgthentlcationType=""Metaloglx. Sharefolnt. dapters, Authenticatlon. WindowsInitlalizer

Jxiflocationy< /Nodelollections:< /INMLADL el fats”

# Load target

$Targetfollection = New-MetalogixSerializableDbjectCollection "<IXMLAbleList

IXMLADLaType=" "Metalogix. Explorer . Nodelol lection, Metalogix.Explorer, Versions7.8.8.1, Culturesneutral,
PublickeyToken=JIb248fac ke 38 cdd" “rchodeCollectionsclocation Path=""/Testinghrea’ = Displaylirl=""http://spsldia-
smTestingfrea” “><Connection NodeType=""Metalogls.SharePolint.5PHeb, Metalogix,SharePolnt, Version=7.0.8.1, 4
Culture=neutral , PublicKeyToken=3b248facieddfcdd” ™ ShowillSites=" "True " AdapterType=""SP"" Urle" “http:/fsps2618-
sm" " Beadlnly=""False" " AuthenticationType=""Metalogix,SharePolnt.Adapters, Authentication. HindowsIndtializer =
freflocations< Medefollectiony</IMLADLeL 151"

# Run the action

foresch{$Target In $TargetCollection) {

$sourceCollection | Copy-MLSharePointSite -Target $Target -CopyPermissionlevels -CopySitePermissions - 5
CopyAccessRequestiettings -Copylssociatediroups -CopySiteWebParts -Lopylists -CherwriteSites -
RecursivelyCopySubsites -CopyContentTypes -CopyNavigation -CopySitefeatures -RunNawigationStructurelopy -

The PowerShell (PS) script itself contains five sections. They are:
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e Section 1 - This first section at the top (starting with an "if" statement) runs a check in the PowerShell
console to make sure that the Metalogix snap-ins have been added. If they are not found then it will
add them to that instance of the PS console.

e Section 2 - Load Configuration settings - This section will find and load all of the Content Matrix
client application configuration settings into the PowerShell script. These are the client application's
environmental settings and not the migration/action settings.

e Section 3 - Load source - This section will load all of the data for the source environment
connection.

e Section 4 - Load target - Similar to the previous section, this will load target environment's
connection information.

e Section 5 - Run the action - Last is the "Run the action" section. This last section will contain all of
the other data for the migration, such as the type of migration (i.e. a site migration, list migration,
item migration, etc.) and all of the settings and configurations for the migration/action that is being
run. This includes things like settings for versions, content types, permissions, etc.

Now you can run or schedule the PowerShell script.

Running a PowerShell Script

Once a PowerShell script has been created, you can run it from the PowerShell console.

To run the PowerShell script:
NOTES:

e If you have more than one edition of Content Matrix, only one edition can be run per PowerShell
session.

o |f Content Matrix settings is changed, in order to apply new settings all PowerShell sessions must be
restarted.

To add the PowerShell cmdlets for the application framework:
1. Open a Powershell ISE or PowerShell console session.
2. Run the Add-PSSnapin command and by pasting in the following text:

if ( $PsVersionTable.PSVersion.Major -1t 3 ) { Write-Host "Windows
PowerShell Version 3.0 or later needs to be installed in order to run

Content Matrix PowerShell scripts."; exit; }if ( (Get-PSSnapin -Name
Metalogix.System.Commands -ErrorAction SilentlyContinue) -eq $null )

{ add-pssnapin Metalogix.System.Commands | out-null }if ( (Get-PSSnapin -
Name Metalogix.File.Commands -ErrorAction SilentlyContinue) -eq $null )

{ add-pssnapin Metalogix.File.Commands | out-null }if (Get-Command Set-
MetalogixJobPrerequisites -ErrorAction SilentlyContinue){ Set-
MetalogixJobPrerequisites -Value "Content Matrix Console - File Share
Edition" }
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2. Set the directory to the location where the PowerShell script is located.

3. Enter the name and extension of the PowerShell Script (at its specified location), and the script will
run.

In the case that you are running a script from the same directory you would use the format: .
\[ScriptName].ps1. So if your PowerShell scrip was named "ResourceScript.ps1" then you would
enter: .\ResourceScript.ps1 into the window, and the script would run.

If the script is in a different directory, you would enter the location of that directory relative to
your current location, followed by the script name. For example, if your prompt is at the "C:\" drive
and your PowerShell script, named "ResourceScript.ps1" is on the desktop you would enter: C:
\Users\[User]\Desktop\ResourceScript.ps1, and the script would run.

NOTE: In some cases the Execution Policy may prevent you from running a PowerShell script. In this
case you will likely see the message: [Script].ps1 cannot be loaded because the execution of scripts is
disabled on this system. Please see "get-help about_signing" for more details. In this case, running the
command: set-executionpolicy RemoteSigned should change the existing script policy to allow you to
run these scripts for your location. It is advised that you check with your System Administrators
before doing this to ensure that no Company Policies are being broken by this action. If this is an
action you need to take, you should only need to run this command once.

The migration will begin, and any warnings and/or errors that are encountered in running the script will
be displayed in the PowerShell window.

Scheduling a PowerShell Script to Run as a Windows
Scheduled Task

Once a PowerShell script has been created, you can run any migration job as a scheduled task on the
system that the client application is installed on. This can be any migration action that exists in the Job
List section, whether it's a migration job that was saved or a job that was previously run.

The Generate PowerShell Script option saves configurations for the selected job(s) as a PowerShell
script. After the script has been saved, you must create a Windows Scheduled task directly in the
Windows Task Scheduler.

Once these jobs have been created as scheduled tasks they can no longer be viewed (as scheduled
tasks) in Content Matrix. If you want to make any other modifications or remove the task you can do
so directly in the Windows Task Scheduler. If a task has been scheduled, the system will be able to run
the task at the appointed time(s), regardless of whether Content Matrix client application is open.

To schedule a PowerShell script to run via the Windows Task
Scheduler:

1. Onthe system where the scheduled task will run, open the Windows Task Scheduler.
2. Choose Actions > Create Task.

3. Enter a task Name and Description.
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4. Inthe General tab, go to Security options and specify the user account that the task should be run
under. Change the settings so the task will run regardless of whether the user is logged in.

5. Select the Triggers tab, and click [New] to add a new trigger for the scheduled task. This new task
should use the On a schedule option. The start date can be set to a desired time, and the
frequency and duration of the task can be set based on your specific needs. Click [OK] when your
desired settings are entered.

6. Select the Actions tab and click [New] to set the action for this task to run. Set the Action to Start a
program.

7. Inthe Program/script box enter "PowerShell."

8. Inthe Add arguments (optional) box enter the value ".\[Your PowerShell Script Name]." For
example, if your PowerShell Script is named "Migrationl.ps1" then you would enter ".
\Migration1.ps1" as the value.

9. Inthe Startin (optional) box, add the location of the folder that contains your PowerShell script.

NOTE: The location used in the Start in box will also be used for storing the scheduled task run
times, the job history for the copies, and any additional logging that may occur.

10. When all the desired settings are made, click [OK].
11. Set any other desired settings in the Conditions and Settings tabs.
12. Once all the desired actions have been made (or added), click [OK].

The task will be immediately set, and is ready to run.

After the scheduled task has run, a new entry will be added to Content Matrix's Job List section.

Triggering a Job in the Content Matrix Console
to Run Using PowerShell

As an alternative to generating a PowerShell script, you can use PowerShell to trigger jobs that have
been created in the Content Matrix Console.

To access the PowerShell cmdlets for triggering jobs to run:

Open a PowerShell or PowerShell ISE session and add the PowerShell snap-ins for the application
framework.

The following cmdlets for running jobs are now available:
e Get-MLJobs

e |[nvoke-MLJob

To retrieve information about jobs in the Console:

1. Select (from the PowerShell ISE Command Window) or enter Get-MLJobs.
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2. (Optional) Enter one or more of the following parameters if you want to filter jobs:
¢ JobNameOrTitle
¢ JobStatus
e Source
e Target
NOTE: If you do not apply filters, all jobs in the Console will be retrieved.
3. Runthe cmdlet.

Example scripts:

Get-MLJobs

To run one or more jobs:
1. Select (from the PowerShell ISE Command Window) or enter Invoke-MLJob.

2. Select or enter additional parameters. Use the information in the following table for guidance.

Parameter Notes

JobID e You can obtain the Jobld by running the Get-MLJobs cmdlet.

e You can run multiple jobs using the PowerShell Pipeline variable.

JobStatus Valid statuses are:
e Running e Warning
e Not Running e Failed
e Paused e Queued
e Aborted e Triggered
e Aborting e Cancelling
e Done e Cancelled
Quiet Use this parameter if you do not want to display a status of the job as it
is running.
RunRemotely Use this parameter if you want to submit the job for Distributed
Migration.

NOTE: This option is valid for SharePoint Edition only.

3. Runthe cmdlet.



Example Scripts

Invoke-MLJob -JobId '92416012-4b69-4d4e-b3c2-984cde279909"

Invoke-MLJob -JobStatus Failed

Run multiple jobs using the PowerShell pipeline variable:

Invoke-MLJob -JobID 'c8176ddl-f1fd-484c-bc66-c002£f5406£05' —-RunRemotely
'5ca0d97f-4d1d-445f-a6d9-3292abe89%a6f', '0a2e0874-a759-46£4-b459-
bb98ec2991ad' | Invoke-MLJob '30bf6d71-0a28-4012-b612-2d22562b5b46",
'0b094765-46e0-4919-8922-cc5fe841elf5' | Invoke-MLJob -Quiet
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13

Job Log Files

You can view the progress of a migration tab in real-time via interactive log files. The logs are fully
searchable.

To view an interactive log:

After starting an action, click Details>> in the progress dialog box.

NOTE: All logging in Content Matrix is done through jobs. If a job list is deleted from the Job List, all
logging for those actions will also be deleted. There is no backup for the job lists, unless the job is
manually saved to another location. Once a job list is deleted, all logging for the actions within that
job list are gone. Content Matrix will automatically hold any job lists created through any copy
actions, in the Job Lists section, and these job lists can only be deleted through the appropriate Delete
commands. The job lists can also be manually selected and saved through the Job list section.

There are two types of jobs in Content Matrix:

Ajob list is a collection of job items. AJob list is created for each copy or compare action that is made.
Any "Copy" action/job that is in the Job List section can be used as the base of an incremental copy job.
Job items can be viewed in the Log Viewer, by opening a job list. There are three basic ways to open a
job list to access the Log Viewer:

e Double-click on a job list.
e Select ajob list, then in the Job List section of the toolbar click View Log.

e Select a job, right-click, and choose View log.

Job items are job files, or logging, for individual items within the scope of an action. For example, if a
File Share folder is copied as a SharePoint site, there would be a job item for adding each SharePoint
list and each item in that list, and one job item for adding or creating each site or sub-site. If a File
Share folder with 5 documents is copied, then there would be a job item for adding/creating the list,
and then one job item for adding each of the documents.
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Log Viewe -
Show Leg ltems =
Time Operation Item Source

q" 5/18/2017 1:38:24 FPM Loading source an... Paste Site a5 Su... http:/fga2013farm4:38876. ..
V" 5/18/2017 1:38:33 FM Copying Site SubTwol http:/fqa2013farm4: 38876, ..
./ 5/18/2017 1:39: 13 PM Copying Site Colu... SubTwoA http:/fga2013farm4:38876. ..
J 5/18/2017 1:40:15PM Adding List Shared Documents  htip:/fga2013farm+:38876. ..
9" 5/18/2017 1:41:06 PM Copying Column D... Shared Documents  http:/fga2013farm4:38876. ..
V" 5/18/2017 1:41:09 PM Adding List SiteAssets http:/fqa2013farm4: 38876, ..
‘/ 5/18/2017 1:41:59 PM Copying Column D... SiteAssets http:/fga2013farm4:38876. ..
J 5/18/2017 1:42:02 PM Adding List SitePages http:/fga2013farm4: 38876. ..
9" 5/18/2017 1:42:59 PM Setting Content T... ContentTypes http:/fga2013farm4: 38876, ..
V" 5/18/2017 1:43:08 PM Copying Document  Home.aspx http:/fqa2013farm4: 38876, ..

5/18/2017 1:43:15PM Adding referenced... i:0#.flmembers...
B e R R e e

<

Target
https:, ™
https:,
https:,
hitps:,
https:,
https:,
https:,
https:,
https:,
https:,
https:,

Job items are job files, or logging, for individual items within the scope of an action. For example, if a
SharePoint site is copied, there would be a job item for adding each list and each item in that list, and
one job item for adding or creating each site or sub-site. If a SharePoint list with fie documents is

copied, then there would be a job item for adding/creating the list, and then one job item for adding

each of the documents.

From the Log Viewer you can select and view any job items that exists within that job list.

NOTE: Some actions in Content Matrix have the ability to run with Verbose Logging. This option will

increase the size of the log file.

Log Item Details

To view Log Item Details:

1. From the Log Viewer, select the item whose details you want to view.
2. Use one of the following options:
=  Double-click on the item.

OR

= Right-click and choose View Job Item.
OR

= |f the job is currently running, click Details>>.
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) Log Item Details - o IEER

OPERATION STATUS ITEM NAME

Copying Content Type Resource Fil Failed docsethomepage.aspx

TIME STARTED TIME FINISHED BYTES COPIED
11/23/2021 5:07:50 PM 11/23/2021 5:07:52 PM oB

SOURCE

hitp://sp2016/sites/Ishan Test/ cts/documente20set

INFORMATION
Exception: Access denied.

DETAILS VIEW CONTENT COMPARER

Error: Access denied. ~
Stack: at Micosoft.SharePoint.Client.ClientRequest. ProcessResponseStream(Stream responseStream)

at Microsoft. SharePoint. Client. ClientRequest.ProcessResponse()

at Microsoft. SharePoint.Client. ClientContext.ExecuteQuery()

at Metalogix.SharePoint. Adapters.CSOM20 13.ClientContextExtension.ExecuteQueryWithIncrementalRetry
(ClientRuntimeContext context, Int32 retryCount, Dictionary * 2 privateData, Int32 delay) in C:\Users\ishank\source
Yepos\ContentMatrix Metalogix.SharePoint. Adapters. CSOM20 13\ClientContextExtension.cs:line 70

at Metalogix.SharePoint. Adapters.CSOM20 13.CSOMAdapter . CallExecuteQuery(ClientRuntimeContext ctx,
SharePointAdapter calingAdapter) in C:\Users\ishank\source\repos\ContentMatrix
Wetalogix.SharePoint. Adapters.CSOM20 13\CSOMContext.cs:line 173

at Metalogix.SharePoint. Adapters.CSOM20 13.CSOMAdapter.SaveBinaryDirectWithRetries(ClentContext ctx, String
serverRelativeUrl, MemoryStream ms) in C:\Users\ishank\source repos\ContentMatrix
Wetalogix.SharePoint. Adapters.CSOM20 13\I temsWriter.cs:line 3228

at Metalogix.SharePoint. Adapters.CSOM20 13.CSOMAdapter. AddFileToFolder (String sFileXML, Byte[] fileContents,
AddDocumentOptions Options) in C:\Users\ishank\source repos\ContentMatrix
Wetalogix.SharePoint. Adapters.CSOM20 13\ temsWriter.cs:line 3100

at Metalogix.SharePoint. SPFileCollection. Add(String fileXmi, Byte[] content) in C:\Users\ishank\source yepos
\ContantiatriviMatalaniv SharabDaint\SDEile celine 204

[Search KBs ] I Copy ] [ Prev Next Close

The Job Details dialog contains the following information:

Operation - The last operation performed on the item.

Status — The status of the item.

Item Name - For items, the Item ID. For documents, the Filename.
Time Started — The time the action for the item was started.
Time Finished — The time the action for the item was finished.

Bytes Copied — The bytes (B) that were copied in the action. This will be displayed in KB in some
cases.

Source - The Source URL for the item.
Target - Target URL for the item.

Information - Provides an informational message about the item, such as. This section will provide
a description for any different and/or missing attributes/metadata for an item.

Details View - Any errors that were encountered with the item when an action was performed.

Content Comparer tab - Any differences between Source and Target content (from a compare
action). You can display this information in either a Grid View, which displays a metadata property
grid for the item, or as a Text View, which displays a XML text format of the item. This option is
most useful if Verbose Logging has been checked
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You can also:

e Use [Search KBs] to have Content Matrix query the Quest Support Knowledge Base for relevant
articles if you selected a failed item.

e Use [Copy] to copy all of the item information and details (including the Details tab) into the
system’s clipboard. You can then paste the information when it can then be pasted to another
location. When pasted the information will look similar to that of the actual Log Item Details
dialog. This can be used for easy copy/pasting of an items migration log details.

e Use [Prev] and [Next] buttons to move to the previous or next item on the list (if applicable).

Exporting Jobs to an Excel File

You can export a selected job or multiple jobs from the Job List section into a Microsoft Excel file. The
export will include all of the operations within each job (whether it is a migration action or some other
action), and their details. This is to help users better understand their migration data and results, and
provides another way to review the resulting logs.

In addition to the log details that are provided, there are also a number of tables and charts that can be
accessed in different tabs within the Excel file. These tables and charts will help breakdown the
information in a more visible manner.

To export one or more jobs to an Excel file:

1. Inthe Job List, select the job(s) you want to export.
2. Use one of the following options:
=  From the Job List menu, select Export Excel
OR
= Right-click and choose Export selected job to Excel.

3. Save the file to the desired location.

By default the Excel file will open after it has been created. This process may take a few minutes
depending on the size of the selected job(s) and the number of actions in the log(s).

Procedure for exporting one or more jobs to an Excel file

1.

Information in Exported Excel Files

When an Excel file is exported from the Content Matrix Job List there are a number of page tabs that
can be viewed. Each page tab will display a different set of data, and some of these tabs will also
display pivot graphs (with pivot tables behind them).
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NOTE: The data within all of these Excel tabs (both the tables and the graphs) should only be
considered a starting point when looking at your migration data. You can modify the existing graphs
through various methods, such as applying filters, changing the data values, etc. You can also take the

"raw" data from the Logltems tab and use it to create your own graphs or sets of data as required.

The exported file contains the following tabs:

e Jobs - All of the specific jobs that are included in the export. This includes migration jobs as well as

other actions.

e Logltems - All of the operations that have been run by Content Matrix and provide all of the logging
details that are available in the Log Viewer and Log Item Details windows. Some examples of these
operations are: adding lists, adding content types, copying documents, adding users, updating lists,

etc.
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5 Job: | Lsgltems | Error Rates | Opersfion Counts Opera .. ]

e Error Rates - A a graph that represents the number of errors and warnings that Content Matrix
encounters during a migration on a "per minute" basis. The vertical axis will list the number of
errors/warnings that are encountered (at the specified time), and the horizontal axis lists the
amount of time (displayed in a "per minute" value). The horizontal axis can also be changed to
display in month, day, or hour time values as well. Below the graph is a table that provides a

different view of the same error/warning breakdown.
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Operation Counts - The number of operations/actions that are run over a period of time. Some
examples are: copying sites, copying lists, copying documents, adding SharePoint groups, adding
users, copying permissions, etc., and each operation has its own line representation on the graph.
The vertical axis lists the number of operations that are running (at the specified time), and the
horizontal axis lists the amount of time (this is displayed in a "per minute" value). The horizontal
axis can also be changed to display in month, day, or hour time values as well. Below the graph
there is a table that provides a different view of the same migration operation data.

Operation Duration - The total duration of time for each operation/action type against the total
migration time. This is potentially the most confusing graph to read in the exported Excel file. The
vertical axis lists the total duration time for each action. This is determined by finding the
difference between each operation/actions Time Started and Time Finished values, and then

Content Matrix File Share Edition
113
Job Log Files



adding the totals together for all of that operation/actions of that type that are running. This is
then displayed against the horizontal axis which lists the time (displayed in a "per minute" value) for
the migration. The horizontal axis can also be changed to display in month, day, or hour time values

as well. Below the graph there is a table that will provide a different view of the same migration
data.
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An example of how to read this graph is: if at minute 25 (of the hour, not the 25 minute of the
migration) a large number of small documents are copied and completed (all in the 25th minute),
then at minute 25 in the graph there will likely be a spike in the "duration time" for the "Copying
Document" operation/action. If each document was copied in 2 seconds, and there were 41 small
documents, then the Sum of Duration value would be listed as 82 seconds (or 0:01:22). So the

results in the graph would show a spike for the Copying Document operation/action and minute
25, with a value of 0:01:22.

Operation Throughput — The amount of data/throughput (in MB) that is migrated on a "per
minute" basis. The vertical axis lists the amount of data that is being pushed through Content
Matrix for a given operation (at the specified time), and the horizontal axis lists the time (displayed
in a "per minute" value) at which that the action was performed. The horizontal axis can also be
changed to display in month, day, or hour time values. Below the graph there is a table that will
provide a different view of the same throughput data.
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Copying Job Logging to Other Applications

It is possible to copy the results of migration jobs from log files to other applications. This can be
beneficial if you want to keep track of copy or incremental information outside of Content Matrix, or
want to manipulate the information for reporting or retention purposes. The log information is copied
as text, to the clipboard, and can then be pasted within any other application that allows text pasting.
For example, if a copy action was made, the logging can be copied into a Word file, or into an Excel
spreadsheet, then saved.

NOTE: Only the end results of the total action will be copied.

To copy the logging for a job list:

1. Select a job from the Job List.
2. Right-click, and choose Copy selected job to clipboard (alternately Ctrl+C can be used).

3. Openthe desired target program (for example: Microsoft Word, Microsoft Excel, Notepad, etc),
then paste the content into the application (Ctrl+V, or the paste command in the application
itself).

NOTE: The logging for each action within the list must be copied separately.

To copy the logging for job items:

e Select the desired job list or job item(s) that the logging is to be copied from, and open the job list
to access the Log Viewer.

e Select any job items that are to be copied. Single or multiple items can be selected in the Log
Viewer. In order to copy the logging for the entire job, all job items in the Log Viewer must be
selected.
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e When all of the desired items are selected, right-click on one of them, and select Copy Log Items to

Clipboard, and select to either copy them with, or without details. The Details are a set of extra

columns that are added to the logging. These columns are typically: Details, SourceContent, and
TargetContent. These columns do not always contain extra information. The default copy option

(Ctrl+C) is to copy the logging without the Details.
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Creating a Support Zip File

You can generate a zip file of data associated with a single migration job to help Quest Support
facilitate troubleshooting.

The high-level data collected in the zip file includes:

e Application Settings files.
e Product information (product version, license, etc.).

e Information about the job (what action settings were set, the job log, etc.).

IMPORTANT: Sensitive Information

Please review the contents of the zip file before sending it to Support. While this feature attempts to
only collect non-sensitive data, no guarantees can be made - it is up to you to ensure that any files in
the zip folder are stripped of any confidential data. Regardless, Quest assures that the contents of the
zip file will only be used for troubleshooting the associated support ticket. For added security, Content

Matrix removes the encrypted password and token information from the file.

NOTE: Because passwords are removed, if you try to import a job from a Support zip file and there is
no active connection to both the source and target, the import will fail. It is recommended that you
create xml jobs using Export to Xml functionality instead of using the xml file generated by the Create
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Support Zip File operation. Refer to the Knowledge Base article While Importing a Job from a Support
Zip File, the error “Could not load data: A password is required” is generated (4369247) (quest.com)
for details.

To create a Support zip file:

1. Inthe Job List, select the job for which the zip file is to be generated.
2. Use one of the following options:
= |nthe main ribbon, click the Help tab, then Create Support Zip File.
= Right-click and choose Create Support Zip File.
3. Save the file to the desired location using the desired file name.

4. If you wish to review the zip file for sensitive information, click Yes to open the zip file. Once you
are satisfied with the contents of the zip file, it can be sent to Quest Support to aid in
troubleshooting.
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Using PowerShell with Content
Matrix

Content Matrix can generate PowerShell scripts to be used to migrate SharePoint content through the
PowerShell command window. You can also use PowerShell to perform other actions, including:

e connecting to SharePoint

e triggering a job in the Content Matrix Console to run

The Content Matrix PowerShell Console shortcut is added to the same Start Menu folder location
where the to Content Matrix Consoles are placed after installation. The same PowerShell console can
be used for any edition, as long as the edition-specific snap-ins are used. You can also use a standard
PowerShell console or PowerShell ISE.

Content Matrix PowerShell Commandlet List

Content Matrix can generate PowerShell script for you, for any migration action that is available
through it. The below cmdlets are used in the generated PowerShell script, but can also be used to
write your own script, should you desire to do so. For more information on each cmdlet, simply type
get-help [cmdlet]. For example, if you want more information on Copy-MLSharePointList cmdlet you
would enter get-help Copy-MLSharePointList, followed by the Enter (return) key.

Below is a list of the available cmdlets (and their parameters), broken up into the available commands
for each snap-in.

Adding PowerShell Snap-Ins for the Application Framework

Whenever a new PowerShell session is launched, the edition-specific snap-ins must be added before
you can perform a Content Matrix action.

NOTES:

o |f you have more than one edition of Content Matrix, only one edition can be run per PowerShell
session.

o |f Content Matrix settings or a connection to a Distributed Database change, in order to apply new
settings all PowerShell sessions must be restarted.
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To add the PowerShell cmdlets for the application framework:
1. Open a Powershell ISE or PowerShell console session.

2. Copy and paste the PowerShell snap-ins from the Quest Support Knowledge Base article located at
https://support.quest.com/content-matrix/kb/333879.

Metalogix.Jobs.Reporting.Commands

Export-JobHistory

e SqlCeDbFilePath - Specify the path to the SQL database file that contains the Job History data.
(Mandatory)

ServerName - The name of the SQL Server. (Mandatory)

DatabaseName - The name of the Job History database. (Mandatory)

AuthType - Indicates whether to use Integrated (Windows) or SQL Authentication. If not specified
will Integrated Authentication will be used.

Username - Specify the username for SQL Authentication.

Password - Specify the password for SQL Authentication.

Metalogix.SharePoint.Commands

Add-MLSharePointSiteCollection

o WebApplicationName - Name of the Web Application to Create the Site Collection in. Web
Application must exist in the specified Target. (Mandatory)

e WebTemplateName - Web (Site) Template to use for the Site Collection. Web (Site) Template must
exist. The value must be in the form namet#tconfiguration. E.g., STS#1 for Blank Site (Mandatory)

e Language - Language to use for the Site Collection. Can be Language Code (LCID) or Language
Name. Language must exist in the specified Target. (Mandatory)

o Title - The Title for the Site Collection. (Mandatory)
o Description - Description for the Site Collection.

e Path - Managed Path for the Site Collection. Include forward-slash characters where required. E.g.,
"/sites/" or "/sites/". (Mandatory)
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URL - Server Relative portion of URL solely used to identify the Site Collection itself. E.g.,
"TestSiteCollection" (Mandatory)

OwnerlLogin - Domain and username to be used as the Primary Administrator for the Site Collection.
E.g., "sampledomain\sample.user" (Mandatory)

SecondaryOwnerLogin - Domain and username to be used as the Secondary Administrator for the
Site Collection. E.g., "sampledomain\another.user"

ContentDatabaseName - Content Database Name to use. Not specifying this value will use the
default content database (auto detect).

SelfServiceCreateMode - Allow users without Farm Administrator privileges to add the Site
Collection.

SetSiteQuota - Set Quota for the Site Collection.

QuotaMaximum - Limit site storage to maximum size (Mb). SetSiteQuota must be set to true and
SelfServiceCreateMode should be false. Mutually exclusive with QuotalD.

QuotaWarning - Send a warning email when the site storage reaches this size (Mb). SetSiteQuota
must be set to true and SelfServiceCreateMode should be false. Mutually exclusive with QuotalD.

QuotalD - Use Quota Template. Can be the integer ID or the string name of the Quota. SetSiteQuota
must be set to true and SelfServiceCreateMode should be false.

Transformers - The collection of data transformers which the action needs to run. Note that if the
passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.

Quiet - If set, the operation will not report progress to the PowerShell console.

JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
Source - The source node for the actions.

Target - The target node for the actions.

JobDatabase - The connection string of a jobs database to use for logging. If the connection string is
invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Add-Permissions

e Name - The name of the user or group you wish to assign a permission level to. (Mandatory)

e PermissionLevel - The name of the permission level you want to grant the specified user or group.
(Mandatory)



e Recurse - A flag that indicates the given permissions level should be granted to the given user for
each item below the target which has unique permissions.

o Transformers - The collection of data transformers which the action needs to run. Note that if the
passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.

o Quiet - If set, the operation will not report progress to the PowerShell console.

o JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
e Source - The source node for the actions.

o Target - The target node for the actions.

e JobDatabase - The connection string of a jobs database to use for logging. If the connection string is
invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Add-SharePointFolder

e Name - The name of the folder to be created. (Mandatory)

o Transformers - The collection of data transformers which the action needs to run. Note that if the
passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.

o Quiet - If set, the operation will not report progress to the PowerShell console.

o JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
e Source - The source node for the actions.

o Target - The target node for the actions.

o JobDatabase - The connection string of a jobs database to use for logging. If the connection string is
invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Add-SharePointList

e Name - The name for the new list. (Mandatory)
e TemplateName - The numeric code of the template to use. (Mandatory)

o Description - A description of the list.



o Title - The title for the new list.

e |sOnQuickLaunch - Indicates if the list should be added to the quick launch.

e HasVersions - Indicates if the list should enable major versions.

e HasMinorVersions - Indicates if the list should enable minor versions.

o RequiresContentApproval - Indicates if the list should require content approval.

o Transformers - The collection of data transformers which the action needs to run. Note that if the
passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.

e Quiet - If set, the operation will not report progress to the PowerShell console.

o JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
e Source - The source node for the actions.

o Target - The target node for the actions.

e JobDatabase - The connection string of a jobs database to use for logging. If the connection string is
invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Add-SharePointSite

e URL - The URL name for the new site. If not specified, it will be automatically generated from the
given name.

e Name - The name for the new site. (Mandatory)

e TemplateName - The name of the template to use, either in [Name]#[Config] form or by the name
of the STP file. (Mandatory)

o Transformers - The collection of data transformers which the action needs to run. Note that if the
passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.

e Quiet - If set, the operation will not report progress to the PowerShell console.
o JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
e Source - The source node for the actions.

o Target - The target node for the actions.



o JobDatabase - The connection string of a jobs database to use for logging. If the connection string is
invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Clear-GlobalMappings

e ClearGuidMappings - Indicates that global GUID mappings should be cleared.
e ClearURLMappings - Indicates that global URL mappings should be cleared.
e ClearUserMappings - Indicates that global user mappings should be cleared.

o ClearDomainMappingss - Indicates that global domain mappings should be cleared.

Get-MLSharePointDatabase

e Server - The name of the database server. (Mandatory)
e Database - The name of the SharePoint content database. (Mandatory)
e User- A user to connect as, in DOMAIN\Login format.

e Password - The password for the user provided.

Get-MLSharePointFolder

This is the same as Get-MLSharePointList with an additional parameter:

e FolderPath - The list-relative path to the desired folder, seperated by "/". (Mandatory)

Get-MLSharePointFolderFromDatabase

This is the same as Get-MLSharePointListFfromDatabase with an additional parameter:

e FolderPath - The list-relative path to the desired folder, separated by "/". (Mandatory)

Get-MLSharePointltembyFileName

FileName - The filename of the SharePoint document. (Mandatory)

FolderPath - The list-relative path to the desired folder, separated by "/".

ListName - The name of the desired list. (Mandatory)

SiteURL - The URL of the SharePoint site to connect to. (Mandatory)

User - A user to connect as, in DOMAIN\Login format.

Password - The password for the user provided.
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o AdapterType - The short name of the adapter type you want to use for the connection. Use OM for

a local SharePoint or WS for a remote SharePoint where the Metalogix Extensions Web Service is

installed.

e ReadOnly - Indicates that the connection made to the SharePoint site should be read only.

Get-MLSharePointltembyID

Id - The ID of the SharePoint item. (Mandatory)

e FolderPath - The list-relative path to the desired folder, separated by "/".
o ListName - The name of the desired list. (Mandatory)

o SiteURL - The URL of the SharePoint site to connect to. (Mandatory)

e User - A user to connect as, in DOMAIN\Login format.

e Password - The password for the user provided.

o AdapterType - The short name of the adapter type you want to use for the connection. Use OM for

a local SharePoint or WS for a remote SharePoint where our Metalogix Extensions Web Service is

installed.

e ReadOnly - Indicates that the connection made to the SharePoint site should be read only.

Get-MLSharePointltemFromDatabase

This is the same as Get-MLSharePointListFromDatabase with additional parameters:

¢ FolderPath - The list-relative path to the desired folder, separated by "/".

e ItemName - The filename or ID of the desired item. (Mandatory)

Get-MLSharePointList

This is the same as Get-MLSharePointSite with an additional parameter:

e ListName - The name of the desired list. (Mandatory)

Get-MLSharePointListFromDatabase

This is the same as Get-MLSharePointSiteFromDatabase with an additional parameter:

e ListName - The name of the desired list. (Mandatory)
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Get-MLSharePointServer

e ServerURL - The URL of the SharePoint server to connect to. (Mandatory)
e User - A user to connect as, in DOMAIN\Login format.
e Password - The password for the user provided.

e ReadOnly - Indicates that the connection made to the SharePoint site should be read only.

Get-MLSharePointSite

e SjteURL - The URL of the SharePoint site to connect to. (Mandatory)
e User- A user to connect as, in DOMAIN\Login format.
e Password - The password for the user provided.

e AdapterType - The short name of the adapter type you want to use for the connection. Use OM
for a local SharePoint or WS for a remote SharePoint where the Metalogix Extensions Web Service
is installed.

e ReadOnly - Indicates that the connection made to the SharePoint site should be read only.

Get-MLSharePointTenant

e TenantURL - The URL of the SharePoint tenant to connect to. (Mandatory)
e User - A user to connect as, in user@company.onmicrosoft.com format. (Mandatory)
e Password - The password for the user provided. (Mandatory)

e ReadOnly - Indicates that the connection made to the SharePoint tenant should be read-only.

Get-SharePointSiteFromDatabase

e Server - The name of the database server. (Mandatory)

e Database - The name of the SharePoint content database. (Mandatory)
e SiteURL - The server-relative URL of the SharePoint site to connect to.
e User- A user to connect as, in DOMAIN\Login format.

e Password - The password for the user provided.

o HostHeader - A host header for a specified subsite. Use this if you are connecting to a site or
subsite with a host header name.

Refresh-SharePointNode

o Transformers - The collection of data transformers which the action needs to run. Note that if the
passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.

Content Matrix
125
Using PowerShell with Content Matrix



Quiet - If set, the operation will not report progress to the PowerShell console.

JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

Source - The source node for the actions.

Target - The target node for the actions.

JobDatabase - The connection string of a jobs database to use for logging. If the connection string is
invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointFolder

Folder - The Folder object retrieved by using the Get-MLSharePointFolder Cmdlet. (Mandatory)

o Transformers - The collection of data transformers which the action needs to run. Note that if the
passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.

e Quiet - If set, the operation will not report progress to the PowerShell console.

¢ JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
e Source - The source node for the actions.

e Target - The target node for the actions.

o JobDatabase - The connection string of a jobs database to use for logging. If the connection string is
invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointitem

Item - The Listltem object retrieved by using the Get-MLSharePointltem Cmdlet. (Mandatory)

Transformers - The collection of data transformers which the action needs to run. Note that if the
passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.

Quiet - If set, the operation will not report progress to the PowerShell console.

JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

Source - The source node for the actions.
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e Target - The target node for the actions.

o JobDatabase - The connection string of a jobs database to use for logging. If the connection string is
invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointList

o List - The list object retrieved by using the Get-MLSharePointList Cmdlet. (Mandatory)

o Transformers - The collection of data transformers which the action needs to run. Note that if the
passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.

e Quiet - If set, the operation will not report progress to the PowerShell console.

o JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
e Source - The source node for the actions.

o Target - The target node for the actions.

e JobDatabase - The connection string of a jobs database to use for logging. If the connection string is
invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointSite

o Site - The site object retrieved by using the Get-MLSharePointSite Cmdlet. (Mandatory)

o Transformers - The collection of data transformers which the action needs to run. Note that if the
passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.

e Quiet - If set, the operation will not report progress to the PowerShell console.

o JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
e Source - The source node for the actions.

o Target - The target node for the actions.

o JobDatabase - The connection string of a jobs database to use for logging. If the connection string is
invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.



Remove-MLSharePointSiteCollection

o SiteCollection - The Site Collection object retrieved by using the Get-MLSharePointSite Cmdlet.
(Mandatory)

e Server - The parent Server object of the Site Collection, retrieve by using the Get-
MLSharePointServer Cmdlet. (Mandatory)

o Transformers - The collection of data transformers which the action needs to run. Note that if the
passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.

e Quiet - If set, the operation will not report progress to the PowerShell console.

¢ JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
e Source - The source node for the actions.

e Target - The target node for the actions.

o JobDatabase - The connection string of a jobs database to use for logging. If the connection string is
invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Search-SharePointSite

e SearchTerm - The search term to use.

o MaxResults - The number of search results to output.

e MatchExactly - Indicates that the search term must match one of the searched fields exactly.
e Recursive - Indicates that data within all subwebs should be included in the search.

¢ Includeltems - Indicates that the search results should include items.

¢ IncludeDocuments - Indicates that the search results should include documents.

¢ IncludeFolders - Indicates that the search results should include folders.

¢ IncludelLists - Indicates that the search results should include lists.

¢ IncludeSites - Indicates that the search results should include sites.

e ContentType - If specified, search results must include this value in their content type name.

o Author - If specified, search results must have been created by an author matching this value.
o Editor - If specified, search results must have been modified by an editor matching this value.
o CreatedBefore - If specified, search results must have been created before this date.

o CreatedAfter - If specified, search results must have been created after this date.
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¢ ModifiedBefore - If specified, search results must have been modified before this date.

o ModifiedAfter - If specified, search results must have been modified after this date.

e Transformers - The collection of data transformers which the action needs to run. Note that if the passed-in
value for this parameter does not include transformers which are considered mandatory, they will be added
automatically.

e Quiet - If set, the operation will not report progress to the PowerShell console.

¢ JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

e Source - The source node for the actions.

e Target - The target node for the actions.

e JobDatabase - The connection string of a jobs database to use for logging. If the connection string is invalid, an

exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the 'JobDatabase’
parameter will take precedence and the job will only be written to the job database.

Update-SharePointSiteCollectionSettings

o SiteCollectionAdmins - A list of login names to be granted site collection administrator privileges.
e QuotaMaximum - An independently defined maximum storage size for this site collection.

e QuotaWarning - An independently defined size at which to send a warning email for this site
collection.

e QuotalD - A quota template ID to use for this site collection.

o Transformers - The collection of data transformers which the action needs to run. Note that if the
passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.

e Quiet - If set, the operation will not report progress to the PowerShell console.

¢ JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
e Source - The source node for the actions.

e Target - The target node for the actions.

o JobDatabase - The connection string of a jobs database to use for logging. If the connection string is
invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.
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Metalogix.System.Commands

Set-ApplicationDataPath

e Path - The path to be used as the root folder for the application path. Note that relative path
elements relating to the product being used will still be generated within this directory, and that the
application data will be contained within those folders. (Mandatory)

¢ IncludeCompanyName - Indicates that the Metalogix company name should still be used as part of
the relative path from the specified directory to the application data folder.

Set-CommonDataPath

e Path - The path to be used as the root folder for the common data path. Note that relative path
elements relating to the product being used will still be generated within this directory, and that the
common data will be contained within those folders. (Mandatory)

¢ IncludeCompanyName - Indicates that the Metalogix company name should still be used as part of
the relative path from the specified directory to the common data folder.

Get-MetalogixConfigurationVariable

e Name - The name of the configuration variable. (Mandatory)

o ValueType - Specify the value type of the configuration variable. This type must be IConvertible.
(Default: IConvertible).

New-Filter

o PropertyName - The name of the parameter to compare the value to on the object being filtered.
(Mandatory)

e Operand - The operand to use to compare the specified value to the given property value.
(Mandatory)

e Value - The value to compare the given property to. (Mandatory)

e CaseSensitive - Indicates if the comparison should be case-sensitive. This parameter is only
meaningful when the property to be compared to is a string.

e TypeName - The name of a type to apply the filter to. If not specified, the filter will apply to any
object.

Content Matrix

130
Using PowerShell with Content Matrix



Join-Filter
e Logic - The logic to use in the join (and or or). (Mandatory)
o FilterExpression - The filter object to join together. Can be a set of filters). (Mandatory)

Invoke-Filter

e Objects (Mandatory)

o Filter (Mandatory)
Load-MetalogixConfigurationVariableSettings

o FilePath - The full file path of the configuration variable settings file to load. (Mandatory)

e Scope - The scope to load these settings into. (Default: Environment).

New-MetalogixSerializableObject

TypeName - The name of the type of object to create. (Mandatory)

AssemblyName - The name of the assembly containing the type to be created. (Mandatory)

SerializedValue - The XML representation of a single serializable Metalogix object. (Mandatory)

e Enumerate - If set, any collections returned by the cmdlet will enumerated. Otherwise, collections
will be returned as a single object.

New-MetalogixSerializableObjectCollection

o SerializedValue - The XML representation of a Metalogix object collection. Generally this will be
obtained by requesting the PowerShell command for a job configured in the GUI. This cmdlet is not
recommended for general use. (Mandatory)

Set-MetalogixConfigurationVariable

e Scope - The scope of the configuration variable. Possible values are Environment,
EnvironmentSpecific, User, UserSpecific, Application, ApplicationSpecific,
ApplicationAndUserSpecific. (Default: ApplicationAndUserSpecific). (Mandatory)

e Name - The name of the configuration variable. (Mandatory)
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o Value - The value of the configuration variable. (Mandatory)

Set-MetalogixDefaultResolverSetting

e Name - The name of the configuration variable ("ResourceTableResourceTableLink"). (Mandatory)

e Value - The value of the configuration variable. This value will indicate where to obtain configuration
key settings from. Options are local file system ("Metalogix.ResourceFileTableResolver") or agent
database (Metalogix.Core.ConfigVariables.ResourceDatabaseTableResolver). (Mandatory)

Metalogix.File.Commands

Copy-File

¢ IncludeFiles - Specify whether to include files. (Disabled)

o ExistingFileAction - Overwrite, rename, or skip on existing file with same name.

o DefaultContentType - Specify to migrate current content using the default target content type.

e ContentTypelD - Specify the content type id of the content type to map to.

o ContentTypeFieldMappings - Specify field mappings from source fields to the target content type.
e CorrectName - Enable/disable automatic replacement of invalid SharePoint characters in name.

e CorrectNameCharacter - Specify the replacement character for invalid SharePoint characters in
name.

e RenamefFiles - Enable/disable renaming of filenames using custom column.

e RenameColumn - Specify the column name of the column to use for renaming the files.
o LinkCorrectionOptions - Specify the link correction options.

e LoggingOptions - Specify the logging options.

e PermissionsOptions - Specify the permissions options.

o TargetHierarchyOptions - Specify the target hierarchy options.

e StoragePointOptions - Specify the target StoragePoint options.

o Transformers - The collection of data transformers which the action needs to run. Note that if the
passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.

Content Matrix
132
Using PowerShell with Content Matrix



Quiet - If set, the operation will not report progress to the PowerShell console.

JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

Source - The source node for the actions.

Target - The target node for the actions.

JobDatabase - The connection string of a jobs database to use for logging. If the connection string is
invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Copy-FileAsHierarchy

o MigrateToDocSet

o PermissionsOptions

e TargetDocSetOptions

o MigrateToSubFolder

e TargetSubFolderOptions

o MigratePermissionsForSubFolder
e TargetDocLibOptions

o MigrateToSubSite

o TargetSubSiteOptions

o MigratePermissionsForSubSite
e TargetSubSiteTemplateOptions

o Transformers - The collection of data transformers which the action needs to run. Note that if the
passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.

o Quiet - If set, the operation will not report progress to the PowerShell console.
o JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
e Source - The source node for the actions.

o Target - The target node for the actions.



JobDatabase - The connection string of a jobs database to use for logging. If the connection string is
invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

UseAzureOffice365Upload - Indicates if the copy operation to Microsoft 365 should use Azure/SPO
Containers.

EncryptAzureMigrationJobs - If Azure/SPO Containers are being used, indicates if the job manifest
file should be encrypted.

Copy-FileAsSiteHierarchy

This is the same as Copy-FileAsHierarchy with additional parameters.

Copy-FileToSite

This is the same as Copy-File with additional parameters.

Copy-FolderAsFolder

ExistingFolderAction - Overwrite, rename, or skip on existing folder and file with same name.
IncludeSubFolders - Migrate subfolders.

IncludeFiles - Migrate files.

CorrectName - Enable/disable automatic replacement of invalid SharePoint characters in name.

CorrectNameCharacter - Specify the replacement character for invalid SharePoint characters in
name.

FilterExpression - Defines a collection of filters to be applied to the files.
FileSettings - Specify the file settings.

LinkCorrectionOptions - Specify the link correction options.
PermissionsOptions - Specify the permissions options.
TargetHierarchyOptions - Specify the target hierarchy options.
StoragePointOptions - Specify the target StoragePoint options.
DefaultContentType - Specify if default Content Type should be used.

ContentTypelD - Specify the ID of the default Content Type to use.
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o ContentTypeFieldMappings - Specify the Content Type field mappings.

o Transformers - The collection of data transformers which the action needs to run. Note that if the
passed-in value for this parameter does not include transformers which are considered mandatory,
they will be added automatically.

o Quiet - If set, the operation will not report progress to the PowerShell console.

o JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
e Source - The source node for the actions.

o Target - The target node for the actions.

e JobDatabase - The connection string of a jobs database to use for logging. If the connection string is
invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the
'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Copy-FolderAsHierarchy

This is the same as Copy-FileAsHierarchy with additional parameters.

Copy-FolderAsList

This is the same as Copy-FolderAsFolder with additional parameters.

Copy-FolderAsSite

This is the same as Copy-FolderAsFolder with additional parameters.

Copy-FolderAsSiteHierarchy

This is the same as Copy-FileAsHierarchy with additional parameters.

Get-File

e Location - The location of the target item. (Mandatory)

Get-Files

o Name - Filter files by file name.
o Extensions - Filter files by file extension.
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e MinSize - Filter files by minimum file size.

o MaxSize - Filter files by maximum file size.

o CreatedBefore - Filter files by before created date.

o CreatedAfter - Filter files by after created date.

o ModifiedBefore - Filter files by before modified date.
o ModifiedAfter - Filter files by after modified date.

e Location - The location of the target item. (Mandatory)

Get-Folder

e Location - The location of the target item. (Mandatory)

Get-Folders

e Location - The location of the target item. (Mandatory)

Refresh-File

e Location - Refresh target folder. (Mandatory)

Refresh-Folder

e Location - Refresh target folder. (Mandatory)

Content Matrix

Using PowerShell with Content Matrix

136



15

Modifying Content Matrix
Configuration and Settings

You can configure and customize a number of Content Matrix settings, including:

e the use of encrypted SQL database connections

e proxy settings

e available actions and events

e default settings in configuration variable files

e client-side settings

e resource utilization settings

Configuring Proxy Settings

In most cases Content Matrix can automatically connect to SharePoint and authenticate license keys,
through an environment's proxy setting, However, in some cases the proxy may need to be configured
within Content Matrix. In these cases users can specify the proxy settings though the connecting
dialog.

There are two basic places where this proxy setting can be configured. The first of these is when
activating a license key, and the second when connecting to SharePoint. The dialogs for these options
look slightly different, and the when you are using a proxy to connect to SharePoint, you have the
additional option to Import Proxy from Internet Explorer.

W Proxy server E3 ‘ SharePoint Logon [ x|
Enableproxy @ 533 Connection Cptions Enable proxy @
Server name: Port: Import Proxy From Inte En
o Included Certificates
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To configure proxy settings:

1. Inthe Proxy server dialog, check the Enable proxy box.

2. Use the information in the following table to determine the appropriate action to take.

If ... Then ...

you want to A. Select Enter Manually.

manually enter
. - Enter the Server name (or IP) and Port for the proxy.
proxy information

C. Specify the credentials to be used when connecting to the target server.
The Windows authenticated credentials of the current user will be
selected by default. You can specify alternate SharePoint credentials by
clicking the Different user radio button, and entering an alternate
username and password.

SharePoint Logon E3

(O Connection Options /| Enable proxy 0
&3

Import Proxy From Internet Explorer ®) Enter Manually
% Proxy Options Qrver name: 127.0..0.1 Port: | 3080 )
Connect As
| @I Induded Certificates
METALOGIX\doconnor

@ Differentuser: | bellum\administrator

Password:

OK | | Cancel

Internet Explorer | select Import Proxy from Internet Explorer.
has been

. SharePoint Logon E3
configured to use
a prOXy server Via Q/ig Connection Options Q
a proxy auto- C ® Import Proxy From Internet Explorer ) Enter Manually
COnﬁguration 9 Proxy optiens Server name: Part:
(.PAC) file and you | | NOTE: This option is currently available only when connecting to
want to connect SharePoint.

to SharePoint

. . Refer to the Microsoft article Auto proxy configuration settings for Internet
using this method

Explorer for more information.

3. If you accessed the dialog from the License Activation dialog, click [Set].
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Using Encrypted SQL Database Connections

When connecting to a full SQL Content Matrix Job Database, you are given the option to connect using
TLS/SSL encryption.

NOTE: Content Matrix can use any version of TLS that is compatible with .NET Framework 4.7.2. The
default version of TLS used by the operating system on the machine from which you are connecting
will be used by Content Matrix.

Connect to SQL Server E3

SQL Server  |QAXSPI3DB14
S0L Database: |ContentMatrixlobs

w| Encrypt Connection
v

Authentication
® Use Cument Windows User: AXCELERTES T\testbenchfam

Use SQL Server Login:

Password:

Connect || Cancel

The encrypted connection can use either:

e a self-signed certificate or a trusted certificate from the third party authority (refer to the Microsoft
article https: .micr .com/en- I -engin nfigure-windows/enable-
for instructions on

configuring an encrypted connection using a certificate)

OR
e a SQL-generated certificate, which does not require configuration.

NOTE: If a trusted certificate is used, it is not necessary to check the Trust Server Certificate box.
However, if the box is not checked and the certificate is not trusted, the following message will
display:

€ Error E3

A connection was successfully established with the server, but then an error
occurred during the login process. {provider: S5L Provider, error: 0 - The
certificate chain was issued by an authority that is not trusted.)

Show details

In this case, the Trust Server Certificate box must be checked in order to continue the connection.
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Restricting Available Actions and Suppressing
Events

Content Matrix provides you with the ability to control what actions are available to the client
application through configuring on the SharePoint server. Product behaviors can be restricted along
three dimensions:

e Available actions
e Unrestricted users

e Suppressed events

Configuring the behavior of the Content Matrix client from target SharePoint servers requires that an
XML configuration file be added to the target SharePoint server web application directory. The XML file
must be named ServerAdapterConfig.xml and placed in the ML folder directory located within the
SharePoint hive (this is the same directory where the Metalogix SharePoint Extensions Web Service
files are). Below is an example of the typical directory location of the ML folder for SharePoint 2016
and 2019:

\\Program Files\Common Files\Microsoft Shared\Web Server Extensions\16\ISAPI\ML

ServerAdapterConfig.xml File Format

Below is an example of the simple XML format required for ServerAdapterConfig.xml.

<ServerAdapterConfig>
<DisabledActions>

<Action>Metalogix.SharePoint.Actions.Migration.PasteSiteActi
on</Action>

<Action>Metalogix.SharePoint.Actions.Migration.PasteSiteColl
ectionAction</Action>

<Action>Metalogix.SharePoint.Actions.Migration.PasteSiteList
s</Action>

<Action>Metalogix.SharePoint.Actions.Migration.CopyRoleAssignme
ntsAction</Action>

<Action>Metalogix.SharePoint.Actions.Migration.CopyWorkflowAsso
ciationsAction</Action>

<Action>Metalogix.SharePoint.Actions.Migration.PasteFolderActio
n</Action>

</DisabledActions>
<ExemptUsers>

<User>METALOGIX\geordie</User>
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<User>METALOGIX\Jjulien</User>

</ExemptUsers>

<SuppressEvents>False</SuppressEvents>

</ServerAdapterConfig>

There are three main sections within the root ServerAdapterConfig section of this XML:

e DisabledActions: This section defines the set of actions that cannot be run on the client. See

Actions That Can Be Disabled on the Server Side for a complete list.

e ExemptUsers: This section defines the set of users by user name who are exempt from any
DisabledActions. In other words, a user in the ExemptUsers is not subject to any restrictions
imposed on Content Matrix clients by the DisableActions section.

e SuppressEvents: This section defines if any of SharePoint's event receivers are suppressed/disabled
during a migration and then restarted once the action is complete. The value for this section is set
to "True" by default, but can be manually configured if want event suppression to be disabled.
Suppression of event receivers allows Content Matrix to avoid any potential concurrency issues
when migrating (mainly with regards to workflows).

Actions That Can Be Disabled on the Server Side

Many of the SharePoint related actions available in the Content Matrix Console can be disabled on the
server side. The table below lists the complete set of client actions that can be disabled from the server
and provides the format of the action name required in the DisabledActions section of the
ServerAdapaterCongifuration.xml file.

NOTE: When an action that is available via the client Ul is disabled on the server, it will be visible in
client menus but disabled.

Action

Change Global
Navigation Settings
Change Quick Launch
Create Folder

Create List

Create List From XML
Create Site

Create Site Collection

Create Site Collection
in Self-Service Mode

Delete Discussion Item

Configuration File Format
Metalogix.SharePoint.Actions.Administration.ChangeGlobalNavigationActio
n

Metalogix.SharePoint.Actions.Administration.ChangeQuickLaunchAction
Metalogix.SharePoint.Actions.Administration.CreateFolderAction
Metalogix.SharePoint.Actions.Administration.CreateListAction
Metalogix.SharePoint.Actions.Administration.CreateListFromXMLAction
Metalogix.SharePoint.Actions.Administration.CreateSiteAction
Metalogix.SharePoint.Actions.Administration.CreateSiteCollection

Metalogix.SharePoint.Actions.Administration.CreateSiteCollectionSelfServic
eMode

Metalogix.SharePoint.Actions.Administration.DeleteDiscussionltem
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Action

Delete Item

Delete List

Delete Site

Delete Site Collection
Export Doc Items

Publish Documents
and Pages

Update Site Collection
Settings

Add Role Assignments

Copy Folder
Permissions

Copy ltem Alerts
Copy List Alerts
Copy List Permissions

Copy List Role
Assignments

Paste Web Parts

Paste Master Page
Gallery

Paste Content Types
Paste All Subsites
Copy Web Alerts

Copy Web Permissions

Paste Workflow
Associations

Paste All List Items

Paste All List Items
into Items View

Paste Audiences

Paste Default Web
Part Page

Configuration File Format

Metalogix.SharePoint.Actions.Administration.DeleteFolder
Metalogix.SharePoint.Actions.Administration.Deleteltem
Metalogix.SharePoint.Actions.Administration.DeletelList
Metalogix.SharePoint.Actions.Administration.DeleteSite
Metalogix.SharePoint.Actions.Administration.DeleteSiteCollection

Metalogix.SharePoint.Actions.Administration.PublishDocumentsandPagesAc
tion

Metalogix.SharePoint.Actions.Administration.UpdateSiteCollectionSettingsA
ction

Metalogix.SharePoint.Actions.Migration.AddRoleAssignmentsAction

Metalogix.SharePoint.Actions.Migration.CopyFolderPermissions

Metalogix.SharePoint.Actions.Migration.CopyltemAlertsAction
Metalogix.SharePoint.Actions.Migration.CopyListAlertsAction

Metalogix.SharePoint.Actions.Migration.CopyListPermissions

Metalogix.SharePoint.Actions.Migration.CopyListRoleAssignments

Metalogix.SharePoint.Actions.Migration.CopyWebPartsAction

Metalogix.SharePoint.Actions.Migration.CopyMasterPageGalleryAction

Metalogix.SharePoint.Actions.Migration.CopySiteContentTypesAction
Metalogix.SharePoint.Actions.Migration.CopySubSitesAction
Metalogix.SharePoint.Actions.Migration.CopyWebAlertsAction

Metalogix.SharePoint.Actions.Migration.CopyWebPermissions

Metalogix.SharePoint.Actions.Migration.CopyWorkflowAssociationsAction

Metalogix.SharePoint.Actions.Migration.PasteAllListltemsAction

Metalogix.SharePoint.Actions.Migration.PasteAllListltemsIntoltemsViewActi
on

Metalogix.SharePoint.Actions.Migration.PasteAudiencesAction

Metalogix.SharePoint.Actions.Migration.PasteDefaultWebPartPageAction



Action

Paste Duplicate List
Paste Duplicate Site
Paste Folder

Paste List

Paste List as Folder

Paste List Email
Notifications

Paste List Item

Paste List Item into
Items View

Paste My Sites
Paste Navigation
Paste Roles

Paste Site

Paste Site Collection
Paste Site Content
Paste Site Lists

Remove Role
Assignments

Event Suppression

Configuration File Format

Metalogix.SharePoint.Actions.Migration.PasteDuplicateListAction
Metalogix.SharePoint.Actions.Migration.PasteDuplicateSiteAction
Metalogix.SharePoint.Actions.Migration.PasteFolderAction
Metalogix.SharePoint.Actions.Migration.PasteListAction

Metalogix.SharePoint.Actions.Migration.PasteListAsFolderAction

Metalogix.SharePoint.Actions.Migration.PasteListEmailNotificationAction

Metalogix.SharePoint.Actions.Migration.PasteListitemAction

Metalogix.SharePoint.Actions.Migration.PasteListltemIntoltemsViewAction

Metalogix.SharePoint.Actions.Migration.PasteMySitesAction
Metalogix.SharePoint.Actions.Migration.PasteNavigationAction
Metalogix.SharePoint.Actions.Migration.PasteRolesAction
Metalogix.SharePoint.Actions.Migration.PasteSiteAction
Metalogix.SharePoint.Actions.Migration.PasteSiteCollectionAction
Metalogix.SharePoint.Actions.Migration.PasteSiteContentAction

Metalogix.SharePoint.Actions.Migration.PasteSiteLists

Metalogix.SharePoint.Actions.Migration.RemoveRoleAssignmentAction

Metalogix.SharePoint.Actions.Migration.SuppressEvents

Note that many of the above listed actions are used by other actions. When a given action is enabled,
but one or more of its sub-action is disabled, the sub-actions will not run. When a user attempts to run
an action for which sub-actions are disabled, they will be notified with a dialog similar to the following:

Disabled sub-actions x|

This action uses the following sub-actions that are not enabled on
l . one or more of the selected target servers. Any configuration
options selected relating to these actions will be ignored:

Paste Role Assignments
Paste all child lists

Paste Content Types

Paste Workflow Assodations

Cancel |
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Configuration Variable Files

Content Matrix uses a set of configuration variable files behind the scenes to help set and manage
settings for all of the Content Matrix Editions. This section explains what the configuration variable
files are, their general behavior, and where to find them.

Configuration variables are contained in the following three files:

e EnvironmentSettings.xml
e UserSettings.xml

e ApplicationSettings.xml

Some settings can be configured for all Product Editions, while other settings are limited to individual
Product Editions.

Any settings that are configured in multiple files will be scoped to the lowest level (either in the
"UserSettings.xml" file or the "ApplicationSettings.xml" file), including values that are pulled from the
old EnvironmentSettings.xml file.

IMPORTANT: Make sure the Content Matrix Console is closed when making updates to configuration
variable files.

EnvironmentSettings.xml File

This file allows users to configure general settings for all Product Editions. This means that these
settings only need to be set in a single file, either for all users of the machine (if users are required to be
local administrators) or for each individual user of the machine (if users are not required to be local
administrators) and can be found in one of the following locations:

o |f you are required to be a local administrator on the machine where Content Matrix is installed: C:
\ProgramData\Metalogix

OR

e |f you are not required to be a local administrator on the machine where Content Matrix is installed:
C:\Users\<username>\AppData\Roaming\Metalogix\Common

UserSettings.xml File

This file allows users to configure general settings for all Product Editions for a specific user account
(the logged in account). This means that these settings will be configured for all Product Editions, but
only for the current user account. If another user would like to configure these same settings to work
for them, they must be configured manually under the appropriate user account. It can be found in the
following location:

C:\Users\<USER>\AppData\Roaming\Metalogix
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ApplicationSettings.xml File

This file allows users to configure settings that are limited to the specific Product Edition of Content
Matrix Console, for a specific user account (the logged in account). This means that each Product
Edition, for every user account, must be configuredindividually. While the "ApplicationSettings.xml" file
for each Product Edition can contain some of the same settings, there are some settings that are
Edition specific (for example, some settings may only work for SharePoint Edition, so they will only be
available in SharePoint Edition). Any settings that are replicated through various version of the file will
only be applied to the specific Edition.

For example, the "AllowCheckResults" setting is available in every "ApplicationSettings.xml" file, but it
must be set on an individual Product Edition basis. Setting it for SharePoint Edition will not configure it
for Public Folder Edition. It can be found in the following location:

C:\Users\<USER>\AppData\Roaming\Metalogix\Content Matrix Console - <Product> Edition.

Client Side Configuration

For an individual Content Matrix Console instance, you can Configure Settings for Migrations Using
the Import Pipeline.

Configuring Settings for Migrations Using the Import
Pipeline

Content Matrix has various XML properties that can be modified to fine-tune or help troubleshoot your
Import Pipeline migrations. These properties can be found in the EnvironmentSettings.xml file.

NOTE: You can also contact Quest Support for assistance in identifying and resolving issues with
migrations using the Import Pipeline. For a list of supported migration actions, see Objects and
Actions Supported for Using the Import Pipeline.

Batch Size Settings

The following XML properties can optionally be modified. However, it is generally recommended to not
modify these values unless you are encountering issues when migrating using the Import Pipeline.

UploadManagerBatchSizeltemThreshold

This key controls the maximum batch size in item count, including all folders and documents, to be used
if Content Matrix will be submitting batches according to number of items. The default value is 200 and
the value must be a positive integer.

<XmlableEntry>
<Key>UploadManagerBatchSizeItemThreshold</Key>
<Value>200</Value>

</¥XmlableEntry>

UploadManagerBatchSizeMBSizeThreshold
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This key controls the maximum batch size to be used if Content Matrix will be submitting batches
according to size. The default value is 1000 megabytes and the value must be a positive integer. The
value should be set carefully, taking into consideration factors such as total upload bandwidth, speed
of data retrieval from the source system, and so on.

<XmlableEntry>
<Key>UploadManagerBatchSizeMBSizeThreshold</Key>
<Value>1000</Value>

</XmlableEntry>

Batch Resubmission Settings
MaxAzureBatchRetryCount

This key controls the maximum number of times Content Matrix will resubmit the batch until it is
successfully migrated. (The default value is 5.)

<XmlableEntry>
<Key>MaxAzureBatchRetryCount</Key>
<Value>5</Value>

</XmlableEntry>

ErrorMessagesForRetryAzureBatch

This key specifies error conditions for which you want Content Matrix to resubmit a batch, when it
normally would not.

NOTE: Separate multiple error messages with a pipe character (|), as shown in the example below.

<XmlableEntry>

<Key>ErrorMessagesForRetryAzureBatch</Key>

<Value>Item does not exist|Object Reference Not Set</Value>
</XmlableEntry>

Performance Settings
BufferSizeForPipelineMigrationInMb

This key controls the buffer size while uploading files to Azure Storage Account Containers using the
Import Pipeline. The default value is 64, which means, for example a 128 MB file will be uploaded in
two parts, 64 MBs at a time. The lower buffer size, the more quickly the computer processor handles
the information. Keep in mind that the higher the value, the more system resources will be consumed.

<XmlableEntry>
<Key>BufferSizeForPipelineMigrationInMb</Key>
<Value>64</Value>

</XmlableEntry>

MaxParallelUploadFilesinPipeline

This key controls the number of files uploaded in parallel to Azure Storage Account Containers when
using the Import Pipeline. The default value is 2, which means a maximum of two files can be uploaded
in parallel. Keep in mind that the higher the value, the more system resources will be consumed.

<XmlableEntry>
<Key>MaxParallelUploadFilesInPipeline</Key>
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<Value>2</Value>
</XmlableEntry>

UploadManagerMaxRetryCountThresholdForJobResubmission

WARNING: This value should not be changed unless absolutely necessary.

This key controls the amount of time to wait for a response from the reporting queue before re-
requesting a migration job. This value is specified in multiples of 15 seconds, meaning that the default
value of 960 corresponds to 4 hours and the minimum value of 120 corresponds to 30 minutes. This
value must be a positive integer greater than or equal to 120.

<XmlableEntry>
<Key>UploadManagerMaxRetryCountThresholdForJobResubmission</Key>
<Value>960</Value>

</XmlableEntry>

Temporary Storage Location
UploadManagerLocalTemporaryStorageLocation

This key indicates the directory in which the temporary binary files and manifest XML files for each
batch are saved. If no filepath is specified, the default file path is used.

<XmlableEntry>
<Key>UploadManagerLocalTemporaryStorageLocation</Key>
<Value>C:\ProgramData\Metalogix\Temp folder sample</Value>
</XmlableEntry>

Changing Resource Utilization Settings

How many threads can be used simultaneously per job in Content Matrix is controlled by the Edit
Resource Utilization Settings option, which is accessible from the Settings ribbon at the top of the
Console Ul.

If the option is clicked, a dialog containing a slider will appear that will allow control of the number of
threads available within a single action. If the slider is moved all the way to the left, this will turn off
multithreading and only allow a single thread to be used during the action. (For more information on
threading, refer to the Microsoft article About Processes and Threads.)

NOTE: Turning off multithreading in this way can be a valuable way of troubleshooting whether
multithreading is causing issues.

If the slider is left in the middle, it will allow twice the number of processors in threads to be created
per action. For example, if the machine running Content Matrix has a two core CPU, four threads will
be able to be used if the slider is in the below state:
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Moving this slider to the right will increase the resources allocated to running jobs.
This allows the application to scale performance with available hardware.
In most cases, Metalogix recommends this setting be left at the default value.

Resource Utilization Settings H...
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Moving the slider farther to the right will allow more threads to be used, but can potentially overwhelm

system resources. This could lead to potential errors if the system resources cannot handle the data

being migrated. There is a chance that if the speed is too high, you would see a slowdown in the

overall migration, because the migration is trying to run actions faster than the resources properly

allow.

While this value can be set through the Content Matrix Console, you can also set it through the back
end, if the Ul setting does not seem to be working for you. Please contact Quest Support for more

information on this back end setting.
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Frequently Asked Questions

This section answers some of the most frequently asked questions about using Content Matrix.

Activating the License Key Silently

Question

I would like to activate my license outside of the Content Matrix Console. Is that possible?

Answer

You can activate your Content Matrix license using PowerShell. Follow the steps below.
NOTE: This method can only be used for online activations.

1. Open the Content Matrix PowerShell Console.

2. Run the following cmdlet, which includes specifying the Content Matrix Console Edition for which
you want to activate the license.

if (Get-Command Set-MetalogixJobPrerequisites -ErrorAction
SilentlyContinue) { Set-MetalogixJobPrerequisites -Value "Content Matrix
Console - <Edition name>" }

NOTE: Valid values for <Edition Name> are SharePoint Edition, FileShare Edition and Public
Folder Edition. If you license covers more than one Edition, it is only necessary to activate one.
The license activation will automatically be applied to any other Edition for which you are
licensed.

3. Run the Set-MetalogixLicense cmdlet. Note that additional parameters are required if a proxy
server is used.

Without proxy server:

Set-MetalogixLicense -Key "<license key>"

With proxy server:

Set-MetalogixLicense -Key "<license key>" -ServerUrl
"<proxy server IP addres>" -Port "<proxy port number>" -UserName
"<user account>" -Password "<password>"

NOTE: When entering the license key, include hyphens.
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Created Dates Not Retained

Question
We reviewed the upload process and observed that created date was not retained but all other
attributes (modified date, modified by and created by) were all correctly set. What could cause this?

Answer
In some cases customer try to set a created date that is more recent than the modified date. This is not
allowed by SharePoint. As a result, the created date will be set to the current date.

General Limitation Questions

Question

1. Isthere a limit to the number of items you can be listed under a File Share Connection?
2. Isthere a limit to the number of rows and columns that you can have in the File Share Edition?

3. Isthere an expected amount of memory usage?

Answer
1. This partly depends on the machine that is running the Content Matrix Console. Depending on the
machine it is recommended to only go as high as 5000 items under a File Share connection.

2. This is similar to the number of items. Since it is recommended to only go as high as 5000 items
under a File Share connection, and each item is the same as one row in the Items View tab, we
recommend to only go up to 5000 rows under a specific File Share connection. While there is no
limit to this for columns, since these are only related to rows in that it is information for items, it
would still be a good general rule to not exceed 5000 columns, but going over this should not be an
issue.

3. Content Matrix Console uses an in memory Database (DB) for it's project files, so the amount of
memory used can get quite large depending on the number or rows and columns that are included
under the File Share connection. To help reduce the in-memory footprint any long strings are stored
in the DB, and not in the memory. Since each user's migration scenario is different, we can't
accurately give an expected amount of memory usage.

License Key Troubleshooting

Question

| have been unable to get Content Matrix to recognize my license key. When | copy and paste it into
the box, | get a "the specified license key is invalid" error.
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Answer
Here are some things to check:

e Make sure that the license covers the product edition. (For example, if you are licensed for
SharePoint Edition and try to activate the license for Public Folder Edition, the invalid error will
display.)

e Confirm that the license you are installing is for the correct application versions of Content Matrix.
Contact Quest to verify that it is. (For example, license keys beginning with 823, 824, and 827 are not
compatible with File Share Edition since its reintroduction in version 9.9.)

e When performing an offline key activation, make sure to enter the long key in its entirety, including
the "=" symbol at the end of it.

o Verify that you have write privileges to the registry. The installer will fail if the registry is locked. In
some cases there may be a group plicy that is preventing the user from adding the key in the registry,
despite the user having the correct permissions.

e Some versions of Windows will automatically block write access to the registry under the user
account, even if that account has write access to the registry. In this case you can go to the
application installation folder, right click on the application .exe file, and choose 'Run as
Administrator'. Then re-enter the license key.

Errors Connecting to SharePoint 2019 or
SharePoint Server Subscription Edition in a
FIPS-Enabled Environment

Question

Why am | getting an error when | try to connect to SharePoint 2019 or SharePoint Server Subscription
Edition in a FIPS-enabled environment?

Answer

Content Matrix uses some assemblies for FIPS compliance that are not supported for certain
SharePoint 2019 and SharePoint Server Subscription Edition connections.

For a remote object model (MEWS) connection (displays for the top node) for SharePoint 2019:

Client found response content type of 'text/html; charset=utf-8', but expected 'text/xml'. The request
failed with the error message: -- <!DOCTYPE html> <html>

For a local object model (OM) connection (displays at the item level for SharePoint 2019 and
SharePoint Server Subscription Edition):
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The type initializer for 'Microsoft.SharePoint.ApplicationRuntime.SPRequestModule' threw an exception
In addition, errors will display in Browser View and Items View.

For SharePoint Server Subscription Edition, you can connect using a remote object model (MEWS)
connection.

Changing a Job Configuration for Multiple Files

Question

Is it possible to change the configuration for multiple job files at one time in the Job List section of
Content Matrix?

Answer

Yes, this is possible. Most users will only need to change the configuration of a single job in the Job List
section, but it is possible to change the configuration for multiple jobs at one time.

In order to modify the configuration for multiple job files at one, select all of the jobs in the Job List
section. Once all of the desired jobs are selected there are two methods that can be used to access the
configuration dialog. The first is to click the Change Configuration button at the top of the Job List,
and the second method is to open the context (right-click) menu, and select the Change configuration
for selected jobs option.

The behavior for changing the configuration of multiple files at once changes slightly depending on the
version of Content Matrix Console that is being used.

Behavior in Versions 6.1.00 and Later

When changing the configuration for multiple files that use the same type of action at once, only
settings that are changed during the re-configuration will be pushed into all of the selected jobs. This
means that even if all of the jobs contain different settings, they will all still contain these different
settings after the configurations have been modified. Only the settings that were re-configured will be
changed (to whatever setting they were changed to).

Let's look at the example of three "Paste Site" jobs that are previously configured, and each has a
different Rename action applied to it as well as a few various other differences in selected options.
When the Change Configuration is applied to all three at once, only the settings that were
reconfigured will be affected. So if the web part options were changed, then those options will be
applied to all three jobs, but each will still retain their original Rename setting, and any other settings
that were configured even if there are differences.

Behavior in Versions 6.0.0201 and Earlier

When changing the configuration for multiple files that use the same type of action at once, all of the
selected files will have the options for the first job in the Job List section pushed into them, regardless
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of any other setting the previously used. Basically, all of the jobs after the first select job in the Job List
will be modified to use all of the settings from the Change Configuration dialog.

Let's look at the example of three "Paste Site" jobs that are previously configured, and each has a
different Rename action applied to it as well as a few various other differences in selected options.
When the Change Configuration is applied to all three at once, all of the configuration options that are
set for the first of the selected jobs in the Job List will be pushed to the two remaining jobs. These two
remaining jobs would then use all of the exact same configuration options as the first job, including the
values for the rename options. Any of the previous settings for the two remaining jobs would be lost
(because they are replaced with the first jobs configuration options).

Multiple Clients

Question

Does Content Matrix Console - File Share Edition support running multiple clients at the same time?

Answer

Content Matrix Console - File Share Edition does not currently support running multiple migration
actions at one time through a single instance of the client. However, it is possible to open multiple
copies of the client and have each one run a separate migration action. If multiple instances of the
client are opened at the same time to run migrations, users will need to make sure that the source
documents/folders are not being copied from the same location, and that the selected target is not the
same SharePoint list/site. If the source and target location overlap for multiple concurrent migrations
there is a possibility that the SharePoint APIs that are called by File Share Edition will conflict and they
will try to overwrite one another. As a result the migrated content may not migrate correctly, and will
have to be re-migrated at a later date.

Source Files

Question
| was wondering what happens to files on the share drive after we migrate them to SharePoint? Are
they marked or flagged on the share drive as having been migrated or are they deleted?

Answer
The files on the file system are left as is. Content Matrix Console - File Share Edition only performs read
operations on source files.

Your Content Matrix Console - File Share Edition project is the best way to track what has been
migrated. We do provide a facility to remove the files from the source location post-migration--if that
is what you are looking for. Obviously, this is something to use carefully and we would be happy to
discuss further whether this might be useful in your case. Please contact Quest Support for more
information.

Content Matrix
153
Frequently Asked Questions


https://support.quest.com

Using Proxies, Load Balancing or Alternate
Access Mappings

Question

How does Content Matrix deal with environments that use proxies, load balancing and/or alternate
access mappings (AAM)?

Answer

Content Matrix Console should not run into any issues with these three things. Content Matrix uses the
Metalogix Extensions Web Service (MEWS), which deploys over a whole farm and functions
identically to a regular SharePoint web service. SharePoint web service's get the benefits of IS
redirection, proxy pushing, and anything else that SharePoint can utilize, such as Alternate Access
Mappings (AAM). Since the Metalogix Extensions Web Service acts the same as a SharePoint web
service it also gets all of these benefits.

In the case for load balanced environments the Metalogix Extensions Web Service would need to be
deployed through the target side SharePoint farm. When the Web Service is installed it automatically
gets deployed to all the SharePoint instances within that farm, as a SharePoint solution. Once the Web
Service is installed on the target server, then load balancing should no longer be an issue.

There are, however, some cases where proxy settings may not work correctly by default. In these cases
it is possible to set some specific proxy settings for the specified connection. Please see the Configuring
Proxy Settings page for more details.

SharePoint Site Collection Creation Issue

Question

| have been trying to create a new site collection through Content Matrix but | have been encountering
issues. Why is this happening? and what can | do about it?

Answer

Starting with SharePoint 2013, most web applications use claims authentication, but the Central
Administration web application that manages the server level settings uses Classic authentication. When
Content Matrix Console connects to a SharePoint server it has to authenticate through a web
application. When connected to a SharePoint 2013 or later web application that uses Claims
authentication, SharePoint itself can have trouble recognizing that the accessing User account has
permissions in the web application areas that are managed by Classic authentication. This is also true if
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connected to a web application that uses Classic authentication, if trying to access an area managed by
Claims authentication.

The permissions to create site collections is managed by Classic authentication, so if connected
through a Claims authentication web application users will receive a "401 Unauthorized" error message
when trying to create a new site collection. This happens even if the user account has all of the
appropriate permissions. If connecting through a Classic authentication web application, users will
receive permission errors when trying to set any settings on a site collection that uses a Claims
authentication web application, after the site collection is created.

From internal testing, we have determined that SharePoint connections that use the
{O\ Local Object Model will not run into this issue. This is because the Local OM connection
Q_Fffl type does not run authentication through IS, which appears to be a trigger point for
the authentication issues.

From testing we have also determined that you are still able to create SharePoint site
collections when using the Remote OM connection type, but in order to do this Content
Matrix Console must elevate your permissions for the creation step. Before elevating
any credentials, Content Matrix Console will run a preliminary check to ensure the
migrating user has enough permissions initially to be able to use the elevated site
collection creation. In order for these elevated permissions to be used, the migrating
user account must explicitly (by name) have "Full Control" permissions on the Web
Application that the site collection is being created on.

In the Remote OM connection case users can also create a site collection within any
web application if they are a member of the Farm Administrator group in SharePoint
and they are connected to Central Administration as a farm connection.

Possible Errors when Creating Site Collection in SharePoint

Below is a list of errors (and their explanations) that you might encounter when trying to create site
collections in SharePoint through Content Matrix Console.

e Error Message 1 - Unable to obtain Web Application '<web application name>'.
Explanation/Resolution - Content Matrix is unable to find the web application. This should not occur
unless a serious issue within SharePoint has occurred from the time the site collection configuration
dialog was displayed, and the call to the Metalogix Extensions Web Service (for remote OM
connections) was made to perform the site collection creation. Check your SharePoint environment,
and resolve any issues. Then try again.

e Error Message2 - Migrating user '<migrating user>' requires explicit Full Control on the web
application where the site collection is intented to be created. If the migrating user is a member of
the Farm Administrators group then connect to the Central Administration site and try again.

Explanation/Resolution - The migrating user has read permissions on the web application (using a
farm or web connection type) that they're connected to, but does not have full control on the web
application that they are trying to create the site collection in. To resolve this, the migrating user
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account must be added explicitly (by name) with Full Control to the respective Web Application that
they are trying to create the site collection in. They can also create a site collection within any web
application if they are a member of the Farm Administrator group in SharePoint, and they are
connected to Central Administration as a farm connection.

Job List Database fails to Load After Upgrade

Question

| recently upgraded to Content Matrix Console version v.6.2.x.x and my Job List database is failing to
load. What might be causing this issue? and how can | fix it?

Answer

This issue was likely caused by a recent upgrade to Content Matrix Console's security features. A
security upgrade has been made in Content Matrix Console version 6.2.0.0 and later. This change has
resulted in two potential issues that users can encounter. These issues and their resolutions are:

o Issue 1: The Job List database failing to load.

Resolution: When the Content Matrix Console client opens, an error message will prompt the user to
open the Job List file again. Go down to the Job List section and click File > Open Job List. This will
open a Browser window. Navigate to the location that contains the LST file for the Job List that was
previously listed in the Job List section. Then select the LST file and click Open. The Job List will now
be loaded and users can continue as normal.

Due to the security upgrades in version 6.2.0.0 and later, the security settings for the Job List need to
be upgraded. Content Matrix Console cannot do this while the job is actively selected, but can apply
the update to the existing Job List the next time it is loaded back to the Job List section of the client
application.

e [ssue 2: Any connections that have had the Save my credentials check box selected will no longer
have their passwords saved.

Resolution: For any connections that had their credentials previously saved by using the Save my
credentials option, you will need to connect or reconnect to that environment and enter the
password in again, then complete the connection. The security upgrade has caused the encryption
file for any saved passwords within Content Matrix Console to be upgraded, and to apply this
upgrade to this file, any saved passwords must be re-entered.
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Migrating Empty Folders

Question

Is it possible to migrate any empty folder within my File Share?

Answer
Yes, it is possible to migrate any empty folders into SharePoint. By default any empty folders that exist
within the File Share folder structure will be migrated into the target SharePoint environment.

If the configuration options for the migration are set to determine the folder name (that each file
should be migrated into) based on the data in a custom column, then any empty folders will still be
migrated but they will ignore this setting and instead use the original empty folder name.

Retrying Failed Document Copies to 0365 CSOM
Connections

Question

When | try to migrate some of my content into Microsoft 365 using a SharePoint CSOM or Microsoft
365 Tenant connection type, and this content contains a large Document Library, | see that some of my
documents fail to migrate. The logs for the failure indicate that a "HTTP 500 - Internal Server Error"
was thrown. What is the cause of this? And how can | fix it?

Answer

There is a potential issue when migrating specifically to SharePoint Online where users can encounter
an "HTTP 500" error. This is caused by a combination of the CSOM/Tenant connection adapter and
SharePoint's document upload methods. To help resolve this issue there is a document retry feature
that can be configured. This retry feature will attempt to upload the document(s) into the SharePoint
Online target, and depending on the configured setting, will attempt to retry the upload process if it
fails or times-out on the initial try.

The below steps will explain how to enable and configure this retry setting.

NOTE: This retry method is only meant for migrating to SharePoint Online targets. If you are
migrating to an on premises target, then this retry feature will not benefit you since it makes use of
Microsoft 365 specific methods.

1. Make sure that the Content Matrix client application is closed.

2. Inthe file system that the Content Matrix Console client application is installed on, navigate to the
the appropriate file location:
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o |f you are required to be a local administrator on the machine where Content Matrix is installed:
C:\ProgrambData\Metalogix

OR

o |f you are not required to be a local administrator on the machine where Content Matrix is
installed: C:\Users\<username>\AppData\Roaming\Metalogix\Common

3. Inthis location there should be an EnvironmentSettings.xml file. Open this file in an editor
program. For example, Notepad, etc.

4. There are two variables that will need to be modified in order for the retry method to work. They
are:

e CSOMDocumentRetriesNumber - This value determines the number of times that Content
Matrix will make another attempt to upload/migrate any document(s) that has failed the initial
document upload try, when migrating to a SharePoint Online CSOM target.

e CSOMDocumentRetriesDelay - This value determines the amount of time, in seconds (s), that
Content Matrix will wait before starting a document upload retry, and is based on the above
("CSOMDocumentRetriesNumber") variable.

NOTE: The default values for these two variables will be set as "0". Users can set these values as
desired, based on what works best for their environment.

5. After the desired values have been entered in the two variables, save and close the file.

6. Restart the Content Matrix client application. The changes should now be in Content Matrix
Console, and used when running any migration to a SharePoint Online target environment.

After these values have been set and the client application has been restarted, any documents that fail
on the initial migration attempt we be retried.

IMPORTANT: If these steps do not resolve the issue and you are using the Import Pipeline for the
migration, the error may be pipeline-related. See "Error, the batch will be resubmitted" Message
Displays When Using the Import Pipeline for details.

Import Pipeline Batches Getting Stuck

Question

| am migrating some content using the Import Pipeline. After some time the batches seem to simply
stop. Why am | facing this issue?
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Answer

Migration duration and overall performance using the the Import Pipeline may vary due to factors
outside the control of Content Matrix. Migration processing resides within Microsoft's domain and is
subject to Microsoft's internal processes, such as maintenance and upgrades.

You may experience a delay of several hours before batch completion if the machines that Microsoft
uses undergo maintenance/upgrades or if there are Microsoft 365 service issues/outages (as can be
seen in the Microsoft 365 Admin Center under Service Health).

Error: 'The object is associated with property
AssociatedMemberGroup.'

Question

When attempting to copy an object to a SharePoint Online site or OneDrive, why do | receive the
following error?

Object reference not set to an instance of an object on server. The object is associated with property
AssociatedMemberGroup.

€ Error E3

0 Obiject reference not set to an instance of an object an server, The object is

assodated with property AssodatedMemberGroup,

i Cloge

Error: Object reference not set to an instance of an object on server. The object is ~
associated with property AssociatedMemberGroup,
Stack: at Microsoft. SharePoint. Client. ClientObject. ChedkUninitializedProper ty (String
prophame)

at Microsoft, SharePoint, Client. Group. get_allowMembersEditMembership ()

at Metalogix. SharePoint. Adapters. CS0M2013. CSOMAdapter. GetWebXML{ClientContext
chi, Web web, XmlWriter xmlWriter, Boolean bFullXML)

at Metalogix.SharePoint, Adapters, CS0OM20 13, CSOMAdapter, GetSiteXml(ClientContext
cb, ¥mlWriter xmlWriter, Boolean bFullXML)

at Metalogix.SharePoint, Adapters. CSOM20 13, CSOMAdapter, GetSiteXml(ClientContext
chi, Boolean bFullXML)

at Metalogix. SharePoint. Adapters. CS0M20 13, CSOMAdapter. GetSite(Boolean
bFetchFullXml)

Answer

This error may occur when one or more of the default SharePoint groups (Owners, Members, and/or
Visitors) are not present on the target.

NOTE: For OneDrives, none of these groups are present by default.
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Create the missing default group(s) on the target. Refer to the applicable Content Matrix Knowledge
Base article for more information.

Migration Error: 'ERROR, the batch will be
resubmitted to the import pipeline’

Question

What does it mean when the message ERROR, the batch will be resubmitted to the import pipeline
displays in the Information section of the Log Item Details dialog when a migration is performed using
the Import Pipeline?

[ Log Item Details - oI E8
OPERATION STATUS ITEM NAME
I;SF‘O Migrakion Warning Warning Batch 2
TIME STARTED TIME FINISHED BYTES COPIED
SI9/2019 5:123:22 AM SI9f2019 5129122 AM aeE
SOURCE

CustLisk_FLO_TremAkkach

TARGET
https: /imetalogixsoftware62 3, sharepoint. com/sites/Rini G505EuildTarget

INFORMATION
@ROR, the batch will be resubmitted to the import pipeline ::)

DETAILS WIEW COMTENT COMPARER.

{"Event":"JabErrar”,"JobId"; "5 193545-af 1 c-4he7-5833-3ad4233828=a", "Time"; "05/09/201 9 ~
10:258:02.825", "TakalRetryCount": 0", "MigrationType": "Mane”, "Migr ationDirection”; " Irmpart”, "Objeck Type": "LiskItem", "L
tl":"Lisks/CuskList_FLO_Itemattach/FLL", "Id": "S53 6a0ad-cdas-473e-a469-

c0e715614573", "SourceListIkernInkTd": " 1", "TargetListTkerInk1d": " 1", "ErrarCade":"-

Zla0246526", "ErvarType™: "Micrasaft, SharePaink, SPException”, "Message":"Save Canflick,ninour changes conflict with
thiose made concurrenth by another user, IF wau wank wour changes bo be applied, click Back in waur web browser,
refresh the page, and resubmit waur changes. CallStack -- &k Micrasaft, SharePaink, SPGlobal HandleCamException

Answer

You may see this message (which will begin with either ERROR or FATAL ERROR) during a migration
when a batch fails to migrate in its entirety. To address this issue, increase the value of the
environmentsettings.xml key MaxAzureBatchRetryCount. This key controls the maximum number of
times Content Matrix will resubmit the batch until it is successfully migrated. (The default value is 5.)

The batch retry mechanism will also be triggered for the following errors:

Please try again. CallStack -- at Microsoft.SharePoint messages

Access denied

Save Conflict The system cannot find the path specified. (Exception from HRESULT: 0x80070003)

Updates to system roles is not allowed.
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e [jst does not exist

For any error not listed above (such as Item Does Not Exist, which is different than List does not Exist), a
batch will be resubmitted only if the error message is added to the environmentalsettings.xml key

ErrorMessagesForRetryAzureBatch.

IMPORTANT: If adjusting this setting does not resolve the issue, the error may be with the CSOM
connection. See Retrying Failed Document Copies to SharePoint Online CSOM Connections for

details.

Support for GCC High Tenants

Question

Does Content Matrix support SharePoint Online GCC High connections?

Answer

Refer to the following table for specific target connections that Content Matrix supports for GCC High

tenants.

IMPORTANT: In order to use ADFS authentication with a GCC High tenant you must first run a utility
provided by Quest Support and enable the setting EnableUserProvidedAuthentication. Refer to the
Quest Support Knowledge Base article Enabling User Provided Authentication in Content Matrix for

details.

Connections

Target OAut OAuth with

Type h MFA

Tenant --

Site --

ADFS ADFS Web Microsoft 365

(Microsoft 365 Browser Web Browser

User Provided Authenticati Authentication
Authentication) on

- v
Y v

Content Matrix
161

Frequently Asked Questions


https://support.quest.com/metalogix-content-matrix/kb/330254/enabling-user-provided-authentication-in-content-matrix

17

About Us

Quest creates software solutions that make the benefits of new technology real in an increasingly
complex IT landscape. From database and systems management, to Active Directory and Microsoft 365
management, and cyber security resilience, Quest helps customers solve their next IT challenge now.
Around the globe, more than 130,000 companies and 95% of the Fortune 500 count on Quest to deliver
proactive management and monitoring for the next enterprise initiative, find the next solution for
complex Microsoft challenges and stay ahead of the next threat. Quest Software. Where next meets
now. For more information, visit www.quest.com.

Contacting Quest

For sales or other inquiries, visit www.quest.com/contact.

Technical Support Resources

Technical support is available to Quest customers with a valid maintenance contract and customers
who have trial versions. You can access the Quest Support Portal at https://support.quest.com

The Support Portal provides self-help tools you can use to solve problems quickly and independently,
24 hours a day, 365 days a year. The Support Portal enables you to:

e Submit and manage a Service Request

View Knowledge Base articles

Sign up for product notifications

Download software and technical documentation

View how-to-videos

e Engage in community discussions

Chat with support engineers online

e View services to assist you with your product
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